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CHAPTER 1

Introduction

The Selenio ™ Broadcast Network Processor (BNP) products—BNP 2xr, BNP 2xr+, and BNP 3xr—deliver 
the industry's highest density digital video solution for grooming, statistical multiplexing, transrating, 
digital program insertion (DPI). Additionally, the BNP 3xr, features incorporation of DVB Conditional 
Access for program encryption. Each model features a flexible, scalable and modular platform that 
simplifies and expedites deployments of advanced video services, simplifies operation and 
management, and reduces operational and capital costs. 

Figure 1. BNP 2xr

Figure 2. BNP 2xr+

Figure 3. BNP 3xr

Receiving input through its Gigabit Ethernet or ASI interfaces, the BNP can statistically multiplex while 
performing grooming and digital ad and overlay insertion.The BNP can receive both standard 
definition (SD) and high definition (HD) program services, and can concurrently groom and insert 
digital ads within the same box while providing program-level encryption in the BNP 3xr. 

The BNP is fully MPEG compliant and interoperable with leading cable industry equipment. The 3xr 
unit offers hot-swappable redundant fan modules and power supplies.

The BNP simplifies configuration by providing a Java-based graphical user interface that can be 
accessed through a standard Web browser. Configuration can be performed through SNMP using any 
standard network management application. The SNMP MIBs are readily available from the BNP home 
page.
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Document Organization
This guide is organized as follows:

• Chapter 1, "Introduction," (this chapter) describes the contents and conventions used in this guide.
• Chapter 2, "Overview," provides a detailed description of the BNP and its features.
• Chapter 3, "BNP Element Manager Basics," introduces the BNP Element Manager GUI you use to 

configure and manage the BNP. 
• Chapter 4, "System Configuration," describes the initial product setup and product configuration 

using the Java-based BNP Element Manager.
• Chapter 5, "System Redundancy," describes how to set up a pair of BNPs for redundant operations. 
• Chapter 6, "Grooming and PSIP," shows you how to set up grooming, transrating, and other 

configuration and operational procedures.
• Chapter 7, "Maintenance," contains guidelines for using the Maintenance menu options from the 

BNP Element Manager. 
• Chapter 8, "Digital Program Insertion (DPI)," describes DPI using the BNP.
• Chapter 9, "DVB Conditional Access," describes how to set up DVP-CA system using the BNP.
• Chapter 10, "ETV Binary Interchange Format," provides an overview of EBIF and typical use cases 

for configuration.
• Chapter 11, "Monitoring Alarms and Events," discusses the methods used to monitor the health of 

the BNP and its status in the network.
• Chapter A, "Editing the DVB NIT Table," shows you how to edit, make additions to, and delete items 

from the NIT table, one of the DVB tables.
• The glossary and index can be used to quickly reference information.

Document Audience
This guide is for system administrators and operators who are responsible for installation and 
maintenance of the BNP and for processing network broadcast. You should be familiar with general 
video and networking terminology, and should be familiar with basic installation of hardware. 

Most importantly, you must be familiar with the basics and principles of broadcast network processing.

Related Documentation
• BNP 2xr Hardware and Installation Reference
• BNP 2xr Quickstart 
• BNP2xr+ Hardware and Installation Reference
• BNP 2xr+ Quickstart 
• BNP 3xr Hardware and Installation Reference
• BNP 3xr Quickstart 
• BNP Release Notes
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Document Conventions
Table 1 provides an easy way to recognize information of particular importance in this manual.

Table 1. Document Conventions

When 
you see: It means:

Note: This points out information that may not be part of the text but provide tips and other 
helpful advice.

Caution: This provides an alert to an action that may have undesirable consequences if the 
instructions are not followed correctly. Cautions also indicate that failure to follow guidelines could 
cause damage to equipment or loss of data.

Warning! This shows that failure to take the necessary precautions or to follow guidelines could 
cause harm to equipment and personnel.

Navigation tip: follow the path alongside the pointer to navigate to a specific option. Because 
many functions can be accessed via various methods, this section provides navigation 
information associated with the GUI menus and, as applicable, quick keys and toolbar icons. 

Clicking any blue link takes you to the item to which the link refers.

Graphics Used
In some cases, the screens shown in this manual may have been slightly modified after the manual was 
released, or may appear slightly different on different browsers.

All efforts have been made to ensure that the latest images are used. In all cases, the functionality 
described is current at the time of writing.
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CHAPTER 2

Overview

This chapter provides a functional overview of the Selenio ™ Broadcast Network Processors (BNPs). 

In This Chapter:
• "Product Overview,” next.
• “Product Features” on page 14.
• “BNP Applications” on page 15.
• “BNP Deployment Architecture” on page 17.
• “Redundancy” on page 20.

Product Overview
The BNP product suite consists of the BNP 3xr, BNP 2xr, and BNP2xr+, each of which is managed by 
using its BNP Element Manager GUI. All BNP devices provide support for ASI2 hardware modules, and 
the following functions:

• Support of both standard definition (SD) and high definition (HD) program services in either 
MPEG-2 or H.264 encoding; the BNP simultaneously grooms and inserts digital ads.

• High density video transrating (rate shaping), statistical multiplexing, grooming and digital 
program insertion (DPI); transrating video streams with impressively high video quality.

• Multiple levels of redundancy support including service level and 1:1 chassis level redundancy.
• Support for up to eight Gigabit Ethernet (GigE) interfaces for video input or output, as well as up to 

18 asynchronous serial interface (ASI) I/O ports in a single rack unit device.

Table 2. Comparing BNPs

BNP 
Model

�
Characteristics

2xr 1RU (rack unit) device that contains Gigabit Processor-2 (GBP2) and Processor-2 (PROC2) 
hardware modules. 

2xr+ 1RU device that contains Gigabit Processor-3 (GBP3) and Processor-3 (PROC3) hardware 
modules. 

3xr 2RU device that contains the BNP 3xr contain Gigabit Processor-3 (GBP3) and Processor-
3 (PROC3) hardware modules. This BNP also provides hot-swappable redundant fan 
modules and power supplies.
Support for DVB Conditional Access (CA) common scrambling algorithm—which is 
configurable with the BNP Element Manager, for encryption of programs processed by 
the BNP 3xr. 
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Product Features
Applicable Platforms: Any BNP device. 

• Based on proprietary flexible Video Intelligence Architecture™ (VIA).
• A graphical user interface for easy configuration and management.
• Eight GigE interfaces standard and up to 18 optional ASI ports.
• Management via two 10/100BaseT Ethernet ports
• Ability to process and encrypt MPEG-2 and H.264 program streams over any of its Gigabit Ethernet 

or ASI inputs, and route them to any of these interfaces.
• Seamless digital ad insertion and program substitution.
• Fully interoperable ad insertion with SeaChange, Arris, and other industry standard ad servers.
• Graphic overlay insertions anywhere on a program (MPEG-2) using the BNP GUI to import 

standard graphic files (PNG).
• International Time Zones.
• Interface to Event Information Scheduler (EIS), Entitlement Control Message Generator (ECMG) and 

Entitlement Management Message Generator (EMMG).
• Support for:

- ATSC and DVB content, including ability to configure and pass through both long and short 
names for ATSC TS output programs.

- EBIF
- “FAT” ASI transport services, multiple program groups over a single TS / ASI interface.
- H.264 grooming and multiplexing in a MPEG-2 TS format.
- Language-specific GUI.
- Multiple levels of redundancy at the chassis, input stream, service (program), and Ethernet port 

level.
- Operator-generated text and graphic messages from the BNP GUI based on digital overlay 

technology.
- Program substitution of a primary network source with a secondary source based on SCTE 30 

control.
- RADIUS/TACACS+ authentication.
- Scheduling for Logo Overlay and Operator Messaging up to one month in advance.
- SCTE 18 Digital Emergency Alert Messaging (EAS), which is used to integrate the BNP with EAS 

management systems to control the playout of message crawls and audio during an 
emergency alert event. �
SCTE 21 to SCTE 20 closed caption conversion.�
Full compliance with the SCTE 30 and SCTE 35 standards.

Applicable Platform: BNP 3xr

• Incorporation og DVB Conditional Access common scrambling algorithm (CSA), compliant with 
DVB CSA and DVB SimulCrypt protocols.

• Bandwidth-based DVB-CA licensing support.
• Dedicated 10/100 BaseT IP management interface for DVB CA encryption.
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BNP Applications
The BNP delivers the industry’s highest density digital video processing solution for a variety of 
applications, some of which are described in the following topics: 

• "Grooming, Transrating and Multiplexing,” next.
• “DPI-Based Ad Splicing” on page 15.
• “Messaging System Applications” on page 16.
• “DVB Conditional Access (DVB-CA) Encryption” on page 17 (for BNP 2xr+ and 3xr). 

Grooming, Transrating and Multiplexing

Using proprietary Video Intelligence Architecture™ (VIA), the BNP provides the ability to transrate 
program streams with the highest quality is unsurpassed in the industry. The BNP seamlessly grooms 
multi-program transport streams (MPTS / MUX) and single-program transport streams (SPTS) on both 
input and output ports. It also offers multiple Quality of Service (QoS) priority levels on any MPEG-2 
program stream enabling selection of the desired level of transrating. 

DPI-Based Ad Splicing

The BNP can concurrently groom and seamlessly splice both SD and HD program streams encoded in 
either MPEG-2 or H.264 formats. This grooming and splicing capability eliminates the need to dedicate 
multiple devices for different functions. The simplified installation, wiring and configuration reduces 
system deployment time. The BNP is fully compliant with SCTE 30 and SCTE 35 standards and is 
interoperable with the leading digital program insertion (DPI) ad servers. This flexible product can also 
perform SCTE 30 to SCTE 35 conversion to support digital ad insertion at the hub. The BNP is an ideal 
solution for both centrally located DPI systems at the headend facility, distributed DPI systems, and 
zoned and targeted ad insertion.

A BNP deployed in a cable digital broadcast video grooming and ad insertion environment is shown in 
Figure 4.

Figure 4. Regional Ad Zone Insertion
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Messaging System Applications
BNP support for messaging system applications is described in the following topics:

• Digital EAS and Operator / Advanced Messaging.
• Graphic Overlay Insertion.

Digital EAS and Operator / Advanced Messaging
Leveraging its existing high-density video processing technology, the BNP’s digital Messaging System 
capability allows operators to program both digital SCTE 18 Emergency Alert System (EAS) alerts and 
operator-generated messages. The Advanced Messaging option allows importing graphics and text 
files into the operator crawl message. EAS and Operator / Advanced Messaging alerts are delivered 
universally throughout the network, overcoming existing challenges that cable operators face in 
supporting analog and digital subscribers with an increasing range of decoding technologies. 

The BNP’s Messaging System support can be applied selectively to any MPEG-2 program being 
processed. EAS and operator-generated messages are digitally rendered and overlaid directly onto a 
program, delivered directly to any digital subscriber set-top box or to analog decoders, and presented 
as an overlay alert crawl to viewers. The BNP also supports operator-configurable audio override or 
audio stream insertion to complement the text crawl message generated by industry-leading EAS 
management vendors for a completely customizable deployment.

A BNP in an SCTE 18 digital EAS application is shown in Figure 5.

Figure 5. BNP in SCTE 18 Digital EAS Application
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Graphic Overlay Insertion
In addition to EAS and operator messaging, the BNP Messaging System Logo Overlay option supports 
insertion of graphic overlays into any MPEG-2 program being processed. Graphic overlays are based on 
importing static graphic Portable Network Graphics (PNG) files. Importing text files is also supported, 
meaning that customers can create a library of graphic and text files to routinely use (see workflow 
example below). You can preview the imported PNG files before starting the overlay insertion. 

The location of the insertion is configurable with positioning anywhere on the display screen defined 
by (x,y) screen coordinates based on pixels relating to program resolution (e.g., SD and HD). Logo 
overlay files can be created with PNG alpha channels to control transparency effects supported by the 
BNP during the insertion of the overlay. Additionally, background transparency support is available for 
non-ascii text overlays in order to support foreign markets. 
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DVB Conditional Access (DVB-CA) Encryption

Applicable Platform: BNP 3xr

The BNP 3xr supports the DVB-CA common scrambling algorithm (CSA) for encryption of MPEG-2 and 
H.264 programs. The embedded SimulCrypt Engine is a low cost, high density, scalable encryption and 
management control implementation that is fully DVB-CA compliant.

The DVB-CA encryption feature includes the following functionalities:

• SimulCrypt Synchronization (SCS).
• Control Word Generation (CWG).
• Common Scrambling Algorithm (CSA).
• ECM / EMM insertion.
• CA-related PSI / SI generation and insertion.
• SimulCrypt EIS Lite GUI configuration and management.

RGB’s SimulCrypt engine interfaces with the following external devices:

• Event Information Scheduler (EIS).
• Entitlement Control Message Generator (ECMG).
• Entitlement Management Message Generator (EMMG).

Figure 6 shows the BNP in a DVB-CA network.

Figure 6. BNP in a DVB-CA Network

BNP

BNP Deployment Architecture
The BNP’s modular and programmable platform is designed to provide operators with full processing 
scalability to meet their specific processing requirements. The program density of the BNP is software-
configurable and upgradeable, allowing operators to start at lower densities and upgrade to the full 
hardware capacity through software licenses as their stream densities and network needs grow.
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This scalability reduces capital costs and allows operators to allocate budgets accordingly. By paying for 
processing on an as needed basis, operators can wisely plan budgets based on today’s requirements 
and avoid over-allocation to meet future needs. The programmable and upgradeable architecture of 
the BNP, as well as its high processing power, eliminates hardware changes and will simplify and 
expedite future deployments of new video processing applications.

The BNP supports both ASI and Gigabit Ethernet interfaces, allowing operators who deploy Gigabit 
Ethernet networks to profit from the increased cost-efficiency offered with this transport, while still 
providing support for operators with legacy ASI networks. This flexibility enables operators with ASI 
networks to continue with their existing infrastructures while providing an upgrade path for a future 
transition to an IP-based network.

The BNP has eight Gigabit Ethernet interfaces and is scalable to support up to 18 ASI interfaces using 
up to three ASI modules. The Gigabit Ethernet interfaces are part of the BNP’s base configuration and 
no additional hardware or licensing is required to utilize these ports. Providing added flexibility, each 
ASI interface is software configurable as input or output by using an easy-to-use graphical user 
interface.

Figure 7. Example of BNP Grooming of GigE or ASI Input Over GigE Transport Network

B N P 

A BNP deployed for bulk rate capping in a Switched Digital Video (SDV) architecture is shown in 
Figure 8.
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Figure 8. Example of SDV Architecture over GigE Transport Network

B N P 

Figure 9 shows how the BNP fits within the network for a centralized system architecture using ASI 
interfaces. GigE interfaces could also be used for both input and output in a co-located headend 
application.

Figure 9. Example of Co-Located ASI Architecture

B N P 

Either ASI or GigE interfaces are used for MPEG input or output. Because of the distance, GigE 
interfaces are typically used for transport between the headend and the hub/node.
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Redundancy
Since a single BNP may deliver advanced video services to tens or even thousands of subscribers in a 
video network, it is critical that the BNP provide a high availability of services. To achieve such reliability, 
the BNP supports a multi-level redundancy feature to ensure service availability and reduce system 
downtime. With proper configuration, the BNP can provide full chassis-level redundancy. On the 
hardware level, a BNP provides fan, power, and chassis redundancy; on the software level, the BNP 
Gigabit Ethernet port redundancy and a configurable program service redundancy feature. 

Four user-configurable redundancy options are supported by the BNP:

• Source Specific Multicast (SSM) Redundancy
• Program Redundancy
• Port Redundancy
• 1:1 Chassis Redundancy

The first three redundancies—SSM, Program, and Port—operate within a single BNP chassis. The 
fourth—1:1 Chassis Redundancy—makes use of two BNP chassis. The redundancy for hot-swappable 
fan trays and power supply modules happens automatically. 

Source Specific Muliticast (SSM) Redundancy
The BNP supports the configuration of up to four source IP addresses per multicast input TS. The BNP 
will join one of the four source specific multicasts, when configured. When the input PAT from the 
current source times out, then BNP will switch to another source configured for that input TS. All the 
streams coming from various sources must be identical (PIDs, program numbers, number of programs 
etc.). Therefore, it does not matter which source specific multicast the BNP joins and receives program 
information from at any given instance. Also, there is no priority associated with configured sources. 
BNP achieves source redundancy using IGMPv3 SSM joins and leave messages. When SSM redundancy 
is configured for an input TS, the BNP joins the first configured source specific multicast and waits a 
maximum of two seconds for the reception of the PAT. If the PAT is not received in two seconds, then 
BNP joins the next configured SSM and repeats the process until it receives a PAT. Video could be 
interrupted for up to three seconds (in worst case). 

SSM redundancy cannot be coupled with program redundancy on the same input TS.

Because SSM Redundancy requires IGMPv3, the router/switch connected to the GigE port of the input 
transport stream must have IGMPv3 enabled.

For information on configuring SSM redundancy, refer to “Creating Input Transport Streams” on 
page 109.

Program Redundancy
The BNP supports program redundancy, which is sometimes referred to as service-level redundancy. 
For this type of redundancy, when the primary program is gone, the BNP automatically switches to a 
redundant or backup program. If any elementary streams are missing from one of the ports, the BNP 
switches to the secondary port.

In a program redundancy configuration, a switch to backup occurs when:

• Missing MPTS/SPTS streams are identified by checking the PAT.



SelenioTM BNP  User Guide, Release 3.7.1 21

Overview - Redundancy

• Missing program streams are identified by checking the PMT.
• A missing video stream is detected.

You can assign a backup program for every program, and any program can be assigned to back up a 
running primary program. The backup program can be another program on the same GigE port or it 
can be on a different GigE port in the same chassis. 

Program-level redundancy is supported such that when there is a groomed program missing, a 
designated input program can function as a standby program and will take over for the missing 
program. The detection of a PAT / PMT missing for over 2 seconds is used as the threshold for the 
detection of the missing input program. 

A program in an input TS that has SSM redundancy configured cannot be used as a backup program 
for program redundancy.

For information about Program Redundancy configuration, see “Program Redundancy” on page 152.

Port Redundancy

The BNP supports Gigabit Ethernet port output mirroring within the same chassis. The mirrored port 
serves as a standby port in case the primary port fails. The mirroring port must have a unique 
IP address configured. The BNP delivers identical streams to both the primary port and the mirrored 
port with the same destination IP address and port number, but a different source IP address.

The multiplexes output on one GigE are delivered to the mirrored GigE port simultaneously as a fully 
operational, redundant output GigE port. Regardless of mirroring, all active GigE ports must have 
unique IP addresses assigned.

To set GigE port-level redundancy, see “GigE Port Configuration” on page 44.

1:1 Chassis-level Redundancy 
When the ports and global settings are configured to do so, the BNP provides 1:1 redundancy. The BNP 
supports hot-standby 1:1 chassis redundancy through heartbeat and virtual IP failover mechanisms. 

Heartbeats provide the ability to synchronize failover to a secondary BNP. A heartbeat daemon on the 
primary unit will send out unicast heartbeat messages every 250 milliseconds.The heartbeat daemon 
running on the standby BNP listens to the heartbeats coming from the primary BNP. If the standby BNP 
does not hear the primary BNP’s, it initiates a failover and takes ownership. The heartbeat daemon 
running on the standby BNP checks for heartbeats coming from the primary BNP over both the normal 
Ethernet 10/100BaseT management connection and optionally the eighth Gigabit Ethernet port (GigE 
8) connection (when used as a backup to the Ethernet 10/100BaseT management port). 

The Backup LED on the front of the chassis indicates the redundancy role of a chassis: green indicates 
the active chassis, and orange indicates a standby chassis. 

The standby chassis takes over if the primary (active) chassis fails, if there is a system or module 
overheat, failed fan, failed power supply, or missing heartbeat from the primary unit. The former 
standby (now the active) chassis now becomes configurable through the BNP Element Manager.
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Virtual IP addressing is used to support the BNP 1:1 chassis redundancy feature. If the active chassis 
fails, the standby assumes the virtual IP address. Network devices communicate with the virtual 
IP addresses, not to the physical IP addresses. If the input/output of the active chassis changes, the new 
setting is automatically synchronized to the standby chassis.

GigE 8 can be configured to send heartbeat messages in the initial setting. If the network Ethernet 10/
100 management connection is unplugged, the active chassis remains active. If the input or output 
GigE link is down, the active chassis shows a hardware fault and becomes the standby.

The standby chassis does not have any separate licenses. The license usage on the active and standby 
chassis is always synchronized; if the standby chassis becomes the active chassis, it assumes the 
licenses of the active chassis.

Figure 10 illustrates a typical configuration scenario of the BNP hot-standby 1:1 chassis redundancy 
feature.

Figure 10. 1:1 Chassis Redundancy using Heartbeat and Virtual IP Failover Mechanism
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In this example, the primary BNP has a management IP address of 192.168.21.1 and the secondary BNP 
has an address of 192.168.21.2. A third IP address in the same subnet 192.168.21.200 is configured as a 
virtual IP address. The video server and management workstation will use this virtual IP address to 
communicate to the active BNP unit. During the normal course of operation, the primary BNP assumes 
the virtual IP address and acts as the active unit. When a failover event happens, the secondary BNP will 
take ownership of the virtual IP address and assume the active role. It achieves this by sending an ARP 
request to associate the MAC addresses of the secondary ports with the virtual IP addresses. 

For information about 1:1 chassis redundancy configuration, see “1:1 Redundancy Best Practices and 
Considerations” on page 94.
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BNP Element Manager Basics

This chapter provides information about the Selenio ™ BNP Element Manager, which is used to 
configure and monitor the Broadcast Network Processor (BNP). 

In This Chapter:
• “BNP Element Manager Overview,” next.
• “Obtaining Java Runtime Environment” on page 24.
• “Broadcast Network Processor Home Page” on page 24.
• “BNP Element Manager GUI” on page 26.
• “Grooming Tab” on page 30.
• “Alarms & Events tab” on page 30.
• “Configuration Tab” on page 31.
• “Chassis Tab” on page 31.
• “BNP Version Information” on page 33.
• “Quick Keys” on page 35.

BNP Element Manager Overview
The BNP Element Manager is a Java-based GUI available using a standard web browser, which offers a 
variety of features intended to simplify the setup and operation of the BNP:

• An embedded GUI application for configuration and management via XML/RPC over HTTP.
• Program level drag and drop grooming.
• PID Management.
• Input program redundancy.
• Output port mirroring.
• Simultaneous bitrate analysis of input and output transport streams and programs.
• Viewing of alarm and event logs.
• Module redundancy configurations.
• Full configuration of system functions and Gigabit Ethernet ports.
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Obtaining Java Runtime Environment 
The BNP Element Manager requires that the PC on which it is running have Java™ Runtime Environment 
(JRE) v1.6 or higher. If your PC does not have the correct JRE installed, it is available free from the 
Imagine Communications Customer Portal.

To obtain installation instructions and the latest version of JRE that is compatible with the BNP Element 
Manager, log in to Imagine Communications Customer Portal and search for Download Java Runtime 
Environment.

Broadcast Network Processor Home Page
The BNP Element Manager software is pre-installed on the BNP at the factory and is presented as a 
home page (Figure 11) following entry of a BNP’s network address from a web browser. In addition to 
providing access to the BNP Element Manger, several other tools are accessible from the home page 
(Figure 11 and Table 3). 

Figure 11. BNP Home Page

Table 3. Broadcast Network Processor Home Page Options  

Link Option Description
Launch BNP Element Manager Click to start the launch, which will present the login dialog prior to 

revealing the BNP Element Manager screen. 

Download Java SDK Quick-access to the Oracle website, if you need to download the 
recommended version of the Java SDK to your desktop.

Show System Log View events and error messages recorded by the BNP.

Show Build Info View the current software version number and build number. 

SNMP Mib Files Access and save or open the MIB files for the current BNP release. 
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Log in and Access the BNP Element Manager
1. Open a web browser from the management workstation and enter the IP address of the BNP in the 

browser’s address field to display the BNP Element Manager home page. 
2. Click Launch BNP Element Manager. The BNP 

Element Manager Log in dialog is now presented for 
local login (shown) or login via AAA. �
For login with AAA, additional fields are provided in 
the login screen, for entry of SNMP read/write strings 
(see also “Changing the SNMP Community String” on 
page 193). 

3. Enter login parameters:

- At IP Address or Host Name: enter the IP 
address of the BNP to manage, or use that already 
provided in this field. 

- At User: select the user account from the drop-
down list. If using an AAA server for 
authentication, the drop-down list is not 
available— you will need to type the user name in this field. (Table 4, and Table 21 on page 50).

- At the Password: field, type the password string. Note that passwords are case sensitive. 

Table 4. BNP Element Manager User Accounts

User Password Privileges
Administrator Admin Unrestricted access and ability to change password. This level of 

access is typically used only by Field Application Engineers and 
Technical Support personnel. However, this access can be 
granted to head-end personnel in your organization. 

Operator Operator Read-write access that allows configuration changes. This is the 
typical login level. 

User User Read-only access. This user account cannot modify BNP 
configuration. 

4. Click Log in.
Successful login presents the Grooming-Mapping tab screen (Figure 13). 

System Configuration Files Access the .cfg files associated with the current BNP release. 

Collect Diagnostic Info for Tech 
Support

Generate complete diagnostic files that can be provided to RGB 
Customer Support about your BNP system. 

Collect Quick Diagnostic Info for Tech 
Support

Generate the short system diagnostic file set. 

Table 3. Broadcast Network Processor Home Page Options  (Continued)

Link Option Description



SelenioTM BNP  User Guide, Release 3.7.1 26

BNP Element Manager Basics - BNP Element Manager GUI

Logging Off

Use the Exit option to log off gracefully from your BNP Element Manager session. 

Menu Path From the BNP Element Manager main menu -> File -> Exit.�
or use quick keys: Alt f, Alt e

The BNP screen is now dismissed. Use steps provided in “Log in and Access the BNP Element Manager” 
on page 25 to initiate another session.

BNP Element Manager GUI
The BNP Element Manager provides a convenient, intuitive method for management of a BNP. In 
addition to numerous tools built into the interface for configuration of services, status of the BNP 
system is always displayed at the bottom border of the Element Manager screen. You can navigate to 
the various functions by selecting options from the tabs and menus, and menu items are associated 
with keyboard mnemonics for quck access (Figure 12). 

Figure 12. Hierarchy of BNP Element Manager Menus and Tabs
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BNP Element Manager Window

The BNP Element Manager provides menus, icons, tabs, and colors in the GUI, which assist in navigating 
to configuration functions and determining status of the BNP (Figure 13). 

Figure 13. BNP Element Manager GUI Components
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Note that the identity of the BNP and the currently logged in user is always in view at the top bar of the 
window. Status of the connection between the BNP and the BNP Element Manager is always on display 
at the bottom bar, alongside the overall status of the BNP system. 



SelenioTM BNP  User Guide, Release 3.7.1 28

BNP Element Manager Basics - BNP Element Manager GUI

BNP Element Manager Menus
Use the BNP Element Manager menus (Table 5) to perform tasks listed in Table 6. You can access these 
options either by using the pull-down menu, or by combining the Alt key with the underlined character 
particular to a function.

Table 5. BNP Element Manager Menus

Menu BNP Purpose
File All Exit the BNP Element Manager.

View All Refresh the currently active window or control view of mapping.

Status All View DPI Activity.

Maintenance All Upgrade software, manage licensing, edit the SNMP community string, set up NIT 
or TOT tables, reboot, perform a BNP shutdown, remove BNP redundancy, or 
regroom. 

DVB-CA 3xr Perform global DVB-CA configuration.

Help All Access the About screen, in which to view current release information about the 
BNP in use.

Table 6. BNP Element Manager Main Menu and Quick Keys 

Menu Description Additional Information
File�
(Alt f)

Perform a graceful logout from the BNP Element 
Manager, with the following option:
• Exit (Alt x)

“BNP Version Information” on page 33.

View
(Alt v)

Adjust the view in the BNP Element Manager 
window, with the following options:
• Refresh Current Screen (Alt r)
• Expand Mapping (Alt e)
• Collapse Mapping (Alt c)

Examples that demonstrate results of 
expand and collapse are provided in 
Figure 55, “Grooming-Mapping View - 
Collapsed View,” on page 104, and 
Figure 57, “View --> Expand Mapping 
to View All Contents,” on page 106. 

Status Check DPI status and/or summary at the BNP 
system level. 
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BNP Element Manager Tabs
Use the BNP Element Manager tabs to perform the configuration, monitoring, grooming tasks listed in 
Table 7. 

Table 7. BNP Element Manager Window Tabs 

Tab Use
Grooming Perform mapping tasks, access real-time bitrate monitoring views. See also “Grooming 

Tab” on page 30

Alarms & Event View real-time lists of alarms and events logged by this BNP. See also Chapter 11, 
"Monitoring Alarms and Events" on Page 252.

Configuration Access various configuration parameters via the subtabs labelled Global, Ethernet 
Control Port, GigE Ports, ASI Ports, User Authentication, Messaging System, and 
SNMP Trap.See also “Configuration Tab” on page 31

Chassis Provides a quick overview of the BNP system state. Clicking a card or port provides 
specific information for that item. Clicking any other part of the BNP displays system 
information about the BNP. See also “Chassis Tab” on page 31.

Maintenance
(Alt m)

Access BNP maintenance functions, with the 
following options:
• Upgrade Software 

�

“Software Upgrade” on page 185.

• License Manager “Managing Licenses” on page 190.

• Change SNMP Community String “Changing the SNMP Community 
String” on page 193.

• Set up Network Information Table (NIT) “You will need to log in as described 
above for any workstation that is 
accessing the Element Manager for the 
first time after the SNMP Read / Write 
Community Strings have been 
changed.” on page 194.

• Set Up Time Offset Table (TOT) “Configuring the Time Offset Table 
(TOT)” on page 194.

• Reboot “Rebooting the System” on page 196.

• System Shutdown “System Shutdown” on page 197.

• Remove Chassis Redundancy “Removing Chassis Redundancy” on 
page 198.

• Regroom “Regrooming” on page 198.

Help
(Alt h)

View version information in the About screen, 
with the following option:
• About (Alt a)

�
“BNP Version Information” on page 33.

Table 6. BNP Element Manager Main Menu and Quick Keys (Continued)

Menu Description Additional Information
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BNP Element Manager Status Bar
The status bar at the bottom of the BNP Element Manager always remains in view to report status 
information about the BNP. Color coding (Table 8) indicates the current, highest-level severity of the 
situation reported for connectivity and alarms. 

Connectivity

Status of connectivity to the BNP is reported at the left portion of the status bar, where you can view 
the currently connected IP address of the BNP, and current status of connectivity between the BNP and 
the BNP Element Manager as either green (good) or red (error). 

Alarms

Status of most critical event reported by the BNP is displayed as a text string and color code (Table 8) in 
the middle section of the status bar. 

Table 8. BNP Element Manager System Status

Color Meaning
Green Informational alert or event.

Yellow Minor alert or event may require operator action.

Pink Major alert or event requires operator action.

Red Critical error has occurred and operator intervention is needed.

Grooming Tab
The Grooming tab screen provides access to the mapping page and the bitrate monitoring pages. For 
more information about the Grooming tab, see the following topics:

• “Grooming - Mapping” on page 104.
• “Monitoring Bitrates” on page 182.

Alarms & Events tab
The Alarms & Events tab provides information about the current state of the system and is viewable at 
any time. For more information about the Alarms & Event tab, see Chapter 11, “Monitoring Alarms and 
Events.”
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Configuration Tab

Table 9. BNP Element Manager Configuration Tab Banks 

Tab Use
Global View and set parameters to be applied to the BNP system. These settings control 

functions such as system time source, chassis redundancy, DPI ad parameters and 
splicing. 
See “Global Chassis Configuration” on page 37.

Ethernet Control 
Port

Configure the BNP to use either a static IP address or that obtained via BOOTP/DHCP. 
This page provides all network addresses, and the chassis MAC address, currently 
used by the BNP’s Ethernet Control Port. 
See also “Ethernet Control Port Configuration” on page 43.

GigE Port Use the GigE Port tab screen to define IP, subnet, and gateway addresses for each BNP 
GigE port, and to manage port mirroring and port negotiations. 
See also “GigE Port Configuration” on page 44

ASI Ports Use the ASI Ports tab screen to set ASI port directions, as either Input or Output.
See also “ASI Port Configuration” on page 47.

User 
Authentication

Set parameters for BNP Element Manager user accounts.
See also “User Authentication Configuration” on page 49.

Messaging System Use the Messaging System tab to define messaging zones and/or logo overlay zones.
See also “Messaging System Configuration” on page 60.

SNMP Trap Use the SNMP Trap tab to set up to eight IP addresses, which identify the SNMP traps 
to be used by the BNP. 
See also “SNMP Trap Agent Configuration” on page 92.

The Configuration tab provides access to several types of configuration tasks (Table 9). 

Chassis Tab
The BNP Element Manager automatically detects the chassis hardware and provides a graphical display 
of the product components and their current states (Figure 14). Both the front and rear panels are 
displayed, as associated with the currently logged in BNP model. The information displayed on this 
screen is

• Read-only. 
• Available regardless of whether the selected BNP is the active or standby unit (Table 10). For 

standby units, however, some configuration options will not be available
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Figure 14. Chassis tab (BNP 3xr)

4

To view specific port 
information, position 
the arrow cursor on a 
port until it becomes 
a hand symbol, then 
click on the port to 
immediately view 
detail about the 
selected port. 

The BNP power unit is 
displayed at the rear 
panel, as either AC 
(shown) or DC. 

Table 10. Chassis tab screen information  

Field Description
Chassis Software Version Version of the software currently installed on the BNP.

Chassis Serial No Serial number for the chassis; useful when troubleshooting or contacting 
technical support. The serial number is the same as the 100-BaseT port 
MAC address.

Chassis Up Time Amount of time that the chassis has been continuously accessible.

Inside Chassis Temperature The internal junction temperature of the FPGA chip is displayed, enabling 
easy determination that the FPGA die temperature is within acceptable 
limits.
If the value of any component inside the chassis exceeds 100°, an alarm 
is generated.

GBP Serial No The serial number of the Gigabit Processing card.

Power Supply Unit The Status and Serial Numbers for both power supply units (PS1 and 
PS2). 
• When a power supply is present and operable, status is displayed as 

Present.
• When a power supply is not present or out of range, status is displayed 

as Not Present. 

Fan Module The Status information for FAN1 and FAN2. 
• When a fan is present and operating, status is reported as OK.
• When a fan is not present or inoperable, status is reported as Failed.

Graphical view of physical 
configuration

A graphical representation of the front and rear of the chassis 
configuration. 
Click on any individual module to display its configuration.

GigE port information Configuration and addresses of the GigE ports. 
Click on the port on the graphical representation to view its information.
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BNP Version Information
BNP software version information is located from the BNP Home page, the Help menu and the Chassis 
tab screen. 

Menu Path From the BNP Home page, click on Show Build Info to present a web view (Figure 15) of the 
software version number and build number.

Figure 15. Viewing Software Version Information—from Home Page

Menu Path From the Chassis tab screen, you can view the version number and build number displayed 
alongside the Chassis Software Version field (Figure 16). 

Figure 16. Viewing Software Version Information—from Chassis Page

Menu Path
From the Help menu, select About to present the About screen (Figure 17). Locate the software 
version alongside the Software Version field. 

Ethernet Control ports Configuration and addresses of the Ethernet Control Port. 
Click either management port on the graphical representation to view the 
information.

ASI Port Information Port, direction, and status. 
Click a port on the representation to see details about the port.

PROC Slot Information Clicking on the card shows Slot (A, B, C, or D) and Card Serial No. 

Table 10. Chassis tab screen information  (Continued)

Field Description
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Figure 17. Viewing Software Version Information—from BNP Element Manager About screen
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Quick Keys
The BNP Element Manager contains numerous shortcuts (Table 11) you can use to navigate quickly 
from the main menu, and to adjust views. 

Table 11. BNP Element Manager Quick Keys

Key(s) Action
Esc Close all dialog windows at once.

Tab In dialogs, navigate to next editable field.

Alt f, Alt e Log off the current user session and dismiss the BNP Element Manager screen. 

Alt v Display the View options from the BNP Element Manager main menu. 

Alt v, Alt r Refresh the current view of the BNP Element Manager screen. 

Alt v, Alt e Expand the current view in the Grooming-->Mapping tab page, to reveal all current transport 
streams, programs, and elements associated with the GigE and ASI ports.

Alt v, Alt c Collapse the current view in the Grooming-->Mapping tab page, to hide all current transport 
streams, programs, and elements associated with the GigE and ASI ports. 

Alt s, Alt a View System DPI Activity

Alt m Display the Maintenance options from the BNP Element Manager main menu. 

Alt h Display the Help option from the BNP Element Manager main menu.

Alt h, Alt a Access the About dialog.
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System Configuration

The Selenio ™ BNP is configurable through a Java-based graphical user interface (GUI) available 
through a standard Web browser, or through SNMP using standard network management applications. 
The easy-to-use interface offers a variety of features that simplify the set-up and operation of the BNP, 
including program and transport level drag and drop grooming; simultaneous bit rate analysis of input 
and output transport streams and programs; alarms and logs window; scheduled dynamic grooming 
with start/end time and calendar entry; redundancy configuration; and full configurability of ASI and 
Gigabit Ethernet ports. 

This chapter describes how to configure the BNP using the BNP Element Manager. You can also use the 
BNP Element Manager to define and manage network processing as described in Chapter 6, 
“Grooming and PSIP,” and to monitor the BNP system as described in Chapter 11, “Monitoring Alarms 
and Events.”

Applicable Platforms: The information in this chapter can be used with any BNP device. 

In This Chapter:
• “Global Chassis Configuration” on page 37.
• “Ethernet Control Port Configuration” on page 43.
• “GigE Port Configuration” on page 44.
• “ASI Port Configuration” on page 47.
• “Port Naming” on page 48.
• “User Authentication Configuration” on page 49 
• “Messaging System Configuration” on page 60.
• “SNMP Trap Agent Configuration” on page 92.
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Global Chassis Configuration
Use the Global tab screen (Figure 18) to view and configure parameters applicable to the BNP system.

Menu Path BNP Element Manager Configuration tab -> Global tab screen.

Note: This screen provides tools you use to establish system redundancy. See also Chapter 5, “System 
Redundancy” for details pertinent to managing active and standby BNPs. 

Figure 18. Global tab screen

1. At the Global tab screen, use guidelines from the following tables to set parameters for the BNP 
system:

- Table 12, “System Time Source—Global Configuration,” on page 38.
- Table 13, “Time Zone, Name, Log Address—Global Configuration,” on page 38.
- Table 56, “Chassis Redundancy Parameters,” on page 95.
- Table 14, “Virtual IP Address Configuration—Global Configuration,” on page 39.
- Table 15, “Advanced System Parameters—Global Configuration,” on page 39.
- Table 16, “Advanced DPI Parameters—Global Configuration,” on page 41.
- Table 17, “PID Display Format—Global Configuration,” on page 41.
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2. Click Apply Configuration to save and implement your settings.

Table 12. System Time Source—Global Configuration

Field Description/Values
Force Sync Click this button to force synchronization between the BNP and the 

NTP server. This action will prompt for a reboot of the BNP. See “NTP 
Server Force Sync” on page 42 for details.

IP Address
(Servers 1-5)

Enter up to five IP addresses for the NTP server; the first field cannot 
be blank. Enter one per NTP Address field.
A green circle to the left of the Server number field represents the 
active NTP server. The lack of a green circle would mean the specified 
server is not active.

Offset (msec) This value shows the difference in milliseconds between the reference 
time and the system clock.

Jitter (msec) This value indicates the magnitude of jitter in milliseconds between 
several time queries.

Table 13. Time Zone, Name, Log Address—Global Configuration 

Field Description/Values
Time Zone If Internal is selected, choose the time zone from the pull-down list 

that coincides with the location of the server, and which represents the 
Daylight Savings Time (DST) rules in effect in that city or country.
The time displayed at the bottom right corner of the BNP main screen 
is synchronized with the time reported by the BNP Server box that is 
local to the time zone in which the server is collocated. All system 
alarms (raised and cleared), program start and end times, splice sent, 
converted and received times, EAS start and stop times, and Message 
Table times are managed and displayed in the server time zone. The 
server time zone may be controlled from the client’s configuration 
screen. 
If the pull-down list does not contain the time zone you require, 
contact Imagine Communications Customer Support for assistance. 

System Name You can assign a unique system name for this BNP. After you click 
Apply Configuration, this name will appear at the top of the screen.

System Log Address Enter the IP address to communicate with a Syslog server.

 



Table 14. Virtual IP Address Configuration—Global Configuration 

Field Description/Values
IP Address for 10/100 Enter the virtual IP address used by the system to manage redundancy 

for the 10/100 management port.
• This address must be the same on both the active and standby 

chassis as it is shared by both units. 
• This address must be on the same subnet as the physical IP 

address.
• Leave blank if no redundancy system is in place

Gateway for 10/100 (Optional) Enter the IP address of the gateway (default router) that the 
10/100 virtual IP should use This address must be the same on both 
the active and standby chassis as it is shared by both units.

IP Address for ETH 2 Applicable Platform: BNP 3xr�
Enter the virtual IP address used by the system to manage redundancy 
for the ETH 2 DVB-CA port.
• This address must be the same on both the active and standby 

chassis as it is shared by both units. 
• This address must be on the same subnet as the physical IP 

address for ETH 2.
• Leave blank if no redundancy system is in place

Gateway for ETH 2 Applicable Platform: BNP 3xr�
(Optional) Enter the IP address of the gateway (default router) that the 
ETH 2 DVB-CA port should use This address must be the same on both 
the active and standby chassis as it is shared by both units.

IP Address for GigE (1-8) For each redundant GigE port, (1 through 8) enter the IP address 
shared by the redundant ports. Each GigE port must be on a separate 
subnet.
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Note: The BNP must be rebooted following modification of the virtual IP address configuration.

Table 15. Advanced System Parameters—Global Configuration 

Field Description/Values
Support SCTE 27 Subtitle 
(Stream Type 0x82)

SCTE 27 Subtitling defines stream type 0x82 for program subtitles and 
subtitling methods. The default value is checked. When unchecked 
stream type 0x82 is not treated as a subtitle.

Enable SCTE-21 to SCTE-
20 Conversion

Check this box to enable the input program conversion of SCTE 21 to 
both SCTE 21 and SCTE 20 closed captioning formats on the output 
program.

Enable PSIP processing Check this box to enable the BNP to detect PSIP tables and pass them 
from the input to the output. PSIP processing is enabled by default. 
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PAL Mode Check this box to optimize BNP processing of Phase Alternating Line 
(PAL) content.
• This setting is recommended if most programming from the BNP 

uses PAL.
• This setting is not recommended with progressive content.
Note: Enabling PAL Mode disables Enable EAS CAP.

Optimize Messaging on 
HD

Check this box when using a 3 to 1 ratio of HD programs per transport 
stream on which messaging is enabled. This feature will decrease the 
PROC card’s capacity. This box is unchecked by default.

Enable EAS CAP Leave this box unchecked to enable ten Messaging Zones (“About 
Messaging Zones” on page 60) of up to 400 characters each. 
Check this box to enable two Messaging Zones of up to 1800 
characters each (to comply with FCC regulations). This will delete all 
but the first two messaging zones and their associations with output 
programs, if any exist.
Note: If you disable EAS CAP after having it enabled, any existing 
messaging zones will be retained, but the messages will be truncated 
to the first 400 characters.
Note: Changing this setting requires a reboot of the BNP. 
Note: Enabling PAL Mode disables Enable EAS CAP.

Enable Transparency for 
Messaging System

Check this box to enable transparency filters in the Messaging System 
tab. 
• This box must be checked if you wish to enable transparency for 

Operator Messaging, Advanced Messaging, and Logo Overlay in 
the Configuration �
-> Messaging System tab.

• Checking this box reduces BNP capacitya.
PCR Interval for Stripped 
Null Packet TS (msec)

The duration between two PCRs of an output SPTS with Stripped NULL 
Packet checked. A value of 0 (zero) indicates the duration between two 
PCRs will follow the default BNP setting (80ms for ATSC, 38ms for 
DVB). A non-zero value applies to all modes. The value can range from 
0 to 100.

a. Please see the latest Release Notes for the impact of enabling transparency for load time and bandwidth on the 
BNP.

Table 15. Advanced System Parameters—Global Configuration (Continued)

Field Description/Values
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.

Table 16. Advanced DPI Parameters—Global Configuration

Category Field Description/Values
Postblack Enable 
Options

AD Server Request Check this to play postblack that an ad server 
specifies for the end of an ad. Left unchecked, 
the BNP ignores postblack requests from ad 
servers.

AD Underflows Check this to insert black frames before 
transitioning back to the network, when AD 
underflows. This will allow a smooth transition 
between the AD that under flowed and the 
network. 

DPI Splicing Accurate splicing for 
non CUE DPI

Check this to allow BNP to delay or advance the 
splicing per current latency on the stream. This 
feature is for frame accurate splicing for DTMF 
based DPI.

Table 17. PID Display Format—Global Configuration

Category Description/Values
Hex (0xffff) Click to set display of PIDs only as hex values.
Decimal (65535) Click to set display of PIDs only as decimal values.
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NTP Server Force Sync
The BNP can be configured to use up to five NTP servers with which the BNP will attempt to 
synchronize. In the event of a significant disparity between the BNP’s time and that of the NTP server, 
the BNP may (by design) require considerable time to synchronize with the NTP server. You can 
manually force a quick synchronization between the server and the BNP. 

Forcing a synchronization will prompt for a reboot of the BNP, thus resulting in a service disruption on 
non-redundant BNP configurations. NTP synchronization on non-redundant BNP configurations 
should be conducted during a maintenance window.

Use steps in this section to perform the following forced synchronizations on the BNP:

• "Forcing Synchronization of the BNP with an NTP Server,” next.
• “Ethernet Control Port Configuration” on page 43. 

Forcing Synchronization of the BNP with an NTP Server

Menu Path From the Element Manager, select Configuration -> Global to access the Global tab screen.

1. At the Global tab screen, click Force Sync. The Option 
dialog queries for verification of this operation.�

2. At the Option dialog, click Yes to continue, or No to 
abort this operation. The Password Verification dialog 
is now displayed. �

3. At the Password Verification dialog, enter the 
Administrator password and click OK. The Reboot 
confirmation dialog is now displayed. �

4. Click Yes to reboot, or No to abort the reboot. 
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Ethernet Control Port Configuration
There are two Ethernet control ports for each BNP: one for basic management and access to the 
Element Manager. On the BNP 3xr, the other port is used for DVB-CA connectivity and access. 

Use the Ethernet Control Port tab screen (Figure 19 and Table 18) to view and configure BNP Ethernet 
control ports. 

Menu Path From the Element Manager tabs, select Configuration -> Ethernet Control Port.

1. At the Ethernet Control Port tab screen, enter and/or type Ethernet control port values. Use the 
following guidelines for IP addressing of these ports:

- The IP address for Ethernet port 1 must be on a different subnet from any of the Gigabit 
Ethernet IP addresses. 

- The IP address for Ethernet port 2 must be on a different subnet from the IP address of 
Ethernet port 1, and any of the Gigabit Ethernet IP addresses. 

2. Click Apply Configuration to save and load the settings. 
You can view the current Ethernet control port configuration either at Ethernet Control Port tab 
screen, or at the Chassis tab screen. 

Figure 19. Ethernet Control Port configuration
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Parameters for static IP configuration are described in Table 18. For information about BOOTP/DHCP IP 
configuration, see “DHCP and BNP IP Configuration” on page 44. 

Table 18. Ethernet Control Port Configuration Fields 

Field Description

IP Configuration Select the source of the BNP boot configuration file from the pull-down 
menu as either BOOTP/ DHCP or Static.

MAC Address A read-only field that displays the MAC address of the 10/100 management 
port.

IP Address Enter the IP address of the management port for the BNP; this field cannot 
be blank. 

Subnet Mask Enter the subnet mask of the management port for the BNP; this field 
cannot be blank.

Gateway Enter the IP address where management packets are routed out of the local 
network (the default router address).

DNS Server Enter the IP address of the DNS server being used for management of the 
BNP.This field is optional.

DHCP and BNP IP Configuration

Note: If you use DHCP rather than a static IP address for your Ethernet control port configuration, you 
will need the assistance of Imagine Communications customer support. Contact them before you 
choose DHCP.

If DHCP is selected to obtain an IP address, the BNP IP address cannot be obtained through the 
Element Manager. One of the following three methods can be used to determine the IP address.:

• Connect to the BNP through the serial console and at a prompt type ifconfig eth0.
• If the DHCP server is available, check the MAC and IP mapping on the DHCP server.
• Use a “sniffer” to sniff the network for DHCP traffic.

GigE Port Configuration
All GigE ports for the BNP can be configured from the BNP Element Manager. The GigE ports support 
full duplex processing of transport streams: the same GigE port can be used for input and output. 

Use the GigE Ports tab screen (Figure 20 and Table 19) to view and configure BNP GigE ports. All GigE 
ports for the BNP are displayed in a list. For easy identification, the ports appear with a color-coded 
icon to delineate the active and inactive ports. Active ports are displayed in green.

Menu Path From the Element Manager tabs, select Configuration -> GigE Ports.
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Figure 20. GigE port configuration

1. At the GigE Ports tab screen, set network addressing, mirroring, and/or negotiation for specific 
GigE ports. 

2. Click Apply Configuration to save and load the settings. 
3. You can view the current GigE port configurations either at the GigE Ports tab screen, or at the 

Chassis tab screen. Clicking a GigE port at the Chassis tab screen displays all configured 
information for the selected port. 

.

Table 19. GigE Port Configuration Fields  

Field Description
Port The GigE port number, listed sequentially.
Status Read-only; the current status of the port.
MAC Address Read-only; the MAC address of the port.
IP Address The IP address for the interface; if no IP address is used, leave the 

field empty.
Note that the Element Manager allows the IP address of the GigE 
ports to be configured in the same subnet. However, Imagine 
Communications recommends that all GigE ports be configured 
on different subnets, for proper routing. 

Subnet Mask The subnet mask address.
Default Gateway The default gateway (default router) to use, if applicable.
Mirrored To If the port is mirrored, the port to which the selected port is 

mirrored appears in a read-only field. When you mirror two GigE 
ports, in the event of failure of one, the other one takes over 
without interruption.

Mirroring Click Set to open a dialog, allowing you to mirror this port. See 
also “Gigabit Ethernet Port Mirroring” on page 46.

Auto negotiation Enable or disable auto negotiation.
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Gigabit Ethernet Port Mirroring
Port mirror configuration is typically used in Source Specific Multicast deployment with IGMPv3 
support, in which the Gigabit Ethernet port pairs serves as two different sources for the same video 
traffic.

When configured for port mirroring, output traffic on a specified GigE port will be copied to another 
GigE port. For example, Figure 21 demonstrates a configuration in which GigE port 6 is mirrored to 
GigE port 3. In this configuration, output traffic on GigE port 6 is copied over to Gigabit Ethernet 3. The 
only difference for the traffic coming from Gigabit Ethernet 6 and Gigabit Ethernet 3 is the source IP 
address.

Configuring GigE Port Mirroring 

Use the GigE Ports tab screen (Figure 21) to define port pairs for mirroring. 

Menu Path BNP Element Manager Configuration tab -> GigE Ports tab screen.

Figure 21. Mirroring GigE ports

1. At the GigE Ports tab screen, click the Set button next to the port that is to be mirrored. Clicking 
on the Set button results in displays of a drop-down selection range that lists the GigE ports. 

2. Use the drop-down to specify the GigE port to which the current port is to be mirrored. The port is 
mirrored when you see the following on the GigE Ports tab screen:

- The mirrored-to Set button disappears.
- The mirrored-to GigE port is now listed in the Mirrored to column.
- The Set button at the originating port is replaced by the Remove button. 

There is no need to click Apply Configuration as the mirroring happens as soon as the port is chosen. 
Mirrored ports are identified at the Grooming --> Mapping tab screen. 
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Removing Port Mirroring

Use the GigE Ports tab screen (Figure 21) to remove port mirror settings. 

Menu Path BNP Element Manager Configuration tab -> GigE Ports tab screen.

1. At the Mirroring column, click the Remove button.
2. At the confirmation query, click Yes to continue. The port is no longer mirrored when you see the 

following on the GigE Ports tab screen:

- The mirrored-to Set button is displayed.
- The mirrored-to GigE port is no longer listed in the Mirrored to column.
- The Set button at the originating port is replaced by the Set button. 

There is no need to click Apply Configuration as the ports discontinue mirroring as soon as the port is 
chosen. Also, the Grooming -> Mapping tab screen is immediately updated to remove the mirroring 
label. 

ASI Port Configuration
Use the ASI Ports tab screen (Figure 22 and Table 20) to view the current ASI port configuration and to 
set a direction for specified ASI ports on the BNP. 

Menu Path BNP Element Manager Configuration tab -> ASI Ports tab screen.

Figure 22. ASI port configuration tab
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At the ASI Ports tab screen, only the active slots are displayed: inactive slots are not displayed. Each 
slot is displayed as a separate block containing the information listed in Table 20. Note that you can go 
to the Chassis tab screen to view all ASI slots and associated information.

Table 20. ASI Port tab screen 

Field Description

Port BNP slot and port number. The example in Figure 22 demonstrates that ports list in 
the left-side block are associated with BNP slot C; ports in the right-side block are 
associated with BNP slot D. 

Status Current status of each ASI port as either Active or Inactive.
Direction Dataflow direction on this port, as either Input or Output. You can use the drop-down 

selector from this field to change the setting. 

Note: To enable display of an ASI port on the Inputs panel of the Grooming -> Mapping window, the 
port direction must be Input.�
To enable display of an ASI port on the Outputs panel of the Grooming -> Mapping window, 
the port direction must be Output.

Port Naming
Use the Modify Port Name dialog (Figure 23) to set a new name for a specified input or output port—
GigE or ASI—on the BNP. Note that the GigE port number will not be removed, but the new name will 
be displayed alongside the GigE port number. 

Menu Path BNP Element Manager Grooming tab -> Mapping tab screen -> Inputs or Outputs panel -> right-
click for popup menu on the port to be renamed, and select Modify Port Name.

Figure 23. Modify Port Name Menu and dialog

1. At the Port Name field, type the alphanumeric string that will identify this port. 
2. Click OK to apply the port name to all instances that reference the port ID in the BNP Element 

Manager. Figure 24 demonstrates display of a new name at a port listing. 
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Figure 24. Port Name Modified

New Port Name

User Authentication Configuration
The User Authentication tab provides a central area from which user control settings can be edited, 
added, or deleted. The BNP permits both local and remote user authentication. 

The BNP authenticates with an AAA server when the AAA feature is enabled from the BNP, using the 
name and password provided by the user account during the login process. If the user name exists in 
the AAA server and the password matches with that stored on the AAA server, the user authorization 
level—as either Admin, Operator, or User—is then returned to the BNP (see also “User Account 
Privileges” on page 500. 

• Remote user authentication is performed using an authentication, authorization and accounting 
(AAA) server that supports RADIUS or TACACS+. The AAA server handles requests for access to 
system resources to be configured, allowing maintenance of user profiles to be performed once for 
any number of clients. When a client wants to access a system resource, it must first get permission 
from the AAA server. 

• By default, the BNP provides a local user fallback authentication method that allows users to log in 
when an AAA server is not available. However, for security and account management reasons, use 
of AAA is recommended. All passwords configured for AAA—both remote and local—are 
encrypted.
You can also create additional, customized user accounts which may be useful for authentication 
and authorization where AAA is disabled on the BNP or when AAA servers are not reachable from 
the BNP (as indicated by a timeout occurring for an authentication request to a AAA server). 

The following work flow (Figure 25) illustrates the authentication process when a user attempts to log 
in to the BNP.
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Figure 25. BNP User Authentication Workflow
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User Account Privileges

Table 21  User Privileges and Operations 

BNP Operation Function Admin Op User

Configuration User Authentication yes no no
Global->Apply Config (button) yes yes no
Ethernet Control Port -> Apply Config (button) yes yes no
GigE Ports ->Apply Config (button) yes yes no
ASI Ports -> Apply Config (button) yes yes no
Messaging System ->Apply Config (button) yes no no
SNMP Trap -> Apply Config (button) yes yes no
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AAA Status and Impact to Authentication 

Table 22  AAA Behavior Reference  

Server Server 
Status

User Priv 
at �
Server DB

Does User Exist? User 
Priv at 
Local 
DB

Auth 
results

Local 
Auth 
effort?

logged in as

In 
server 
DB?

In Local 
DB?

RADIUS UP admin yes na na pass no  admin
DOWN admin yes yes admin pass yes  admin
DOWN admin yes yes op pass yes  op
DOWN user yes yes admin pass yes admin
DOWN admin no yes admin pass yes admin
UP admin no na na fail na failed
DOWN admin yes no na fail yes faileda

a. network down or server not stated + user not present in local db

TACACS+ UP admin yes na na pass no admin
DOWN admin yes yes admin pass yes admin
DOWN admin yes yes op pass yes op
DOWN user yes yes admin pass yes admin
DOWN admin no yes admin pass yes admin
UP admin no na na fail na failed
DOWN admin yes no na fail yes failedb

b. network down or server not stated + user not present in local db

Maintenance Software Upgrade yes yes no
Reboot yes yes no
System Shutdown yes yes no
Remove Chassis Redundancy yes yes no
Regroom yes yes no

Table 21  User Privileges and Operations (Continued)

BNP Operation Function Admin Op User



SelenioTM BNP  User Guide, Release 3.7.1 52

System Configuration - User Authentication Configuration

Global User Authentication Configuration
Use the Global tab screen (Figure 26 and Table 23) to set global AAA options for the BNP. These 
settings enable or disable user authentication using AAA. 

Menu Path BNP Element Manager Configuration tab -> User Authentication tab -> Global tab screen.

Figure 26. User Authentication - Global, AAA disabled

These fields are hidden 
when the Enable box 
is unchecked

1. At the Global tab screen, click the Enable box to reveal the AAA parameter fields.
2. Use guidelines in Table 23 for entries in this screen. 
3. Click Apply Configuration to save and load the settings. 

Table 23. User Authentication Global Fields  

Field Description

Enable Enable (check) or disable (uncheck) authentication using AAA. When 
checked, the remaining fields in this table will appear.
When enabled, user authentication will be performed by the 
specified AAA server. 
When disabled, local user authentication will be used. 
Default is unchecked.

Number of Retries The number of times the system will try connecting to a remote 
server before trying another server in the list.
Default is 0. Valid range is from 0 to 2.

Timeout (sec) The amount of time (in seconds) to wait for a response from the 
remote server.
Default is 2. Valid range is from 1 to 4.
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Local User Authentication Configuration

Use the Local tab screen (Figure 27) to view and manage users currently set up to access this BNP. The 
default user types—Administrator, Operator, and User—are always displayed and cannot be deleted. 
Any additional users that you configure will be displayed in this tab page. 

Menu Path BNP Element Manager Configuration tab-> User Authentication tab -> Local tab screen.

Figure 27. User Authentication Setup- Local

Protocol The preferred protocol to use in selecting a server.
Valid options are:
• Radius - Try all RADIUS servers before trying TACACS+ servers.
• TACACS+ - Try all TACACS+ servers before trying RADIUS 

servers.
Default = Radius.

Remote Only Checking this box will require the BNP to use only remote 
authentication. If enabled and remote authentication fails or 
connection with the AAA server is not established, local 
authentication is not performed and the user is not logged in.
Default = unchecked.
At least one AAA server must first be configured before the Remote 
Only option is checked and the configuration applied to the BNP. See 
“User Authentication Server Configuration” on page 57 for details on 
configuring an AAA server.

Table 23. User Authentication Global Fields  (Continued)

Field Description
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Table 24. Local User Tab Functions

Button Description
Add Access the Add Local User screen, in which to set up additional local user 

accounts. See also “Managing Local User Accounts” on page 54. 
Edit Access the Edit Local User screen, in which to modify an existing password for a 

specified local user account. 
Delete Remove a selected (customized) user account from the local tab screen and 

from the BNP database. Only customized local user accounts may be deleted: an 
error message is presented with any attempt to delete one of the default 
Administrator, Operator or User accounts. 

Table 25. User Account Privilege Levels:

Field Description
User Read-only access account. No changes to the configuration are allowed.

Default password is: User
Operator Read and write access are allowed for all configuration operations except 

changing passwords.
Default password is: Operator.

Administrator Full access to the BNP system configuration is allowed. This is the only user 
account that is authorized to change passwords.
Default password is: Admin.

Managing Local User Accounts 
A BNP default Administrator can add, edit, or delete any other user account, and can provision roles for 
those user accounts. Additional, custom administrator account(s) can be configured (Figure 28), but 
these administrators are limited to creation of accounts with Operator or User roles. 

Topics in this section:

• "Adding a Local User Account,” next. 
• “Modifying a Local User Account” on page 55.
• “Deleting a Local User Account” on page 56/

Adding a Local User Account

Use the Add Local User screen to set up a new local user account. 

Menu Path BNP Element Manager Configuration tab-> User Authentication tab -> Local tab screen.
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Figure 28. Add Local User

1. At the Local Tab screen, click Add to present the Add Local User screen. 
2. At the Add Local User screen, set the privilege level, and type the user name and password strings. 
3. Click Apply to dismiss this screen and to view your entry as a new row in the table of local user 

accounts. 
Table 26. Local User Parameters

Button Description
Privilege Select a privilege level—as either Administrator, Operator, or User—for this user 

account from the drop-down menu. 
For more information about privilege levels, see Table 21, “User Privileges and 
Operations,” on page 50, and Table 25, “User Account Privilege Levels:,” on 
page 54.

User Alphanumeric string to name this user account. 
Password Alphanumeric string—maximum 15 characters—to be used with this user login 

at the BNP. Retype Password

Modifying a Local User Account

Use the Edit Local User screen to modify the password for an existing user account. The current role 
and user name cannot be modified. 

Menu Path BNP Element Manager Configuration tab-> User Authentication tab -> Local tab screen.
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Figure 29. Edit Local User

1. At the Local Tab screen, click on the user account to be modified. The Edit Local User screen is 
now presented. 

2. At the Edit Local User screen, type the current password, then type/retype the new password for 
this account.

3. Click Apply to dismiss this screen and to return to the Local table of user accounts. 

Deleting a Local User Account

Use the Delete button on the Local tab screen to instruct deletion of a specified user account.

Menu Path BNP Element Manager Configuration tab-> User Authentication tab -> Local tab screen.

Note: The default user accounts—Administrator, Operator, User—cannot be deleted. Only those 
accounts created by use of the Add Local User function can be deleted. t

1. At the Local tab screen, click to highlight the user account to 
be deleted. 

2. Click Delete. 
3. At the confirmation query, click Yes to continue.

The selected user account is immediately removed from the Local table of user accounts. 
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User Authentication Server Configuration
Use the Server tab screen (Figure 30) to view the current AAA server configurations, and to access 
tools you can use to set AAA server parameters. 

Menu Path Configuration tab -> User Authentication tab -> Servers tab screen.

Figure 30. User Authentication - Servers

Note: When deleting an AAA server, it may be necessary to first reorder the list of servers so that the 
desired server may be deleted in descending order. See also "About AAA Server Order,” in the next 
section.

About AAA Server Order
The order in which the system attempts to connect to an AAA server is based on the following criteria:

• The preferred authentication protocol specified in the Protocol field of the User Authentication -
> Global tab;

• The current server order as shown in the Order column of the User Authentication -> Servers tab.

If the preferred authentication protocol is set to Radius, all Radius servers will be tried first, followed by 
TACACS+ servers. If set to TACACS+, all TACACS+ servers will be tried first, followed by RADIUS 
servers.

For example, if four AAA servers have been added to the AAA server list (see Table 27) and the 
specified protocol preference is Radius, the order in which the servers are tried is A, D, B, C.



SelenioTM BNP  User Guide, Release 3.7.1 58

System Configuration - User Authentication Configuration

Table 27. 

AAA Server
Current Server
Order Protocol

A 1 RADIUS
B 2 TACACS+
C 3 TACACS+
D 4 RADIUS

AAA Server List Example

Adding or Editing an AAA Server 
Use the Edit AAA Server dialog (Figure 31 and Table 28) to add a new AAA server or to edit an existing 
AAA server. You can add up to eight AAA servers. 

Menu Path From the Element Manager tabs, select Configuration -> User Authentication > Servers; click 
the Add button or the Edit button.

Note: At least one AAA server must be enabled when the Remote Only option is selected from the AAA 
Global Configuration menu. See “Global User Authentication Configuration” on page 52 for more 
information.

Figure 31. Add or Edit AAA Server

Adding an AAA Editing an AAA

1. At the Edit AAA Server dialog, enter information to define the AAA server details. Be sure to check 
the Enable box if this server must be available for the BNP to use when logging in to the BNP 
Element Manager via AAA. 

2. Click Apply to save and load the settings. 
Table 28. User Authentication - Servers - Add/Edit Server Fields  

Field Description

IP Address The IP address of the AAA server. When adding a server, default is blank. 
When editing a server, this field is read-only.

Port Enter the TCP port to use on the AAA server. Valid range is: 0 to 65535.
Default for Radius is 1812.
Default for TACACS+ is 49.
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Reordering the AAA Server Query List
Use the Edit AAA Server Order dialog (Figure 32 and Table 29) to modify the order in which the BNP 
system queries for AAA servers. 

Menu Path From the Element Manager tabs, select Configuration -> User Authentication-> Servers; click 
the Set Order button.

Figure 32. Edit AAA Server Order

Current AAA Server Modifying the AAA Order

1. At the Edit AAA Server Order dialog, in the Change Order to: field, type the new sequence. 
2. Click Apply to save and load this setting. The new server order will be displayed in the Order 

column of the Server tab screen. 
Table 29. User Authentication - Servers - Edit AAA Server Order Fields.

Field Description
Current Order Displays the current AAA server order. The default server order is the order 

in which the AAA servers were added to the list. This field is read-only.
Change Order To The new server order to use.

• Separate each number with one space.
• The same number of servers must be entered that are listed in the 

current order field. For example, if there are 5 servers listed in the Current 
Order field, changing the order to 1 2 4 3 would be invalid; changing the 
order to 1 2 4 3 5 is valid.

Protocol Select the authentication protocol from the drop-down box to use when 
communicating with the AAA server. Choose between Radius and TACACS+.
Default is Radius.

Shared Secret Enter the password or passphrase used to authenticate with the AAA server.
NOTE: this setting must match with that present in the server’s 
configuration file. 

Retype Shared Secret Re-enter the password or passphrase used to authenticate with the AAA 
server.

Enable Check this box to enable the AAA server. If an AAA server is not enabled, it 
will not be available for the BNP to use when logging in via AAA.

Field Description
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Deleting an AAA Server

AAA servers must be deleted in descending order. For example, if there are four servers in the order of 
1, 2, 3, 4, the order in which the servers must be deleted is 4 3 2 1. Prior to attempting deletion of a 
server whose order is not last, reorder the servers to change the desired deletion to the last number in 
that order.

Use the following steps to remove an AAA server from the User Authentication Servers tab screen:

1. At the Servers tab screen, select the highest numbered AAA 
server from the Order column (see Figure 30, “User 
Authentication - Servers,” on page 57)/

2. Click Delete. 
3. At the Delete Configuration dialog (Figure 3), click Yes to 

remove the specified AAA server. 

Messaging System Configuration
The Configuration -> Messaging System tab allows you to configure parameters for the BNP to 
integrate with external messaging systems, insert operator messages directly from the BNP GUI, or 
configure the BNP to use external text or graphic files as overlay messages. You can also configure the 
BNP to insert a graphics file (PNG) into one or more programs as a digital logo overlay. To configure 
these features you must create specific Messaging or Logo Overlay zones under the Messaging 
System tab, which are then associated to desired programs through the Grooming -> Mapping tab. 

This section describes how to create both Messaging and Logo Overlay zones. See “Show Program List” 
on page 89 for instructions on how to associate and enable programs to Messaging or Logo Overlay 
zones.

About Messaging Zones
Use the Messaging Zones tab screen to view a snapshot of all messaging zones. This page also 
provides a global parameter associated only with EAS messaging for system-wide configuration of 
audio EAS override during DPI.

The number of messaging zones allowable is dependent on the following conditions at the 
Configuration -> Global tab screen (see Figure 18, “Global tab screen,” on page 37, and the EAS 
Enable CAP description in Table 15):

Table 30. Global tab screen—Dependencies for Messaging Zones

Enable EAS CAP option Description
unchecked Up to ten messaging zone, of 400 characters each, can be configured 

for the BNP. 
checked Up to two messaging zones can be configured for the BNP.

Per FCC requirement, up to 1800 characters are allowed on the EAS 
messages. However, the BNP Element Manager displays only the first 
400 characters: operator messages remain restricted to 400 characters. 
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Within each zone, two types can be configured: EAS or Operator and Advanced. A Messaging Zone 
may be sent either SCTE 18 alerts that are used for EAS Messaging, Operator Messaging based on 
operator-defined text, or Advanced Messaging created from imported graphics (.PNG) or text files, 
and advanced text parameters. 

Note: If the EAS text consists of 1800 characters, it might take up to one minute to overlay the EAS 
message on to video. Therefore, any operator message that was active before receiving the EAS 
message will stay active (if it was intended to continue for long) until the EAS message is overlaid.

Note: The BNP does not process and act upon the received EAS event code (EAN, EAT, NIC, RMT, RWT, 
NPT). It processes the event based on the “alert remaining time” and priority of the received EAS 
message. 

Accessing Messaging Zones
Use the Message Zones tab screen to view the current messaging zone configurations and to access 
messaging zone configuration tools. 

Menu Path From the BNP Element Manager tabs, select Configuration -> Messaging System -> 
Messaging Zones

Figure 33. Configuration -> Messaging System tab (Enable EAS CAP unchecked)

Table 31. Messaging Zones subtab 

Field Description
Reject EAS audio 
override during DPI

When checked, the BNP will reject all external SCTE 18 EAS messages with 
audio override priority for the duration of an ad insertion (text crawling 
will continue). 

Zone Index The sequential index number of the created zone.This field is read-only. Up 
to ten zones can be added.

Zone Type Displays what type of zone has been created. Choices are: EAS or Operator 
and Advanced Messaging.
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Zone Status
(for EAS Messaging 
Zones)

Read-only: The status of the Messaging Zone. If the zone is an EAS 
Messaging Zone, possible choices are:
• Enable: EAS Zone is ready for SCTE 18 EAS message.
• Emergency Alert Crawl On: SCTE 18 EAS alert activated, text crawl is 

displaying.
• Emergency Alert Audio Override: SCTE 18 EAS alert activated with 

Priority 1-14, emergency audio is playing, text crawl will be present.
• Emergency Alert Video Switch: SCTE 18 EAS alert activated with 

Priority 15, emergency video is playing.
Zone Status
(for Operator or 
Advanced Messaging 
zones)

Read-only: The status of the Messaging Zone. If the zone is an Operator or 
Advanced Messaging Zone, possible choices are:
• Enable: Messaging zone is ready to start Operator messaging or 

Advanced Messaging operations.
• Operator Messaging Loaded: Operator message is loaded on the BNP 

and is ready to start the operator message. 
• Operator Messaging Text On: Operator Alert Message is loaded on the 

BNP and crawl text is displaying in the zone. 
• Overlay On: The Overlay that is loaded in the zone is currently being 

overlaid onto programs that are part of the zone.
• Advanced Messaging Loaded: Text or graphic file is loaded on the BNP 

and ready to play. 
• Advanced Messaging On: Advanced Messaging is loaded on the BNP 

and imported graphic and/or text crawl is displaying in the zone 
• Scheduled: Operator Messaging or Advanced Messaging has been 

loaded and scheduled, but currently is not being played. 
Zone Name Read-only: The name of the zone. This information is created following 

addition or modification of a Messaging Zone.
UDP Read-only: The UDP port used to detect an external SCTE 18 EAS server 

message. This information is the result of adding or modifying a new EAS 
Messaging Zone. If the zone is Operator or Overlay this field displays “N/
A”.

Table 31. Messaging Zones subtab (Continued)

Field Description
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EAS Messaging Zones
The BNP Digital EAS feature supports the SCTE 18 (2007) “Emergency Alert Messaging for Cable” 
standard specification for EAS message control and display, which defines the standard for playout of 
text message crawls and audio during an emergency alert event. Using the 10/100 BaseT management 
interface, the BNP supports the following SCTE 18 messages:

• EAS text crawl.
• EAS text crawl with audio override.
• Substitute EAS detail channel for the network feed.

The BNP responds to any EAS alert based on the SCTE 18-defined alerts list in Table 32. 

Table 32. SCTE 18 Defined Alerts

Levels/Priorities BNP Response
1 - 14 The BNP delivers a text crawl and allows adherence to the SCTE 18 

specification to override the audio source on defined channel with text 
information and encoded audio sources from the EAS system.

15 (highest priority) The BNP offers user configuration to allow adherence to the SCTE 18 
specification to override both video and audio on a detailed channel 
with the encoded service provided by the EAS system, or to use the 
same configuration options for Levels 1-14. The BNP will force tune to 
the detailed channel for H.264 and treat it as a data program

The BNP communicates with an external EAS management system for messaging zone control 
information, including interpretation of FIPS (Federal Information Processing Standards) 
announcements. Additionally, user configurable audio muting and audio override of the network 
program's audio is supported.

Configuring a new EAS Messaging Zone

Note: You must be logged in as the Administrator to add, modify, or delete Messaging Zones 
configuration.

Use the Add EAS Messaging Zone screen (Figure 34 and Table 33) to set parameters for a new EAS 
Messaging Zone. 

Menu Path Configuration -> Messaging System tab ->Messaging Zones subtab ->right-click at white or 
blue table rows and select Add EAS Messaging Zone. 
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Figure 34. Messaging Zone pop-up window

1. At the Add EAS Messaging Zone screen, provide information in the entry and drop-down 
fields.Guidelines are provided in the following topics:

- Table 33, “Zone Index for EAS Messaging,” on page 64.
- Table 34, “EAS Video Configuration for EAS Messaging,” on page 65.
- Table 35, “EAS Zone Control Configuration,” on page 65.
- Table 36, “EAS Crawl Configuration,” on page 66.
- Table 37, “EAS Zone Status,” on page 66.
- Table 38, “EAS Alert Text,” on page 66.

2. Click Apply to save and load the new EAS Messaging Zone. The new zone will be displayed in the 
Messaging Zones tab screen. 

Table 33. Zone Index for EAS Messaging

Field Description

Zone Name Assign a unique name for the zone to be created. This field accepts 
alphanumeric entries.
Up to ten Messaging Zones may be created; these may be a mix of 
EAS or Operator and Advanced zones. 
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Parameters for EAS Video Configuration (Table 34) define the EAS video source for substitution over 
the network program due to alert status or audio override option.

Table 34. EAS Video Configuration for EAS Messaging

Field Description

Port Select desired GigE or ASIa

a. The applicable ASI port (if selecting) must have been configured as an input port in order to appear in the pull 
down menu

 port from the pull down menu on which 
detailed channel information (transport stream) is received for EAS 
messaging.

IP Address The IP address of the GigE port. Input a valid multicast IP address on 
which the detailed channel transport stream is received for EAS 
messaging. (Not required for ASI ports.)

Source IP Address The IP address of the source from which the GigE port receives data; 
the source IP address is optional and should only be included for 
IGMPv3 transport streams. (Not required for ASI ports.)

UDP Port Input a valid UDP port on which the detailed channel transport 
stream is received for EAS messaging. Valid range is from 1 to 65535. 
(Not required for ASI ports.)

Program Number Input the program number on which the program information is 
received for EAS messaging.

Audio Override Delay (In 
Secs)

Specifies the delay of audio splicing of the EAS program by x 
number of seconds. Range is from 0-255. A setting of 0 specifies no 
delay.

 

 

Table 35. EAS Zone Control Configuration  

Field Description

UDP Port Input the UDP port which will be used to detect an external SCTE 18 
EAS server message. The typical port number used for this is 5050. 
• SCTE 18 zone specific messaging will vary by UDP port 

configuration.
• A unique UDP port should be configured for each EAS zone.

PID Choice of two hexadecimal values as defined by the SCTE 18 
standard. Choose which value corresponds to your server: 
0x1FFB or 0x1FFC

Crawl Only Priority Sets the threshold at which program audio will be overridden by an 
external EAS source. 
• If the SCTE 18 message is less than or equal to the value set here, 

then audio override will not occur. 
• If the SCTE 18 message is higher than this level, but lower than 

priority 15, audio override will occur. 
• If the SCTE 18 message is priority 15, then all output programs 

configured to receive EAS messaging are tuned to the emergency 
channel and the audio and text crawl is overridden. 

• If priority is set to 0, then no SCTE 18 messages will be set to 
Crawl Only.
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Table 36. EAS Crawl Configuration 

Field Description
Crawl Position Select the location on the end user’s TV screen in which the crawl 

text will appear, as either Top, Middle, or Bottom. The BNP displays 
crawl positions (in pixels) in accordance with various resolutions: 

Resolution
Crawl 
Height Top Middle Bottom

480 SD 48 32 208 384 
576 SD 48 48 256 464
720 HD 80 64 320 576
1080 HD 80 96 496 896

Crawl Speed Select the speed at which text will crawl across the end user’s TV 
screen, as either Fast, Normal, or Slow.

Crawl Background Color Select the background color on which the crawl text will be displayed 
as either Red, Green, Blue, or Black.

  

Table 37. EAS Zone Status  

Field Description
Start Time Read-only:. Displays the day, date, and time that the crawl has or will 

begin. Applies to both external SCTE 18 EAS server and Operator 
Alert messages.

Remaining Time Read-only:. If a limit was placed on the duration of the alert (either in 
the Operator-defined Crawl Duration field or from the external 
SCTE 18 EAS server), the time remaining is displayed here.

Event Duration Read-only:. Displays how long the event is to take place.
Current Status Read-only: Displays current status of the EAS Zone, as one of the 

following:
• Enable
• Emergency Alert Crawl On
• Emergency Alert Audio Override
• Emergency Alert Video Switch
See the Zone Status topics in Table 31 for a complete description of 
these values.

Priority Read only field. This field will display the EAS message priority (1-15). 

 

Table 38. EAS Alert Text

Field Description
Alert Text Read only field. Displays up to 400 characters of the EAS message 

alert.
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Modifying an EAS Messaging Zone
Use the EAS Messaging Zone screen (Figure 35) to change parameters associated with a specific zone.

Menu Path
Configuration -> Messaging System -> Messaging Zones ->double-click the EAS messaging 
zone or right-click EAS on the zone to be modified-> select Modify Messaging Zone from the 
pop-up menu (Figure 34).

Figure 35. Modify EAS Zone

1. At the EAS Messaging Zone screen, enter or select information to modify parameters for this zone. 
Guidelines for entries are provided in the following topics:

- Table 33, “Zone Index for EAS Messaging,” on page 64.
- Table 34, “EAS Video Configuration for EAS Messaging,” on page 65.
- Table 35, “EAS Zone Control Configuration,” on page 65.
- Table 36, “EAS Crawl Configuration,” on page 66.
- Table 37, “EAS Zone Status,” on page 66.
- Table 38, “EAS Alert Text,” on page 66.
You can use this screen to view the current program list for the zone, and enable to disable status 
updates. 
- Show Program List: Click this button to view the Zone Program List screen, which displays all 

programs associated with the specified zone. 
- Disable Status Updates: Click this button to toggle between disable and enable of real-time 

polling of the zone status fields and operator-defined text crawls. 
2. Click Apply to save and apply the settings.
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Deleting an EAS Messaging Zone
The system queries for confirmation to delete a specified zone, as follows:

• If no output transport streams are associated with the selected zone, you will be asked to confirm 
in the Delete Messaging Zone dialog. 

• If output transport streams are currently associated with the selected zone, the system will remind 
you in the Delete Messaging Zone dialog.

Menu Path Configuration -> Messaging System -> Messaging Zones menu, highlight and right-
click on the EAS Messaging Zone you wish to delete.

1. At the Delete Messaging Zone dialog, either click Yes to delete the zone, or click No to abort this 
action and dismiss the dialog. 

2. Confirm that the zone is deleted: it should no longer be displayed at the Messaging Zones tab 
screen. 

Operator and Advanced Messaging Zones
For MPEG-2 programs only, the BNP Messaging System feature supports Operator and Advanced 
Messaging Zones, which allows the cable operator to generate a text crawl of up to 400 characters in 
length directly from the BNP Element Manager or to specify a text or graphic file as an overlay. Both 
Operator and Advanced zones can be associated to individual programs. 

This capability is only allowed using Administrator login privileges. 

Note: An Advanced Overlay license must be purchased in order to view or configure an Advanced 
Messaging Zone. For more information on Advanced Overlay licensing, see “Managing 
Licenses” on page 190.

Note: SCTE 18 EAS messages take precedence over Operator and Advanced Alert Messages. The latter 
can not be sent to a program that has an active SCTE 18 message alert. An SCTE 18 message 
alert sent to a zone will immediately override any current GUI generated alert message playout.

Configuring an Operator Messaging Zone
Use the Add Operator and Advanced Messaging Zone screen (Figure 36 and Table 39) to set 
parameters for an operator messaging zone. 

Menu Path Configuration -> Messaging System ->Messaging Zones ->Right-click anywhere on the white 
or light blue rows for popup menu -> select Add Operator and Advanced Messaging Zone.

Note: You must be logged in as the Administrator to add, modify, or delete Messaging Zone 
configuration.
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Figure 36. Add Operator and Advanced Messaging Zone - Operator Messaging tab

1. At the Add Operator and Advanced Messaging Zone screen, enter information to define the 
zone name, crawl configuration, and crawl text, as described in the following topics:

- Table 39, “Operator Messaging Configuration - Zone Name,” on page 69.
- Table 40, “Operator Messaging Configuration - Crawl Configuration,” on page 69.
- Table 41, “Operator Messaging Configuration - Crawl Text, Duration, Frequency,” on page 70.
- Table 42, “Operator Messaging Configuration - Schedule,” on page 70.
- Table 43, “Operator Messaging Configuration - Zone Status,” on page 71.

2. Click Apply to save changes and create the messaging zone.

Table 39. Operator Messaging Configuration - Zone Name

Field Description
Zone Name This field is common to both Operator and Advanced tabs.

Up to ten Messaging Zones may be created; these may be a mix of EAS or 
Operator and Advanced zones. 

Table 40. Operator Messaging Configuration - Crawl Configuration

Field Description
Crawl Position Select the location on the end user’s TV screen in which the crawl text will 

appear. Choices are: 
Top, Middle, Bottom.
For details on crawl positioning, see Table 36.

Crawl Speed Select the speed at which text will crawl across the end user’s TV screen. 
Choices are:
Fast, Normal, Slow.
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Crawl Background 
Color

Select the background color on which the crawl text will be displayed. 
Choices are:
Red, Green, Blue, Black.

Background 
Transparency Level

Specifies the level of transparency in which the background color will be 
displayed. At 0%, the background color will be opaque; at 100% there will 
be no background color. 
You may type in any value from 0 to 100 or choose a value from the drop-
down box as follows: 
0% (opaque), 25%, 50%, 75%, and 100%
NOTE: This box will not display unless Transparency was enabled in the 
Global Configuration window. 

Table 41. Operator Messaging Configuration - Crawl Text, Duration, Frequency

Field Description
Crawl Text Input the desired alert message up to 400 alphanumeric characters.
Crawl Duration This section provides the following options for the duration of the text 

crawl:
• One Cycle: Plays the full message one time all the way through.
• Play xxx Seconds: Plays the message for the specified number of 

seconds (with a 5 second or one cycle minimum). Message will play for 
the duration that is longest: Specified value of seconds OR one cycle.

• Continuous: Continuously plays message until the Stop Crawl button is 
clicked.

Frequency Choose between two options for how often message is played:
• Once: Plays message once, either for one cycle or specified number of 

seconds (see above).
• Every: Select either 30 or 60 to play message every thirty or sixty 

minutes, either for one cycle or for specified number of seconds (see 
above) from the moment Start is clicked until the moment Stop is 
clicked.

Table 42. Operator Messaging Configuration - Schedule

Field Description

Start The BNP permits you to start a message immediately or schedule it. 
• Now: Starts play immediately. 
• Time: Allows you to schedule start time. Click on the pulldown arrow to 

display a popup window (seen in Figure 37, “Advanced Messaging 
Schedule Window,” on page 71) to set start. 

Stop • Forever: If message is set to play once (see Frequency, above) this is 
the default. 

• Time: When Frequency is set to every 30 or 60 minutes, the Scheduler 
popup is enabled. Click on the pulldown arrow to display (see Figure 37, 
“Advanced Messaging Schedule Window,” on page 71) and set. 

Table 40. Operator Messaging Configuration - Crawl Configuration

Field Description



Table 43. Operator Messaging Configuration - Zone Status

Field Description
Start Time Read-only field. Displays the day, date, and time that the crawl has or will 

begin. 
Remaining Time Read-only field. If a limit was placed on the duration of the alert, the time 

remaining is displayed here.
Event Duration Read-only field. Displays how long the event is to take place.
Current Status This field is read-only and will display one of the following values:

• Enable
• Operator Messaging Loaded
• Operator Messaging Text On
• Advanced Messaging Loaded
• Advanced Messaging On
• Scheduled 
See Table 31 on page 61 for a complete description of these values.

Next Start Time Read-only field. Displays the time that the next round of messaging will 
begin.

Overlay Image Read-only field. Applicable to Advanced Messaging tab. Displays the status 
of the graphic and/or text overlay. Possible values are:
• Complete: An image or text file has been uploaded to the BNP.
• None: No image or text file has been uploaded to the BNP.
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Scheduling Messaging in Advance

Use the following steps at the Schedule section of the Operator Messaging tab:

1. Click the Time button. The current date and time is now presented in a pull-down selector 
alongside your selection.

2. Click anywhere in the Time field to present the Advanced Messaging Schedule Window 
(Figure 37). 

3. In the calendar, click the Month, Day, and Time fields to schedule the message. 
4. Press OK to dismiss the calendar.

Figure 37. Advanced Messaging Schedule Window
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Modifying an Operator Messaging Zone
Use the Operator and Advanced Messaging Zone screen for a specified zone to change parameters 
for the messaging zone. 

Menu Path
Messaging System -> Messaging Zones -> double-click the messaging zone or right-click the 
zone to be modified -> Modify Messaging Zone from the pop-up menu (Figure 38, and see also 
Figure 34, “Messaging Zone pop-up window,” on page 64). 

Figure 38. Modify Operator Messaging Zone
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Configuring an Advanced Messaging Zone
Use the Add Operator and Advanced Messaging Zone screen (Figure 39) to set advanced messaging 
parameters for a specified zone. 

Menu Path Configuration -> Messaging System -> Messaging Zones -> Right-click anywhere on the white 
or blue rows for popup menu -> select Add Operator and Advanced Messaging Zone. 

Note: You must be logged in as the Administrator to add, modify, or delete Messaging Zone 
configuration.

Note: An Advanced Overlay license must be purchased in order to view or configure an Advanced 
Messaging Zone. For more information on Advanced Overlay licensing, see “Managing 
Licenses” on page 190.

Figure 39. Add Operator and Advanced Messaging Zone - Advanced Messaging screen

1. At the Advanced Messaging screen, set parameters for zone, crawl, and scheduling. Parameter 
and button descriptions are provided in the following tables:

- Table 44, “Zone Name and Status - Advanced Messaging,” on page 74.
- Table 45, “Crawl Overlay - Advanced Messaging,” on page 75.
- Table 46, “Preview, Crawl Resolution, Crawl Duration, and Frequency - Advanced Messaging,” 

on page 76.
- Table 47, “Schedule - Advanced Messaging,” on page 76.
- Table 48, “Advanced Messaging Buttons,” on page 77.
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2. Click Apply to save and apply the settings. 

Table 44. Zone Name and Status - Advanced Messaging

Field Description

Zone Name This field is common to both Operator and Advanced tabs.
Up to ten Messaging Zones may be created; these may be a mix of EAS, 
Operator, or Advanced zones.

Start Time Read-only field. Displays the day, date, and time that the crawl has or will 
begin. 

Remaining Time Read-only field. If a limit was placed on the duration of the alert, the time 
remaining is displayed here.

Event Duration Read-only field. Displays how long the event is to take place.
Current Status This field is read-only and will display one of the following values:

• Enable
• Operator Messaging Loaded
• Operator Messaging Text On
• Advanced Messaging Loaded
• Advanced Messaging On
• Scheduled 
See Table 31 on page 61 for a complete description of these values.

Next Start Time Read-only field. Displays the time that the next round of messaging will 
begin.

Overlay Image Read-only field. Displays the status of the graphic and/or text overlay. 
Possible values are:
• Complete: An image or text file has been uploaded to the BNP.
• None: No image or text file has been uploaded to the BNP.



Table 45. Crawl Overlay - Advanced Messaging

Field Description
Foreground Color Specifies the foreground color of the imported text file. Click the Select 

Color button to choose which color and color scheme to use.
Background Color Specifies the background color of the imported text file. Click the Select 

Color button to choose which color and color scheme to use.
Crawl Position Select the location on the end user’s TV screen in which the imported 

crawl text or graphic will appear. Choices are: 
Top, Middle, Bottom.
For details on crawl positioning, see Table 36 on page 66.

Background 
Transparency Levela

a. The Background Transparency Level setting in the Advanced Messaging tab is applicable only to ASCII and Non-
ASCII text characters. Background Transparency Level is not applied to graphic overlays within text crawls. Alpha 
Channel Transparency settings for the graphic overlay, if present in the.PNG file, will be preserved.

Specifies the level of transparency at which the background color will be 
displayed for ASCII and Non-Ascii text. At 0%, the background color will be 
opaque; at 100% there will be no background colorb

b. Please see the latest Release Notes for details on the impact of enabling transparency for load time and bandwidth 
on the BNP.

. 
• You may type in any value from 0 to 100 or choose a value from the 

drop-down box as follows: 
• 0% (opaque), 25%, 50%, 75%, and 100%.
NOTE: This box will not be displayed unless Transparency was enabled in 
the Global Configuration window. 

Crawl Speed Select the speed at which the imported text or graphic will crawl across 
the end user’s TV screen. Choices are:
Fast, Normal, Slow.

Font Choose the font in which the imported or typed text should be displayed. 
Click the Select Font button to choose font style, size, and attributes.

Text Input the desired alert message up to 400 alphanumeric characters, or use 
the Import Text button to select a text file from the hard drive of the 
computer on which the Element Manager is running. The text file will then 
be uploaded to the BNP’s memory. 

Graphic Displays the name of the.PNG file being used for overlay crawl. If no file 
has been specified, this field will be blank. To select a graphic file as an 
overlay crawl, click on the Import Graphic button and choose a.PNG file 
from the local computer on which the Element Manager is running. The 
graphic will be uploaded to the BNP’s memory when Apply is clicked. 

Foreground Color Specifies the foreground color of the imported text file. Click the Select 
Color button to choose which color and color scheme to use.
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Table 46. Preview, Crawl Resolution, Crawl Duration, and Frequency - Advanced Messaging

Field Description

Previewa

a. When importing a.PNG or.TXT file for the first time, the graphic will appear in the Preview box; however, after the 
graphic has been uploaded to the BNP and the Advanced Message tab is closed, the graphic is no longer available 
for preview, even though it remains stored in the BNP. 

Allows you to choose in which order the overlay (if using both text and 
graphics) will appear. Choose from:
Graphic+Text: Graphic on the left, text on the right
Text+Graphic: Text on the left, graphic on the right
NOTE: The Background Transparency setting only applies to the text 
portion (ASCII or Non-ASCII) of the overlay.

Crawl Resolution Allows you to choose at which resolution the overlay will appear. Choose 
from:
SD (Wx48): Standard definition, width of overlay by 48 pixels in height.
HD (Wx80): High definition, width of overlay by 80 pixels in height.

Crawl Duration This section provides the following options for the duration of the text 
crawl:
• One Cycle: Plays the full message one time all the way through.
• Play xxx Seconds: Plays the message for the specified number of 

seconds (with a 5 second or one cycle minimum). Message will play for 
the duration that is longest: Specified value of seconds OR one cycle.

• Continuous: Continuously plays message until the Stop Crawl button is 
clicked.

Frequency Choose between two options for how often message is played:
• Once: Plays message once, either for one cycle or specified number of 

seconds (see above).
• Every: Select either 30 or 60 to play message every thirty or sixty 

minutes, either for one cycle or for specified number of seconds (see 
above) from the moment Start is clicked until the moment Stop is 
clicked.

Table 47. Schedule - Advanced Messaging

Field Description

Start The BNP permits you to start a message immediately or schedule it. 
• Now: Starts play immediately. 
• Time: Allows you to schedule start time. Click on the pulldown arrow to 

display a popup window (seen in Figure 37, “Advanced Messaging 
Schedule Window,” on page 71) to set start.

Stop • Forever: If message is set to play once (see Frequency, above) this is 
the default. 

• Time: When Frequency is set to every 30 or 60 minutes, the Scheduler 
popup is enabled. Click on the pulldown arrow to display and set (see 
Figure 37, “Advanced Messaging Schedule Window,” on page 71).
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Table 48. Advanced Messaging Buttons

Button Description
Show Program List Clicking this button will open the Show Program List window, which 

displays all programs associated for the specified zone. 
• This button only appears when modifying a zone, and not when creating 

a zone.
Enable Status Update 
/ Disable Status 
Update

Clicking this button will enable real-time polling of the Zone Status fields 
as well as any Operator-defined text crawls.
• When the Enable Status Update button is clicked and real-time polling 

enabled, the button will change to Disable Status Update. Clicking the 
Disable Status Update button will disable real-time polling.

• This button only appears when modifying a zone, and not when creating 
a zone.

Modifying an Advanced Messaging Zone
Use the Advanced Messaging screen (Figure 40) to change parameters for a specified zone. 

Menu Path Messaging System -> Messaging Zones -> right-click or double-click on the zone name for 
popup menu -> select Modify Messaging Zone. 
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Figure 40. Modify Advanced Zone screen

1. Use guidelines as described for Advanced Messaging configuration (page 73) to set parameters. 
2. Click Apply to save and apply the changes. 

To Delete an Operator or Advanced Messaging Zone
Use the Delete Messaging Zone function to remove a specified zone from the BNP. The system will 
query for confirmation of the deletion as follows:

• Where no output transport streams are associated with the 
selected zone, you will be asked to confirm deletion and the zone 
will be deleted.

• Where output transport streams are associated with the selected 
zone, the system will apprise you. 

Operator and Advanced Messaging Zones Best Practices and Considerations
The following guidelines should be used when creating and modifying Operator and Advanced 
Messaging zones:

1. Only one type of Messaging Zone (Operator or Advanced) may be loaded or actively playing as a 
crawl in each zone.
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2. Anytime you wish to make changes to an actively playing or loaded Messaging Zone, you must 
stop the active crawl, make the desired changes, apply the changes to load them onto the BNP’s 
memory, and start or restart the crawl.

3. If you wish to change an actively playing Messaging Zone from one type to another (e.g., from an 
Operator Message to an Advanced Message), follow these guidelines:

• Click the Enable Status Update button and check the current status of the Messaging Zone 
(see Table 31 on page 61 for a description of status messages).

• If the current status of either Operator or Advanced Messaging is ON, stop the crawl by clicking 
Stop in the active zone’s subtab.

• Make any changes to the desired subtab (Operator or Advanced).
• Click Apply to load the new message to the BNP’s memory.
• Click the Start button to begin playing the message.
• If the Enable Status Update button has been clicked, the new status will be appear as [Operator 

Messaging Text or Advanced Messaging] On in the Current Status field.
4. If you wish to change a loaded but not actively playing Messaging Zone from one type to another 

(e.g., from an Operator Message to an Advanced Message), follow these guidelines:

• Ensure the Enable Status Update button has been clicked.

Note: Use caution when opening multiple windows with the Enable Status Update option activated as 
multiple GUI queries can place additional processing load on the BNP. 

• Confirm the current status of the Messaging Zone is not ON (see Table 31 on page 61 for a 
description of status messages).

• Make any changes to the desired subtab (Operator or Advanced).
• Click Apply to load the new message to the BNP’s memory.
• If the Enable Status Update button has been clicked, the new status will be appear as [Operator 

or Advanced] Messaging Loaded in the Current Status field.

Logo Overlay Zones
In addition to EAS and operator messaging, the BNP Messaging System Logo Overlay option supports 
inserting graphic overlays into any MPEG-2 program being processed. Graphic overlays are based on 
importing static graphic Portable Network Graphics (PNG) files. You can preview the imported PNG 
files before starting the overlay insertion, but once the graphic has been saved and uploaded to the 
BNP, you can only see the name of the last file uploaded.

The location of the logo insertion is user configurable with positioning anywhere on the display screen 
defined by (x,y) screen coordinates based on pixels relating to program resolution (e.g., SD and HD). 
Additionally, the BNP will support alpha channel transparency inherent in the PNG file’s creation. Logo 
overlay files can be created with PNG alpha channels to control transparency effects supported by the 
BNP during the insertion of the overlay.

Alpha Channel Transparency
In general, a graphics file consists of three layers, or channels: RGB for red, green, and blue. Another 
type of channel may be added to a graphics file to allow for the configuration of transparency in the 
pixels when the RGB colors are merged, or layered, one on top of the other. This is known as an alpha 
channel. Alpha channels define the importance of each pixel in the layering process so that certain 
portions of the image can either be completely or partially masked. This allows for rectangular-shaped 
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images to appear as irregular-shaped by controlling the pixel opacity, which is important when 
overlaying a logo to a TV screen. 

PNG files are the most common and advanced file extension for supporting alpha channel 
transparency. The BNP will support any transparency mask inherent to the alpha channel of a PNG file 
as long as the Enable Mask field is checked in the Logo Overlay Zone menu.

Note: The Enable Mask field is only visible when the Enable Transparency for Overlays option is 
checked in the Configuration -> Global window.

Figure 41 shows examples of PNG files in which alpha channel transparency has been configured for 
100% background transparency: the left most image demonstrates the view where transparency is not 
enabled on the BNP, and the right-side example is a view in which transparency is enabled.

Figure 41. Alpha Channel Transparency Examples

Alpha channel 
transparency has 
been configured in 
the PNG file but not 
enabled on the BNP.

Alpha channel 
transparency has 
been configured in 
the PNG file and 
enabled on the BNP. 

Overlay Zone Configuration
Use the Logo Overlay Zones screen (Figure 42) to view all currently configured overlay zones, and to 
access functions for management of the zones. 

Menu Path  Configuration tab -> Messaging System tab, -> Logo Overlay Zones subtab.

Note: An Advanced Overlay license must be purchased in order to view or configure a Logo Overlay 
Zone. For more information on Advanced Overlay licensing, see “Managing Licenses” on 
page 190.

Note: SCTE 18 EAS alerts (highest priority) and Operator and Advanced Alert messages (second 
priority) take precedence over Logo Overlays. A Logo Overlay can not be sent to a program that 
has an active SCTE 18 message or Operator and Advanced Messaging alert. An SCTE 18 message 
alert sent to a zone will immediately override any current GUI generated alert message playout.
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Figure 42. Configuration -> Logo Overlay Zones tab

Table 49. Logo Overlay Zones screen  

Table Column Description
Zone Index The sequential index number of the created zone.This field is read-only. Up 

to 32 zones can be added.
Zone Name The name of the zone. This field is read-only and is created when adding 

or modifying a new Messaging Zone.
Position Displays the X,Y position (in multiples of 16 pixels) of the logo placement 

and whether the X axis is from the Left or Right (L or R) and the Y axis is 
from Top or Bottom (T or B).

Zone Status The status of the Logo Overlay Zone. This field is read-only. Possible 
choices are:
• Enable: Logo Overlay zone is ready to start Logo Overlays.
• Logo Loaded: Logo is loaded on the BNP and is ready to start overlay. 
• Logo On: Logo is loaded on the BNP and is currently displaying in the 

zone. 
• Scheduled: Logo has been loaded and scheduled, but currently is not 

being displayed. 

Recommendations for Logo TV Screen Positioning
To simplify logo positioning for both SD and HD programs, the TV screen of either SD or HD has been 
divided into four quadrants with the X,Y coordinates positioned relative to each corner: 

• On the X axis, the screen has been divided into left and right from 0 to 960 pixels (based on half the 
width of a typical HD 1920 pixel screen). 

• On the Y axis, the screen has been divided into top and bottom from 0 to 540 pixels (based on half 
the height of a typical HD 1080i screen). 

In this manner a static overlay graphic may be accurately positioned regardless of SD or HD as long as 
the X, Y coordinates for an SD program do not exceed an SD’s resolution. In order to ensure accurate 
positioning, it is recommended that the X, Y coordinates be kept to a relatively low number. 
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Figure 43 shows an example of Logo Overlay positioning for an HD program (top graphic) and an SD 
program (bottom graphic). The X, Y coordinates for the green logo boxes have been set to relatively 
low numbers (x=64, y=64) so as to remain positioned closer to the corners of the TV screen for both 
HD and SD resolutions. The X, Y coordinates for the blue logo have been set to high numbers (x=900, 
y=500). As such, while the logo for an HD resolution of 1920 x 1080i is positioned in the center of the 
screen, the X, Y values are too large for the blue logo to be placed within the bounds of an SD screen at 
720 x 480i resolution.

Figure 43. Logo Overlay Positioning
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Configuring a Logo Overlay Zone
Use the Add Logo Overlay Zone screen (Figure 44) to set parameters for a specific logo and use of the 
logo in a zone.

Menu Path  Configuration tab-> Messaging System tab -> right-click on white or blue row for popup menu -
> select Add Logo Overlay Zone.

Note: You must be logged in as the Administrator to add, modify, or delete Logo Overlay Zone 
configuration.
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Figure 44. Logo Overlay Zone screen

1. At the Add Logo Overlay Zone screen, enter information to supply zone and logo information. 
Parameter and button descriptions are provided in the following tables:

- Table 50, “Zone Index and Name - Zone Overlay,” on page 84.
- Table 51, “Logo Configuration - Zone Overlay,” on page 84.
- Table 52, “Zone Status - Zone Overlay,” on page 85.
- Table 53, “Logo Import - Zone Overlay,” on page 85.
- Table 54, “Crawl, Frequency, Scheduling - Zone Overlay,” on page 86.
- Table 55, “Buttons - Zone Overlay,” on page 86.

2. Click Apply to save and apply your settings. 



Table 50. Zone Index and Name - Zone Overlay

Field Description
Zone Index The sequential index number of the created zone.This field is read-only. Up 

to 32 zones can be added.
Zone Name The name of the zone. This field is read-only and is created when adding 

or modifying a new Messaging Zone.

Table 51. Logo Configuration - Zone Overlay

Field Description
X Position (0 to 960)
(Multiple of 16 pixels)

Enter the pixel number (in multiples of 16) where the logo will begin for 
the X position (horizontal) of either the left or right quadrants of the TV 
screen.

(X Position) From Left Click this button if the logo’s X position is to start from the left quadrant of 
either the top or bottom quadrant.
For example, if the X position were set to 32 and the From Left button 
selected, the logo’s left most edge would start 32 pixels from the left 
quadrant of either the top or bottom quadrant (whichever is selected).

(X Position) From 
Right

Click this button if the logo’s X position is to start from the right quadrant 
of either the top or bottom quadrant. 
For example, if the X position were set to 32 and the From Right button 
selected, the logo’s right most edge would start 32 pixels from the right 
quadrant of either the top or bottom quadrant (whichever is selected).

Y Position (0 to 540)
(Multiple of 16 pixels)

Enter the pixel number (in multiples of 16) where the logo will begin for 
the Y position (vertical) of either the top or bottom quadrants of the TV 
screen.

(Y Position) From Top Click this button if the logo’s Y position is to start from the top quadrant of 
either the left or right quadrants.
For example, if the Y position were set to 32 and the From Top button 
selected, the logo’s top most edge would start 32 pixels from the top 
quadrant of either the left or right quadrants (whichever is selected).

(Y Position) From 
Bottom

Click this button if the logo’s Y position is to start from the bottom 
quadrant of either the left or right quadrants.
For example, if the Y position were set to 32 and the From Bottom button 
selected, the logo’s bottom most edge would start 32 pixels from the 
bottom quadrant of either the left or right quadrants (whichever is 
selected).

Enable Mask Check this box if the BNP is to display and support alpha channel 
transparency configurations inherent to the imported graphic. For more 
information, see “Alpha Channel Transparency” on page 79.
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Table 52. Zone Status - Zone Overlay  

Field Description
Start Time Read-only field. Displays the day, date, and time that the crawl has or will 

begin. 
Remaining Time Read-only field. If a limit was placed on the duration of the alert, the time 

remaining (in a running-down counter) is displayed here.
Event Duration Read-only field. Displays how long the event is to take place.
Current Status This field is read-only and will display one of the following values:

• Enable
• Logo Loaded
• Logo On 
• Scheduled
See Table 49 for a complete description of these values.

Next Start Time Read-only field. Displays the time that the next round of messaging will 
begin.

Table 53. Logo Import - Zone Overlay

Field Description
Logo Image Displays the location and name of the imported graphic that has been 

uploaded to the BNP. 
Import Graphic... Click this button to select a PNG file from the local computer on which the 

Element Manager is running. 
Logo Render Preview 
(Max logo image size 
is 256x176 pixels)

When uploading a new graphic to the BNP, it will be displayed here. After 
the logo has been uploaded (i.e., Apply has been clicked), and the Logo 
Overlay window is closed, the graphic will not be displayed again, 
however, the file name will still be displayed in the Logo Image field.
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Table 54. Crawl, Frequency, Scheduling - Zone Overlay

Field Description
Crawl Duration This section provides the following options for the duration of the text 

crawl:
• Play xxx Seconds: Displays the graphic for the specified number of 

seconds (with a 5 second or one cycle minimum). Logo will display for 
the duration that is longest: specified value of seconds OR one cycle.

• Continuous: Continuously displays logo until the Stop button is clicked.
Crawl Frequency Choose between two options for how often message is played:

• Once: Displays graphic once or for specified number of seconds (see 
above).

• Every: Select either 30 or 60 to display graphic every thirty or sixty 
minutes, either for one cycle or for specified number of seconds (see 
above) from the moment Start is clicked until the moment Stop is 
clicked.

Schedule - Start 
(button)

The BNP permits you to start a message immediately or schedule it. 
• Now: Starts play immediately. 
• Time: Allows you to schedule start time. Click on pulldown arrow to 

display a popup window (seen in Figure 37, “Advanced Messaging 
Schedule Window,” on page 71) to set start.

Schedule - Stop 
(button)

• Forever: If message is set to play once (see Frequency, above) this is 
the default. 

• Time: When Frequency is set to every 30 or 60 minutes, the Scheduler 
popup is enabled. Click on the pulldown arrow to display (seen in 
Figure 37, “Advanced Messaging Schedule Window,” on page 71) and 
set.

Table 55. Buttons - Zone Overlay

Field Description

Show Program List Clicking this button will open the Show Program List window, which 
displays all programs associated for the specified zone. 
• This button only appears when modifying a zone, and not when 

creating a zone.
Enable Status Update/ 
Disable Status Update

Clicking this button will enable real-time polling of the Logo Overlay 
Zone Status fields.
• When the Enable Status Update button is clicked and real-time polling 

enabled, the button will change to Disable Status Update. Clicking the 
Disable Status Update button will disable real-time polling.

• This button only appears when modifying a zone, and not when 
creating a zone.
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Modifying a Logo Overlay Zone
Use the Zone Overlay Zone screen (Figure 45)—for a specified zone—to modify parameters for the 
logo overlay. 

Menu Path  Messaging System tab -> Logo Overlay Zones subtab -> double-click the zone or right-click the 
zone for popup menu -> select Modify Logo Overlay Zone.

Note: If a Logo Overlay is currently On (click the Enable Status Update button to see real time status 
updates of the zone), stop the overlay first before modifying desired parameters. 

Figure 45. Modify Logo Overlay Zone window

1. Use guidelines from the following references to modify fields in the Zone Overlay:

- Table 50, “Zone Index and Name - Zone Overlay,” on page 84.
- Table 51, “Logo Configuration - Zone Overlay,” on page 84.
- Table 52, “Zone Status - Zone Overlay,” on page 85.
- Table 53, “Logo Import - Zone Overlay,” on page 85.
- Table 54, “Crawl, Frequency, Scheduling - Zone Overlay,” on page 86.
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- Table 55, “Buttons - Zone Overlay,” on page 86.
2. Click Apply to save and upload new changes to the overlay zone.

Deleting a Logo Overly Zone
1. From the Configuration -> Messaging System -> Logo Overlay Zones menu, highlight and 

right-click on the Logo Overlay Zone you wish to delete.
2. Select Delete Logo Overlay Zone from the pop-up menu (Figure 44, “Logo Overlay Zone screen,” 

on page 83). 

- If no output transport streams are associated with the selected zone, you will be asked to 
confirm deletion of the zone and the zone will be deleted.

- If output transport streams are associated with the selected 
zone, the Delete Messaging Zone dialog will query for 
confirmation of the deletion. 

3. Click Yes to delete the zone and its association to any programs. 

Messaging System Zone Priority
At any given time there can be only one Messaging System zone active for a particular program, even 
though each type of zone (EAS, Operator and Advanced, or Logo Overlay) can be enabled or associated 
to a particular program at the same time. If all associated zones have been activated, the priority of 
message playout is as follows:

1. EAS Messaging - will always override any Operator-defined crawl or Logo Overlay for the duration 
of EAS playout.

2. Operator and Advanced Messaging - will override an active Logo Overlay for the duration of 
playout. If playout is continuous and Logo Overlay is also active, then no Logo Overlay will be seen.

3. Logo Overlay - no override.

As an example, let us assume that a program playing on Channel 2 has all three zones configured with 
EAS, Operator and Advanced, and Logo Overlay zones, with a scheduled Operator Messaging text 
crawl scheduled to playout one cycle every hour and a continuously active Logo Overlay. During the 
time that the Operator Messaging crawl is scheduled to play, the Logo Overlay will not be present, 
however, when the crawl has finished its cycle the Logo Overlay will return. If, at any time, an EAS 
message is generated, both the Operator crawl and the Logo Overlay (after the crawl has finished) will 
be overridden until the EAS messaged has completed its cycle.
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Show Program List 
Within each Messaging System zone you can view which active programs have been configured and 
enabled for messaging services. 

Programs Configured for Messaging Services
When a program is groomed from an input source to an output transport stream, you can specify 
which Messaging System Settings are configured (or associated) on a per program basis. A program 
can be associated with any or all three Messaging zone types (EAS, Operator and Advanced, and Logo 
Overlay). For more information on associating programs for Messaging Zones, see “Managing Output 
Transport Streams” on page 113.

Managing Program Activity for Messaging Service Zones
An output program may join or leave a Messaging Service zone at any time. The changes take effect 
the next time a message event starts. Once a program has been associated with a Messaging Service 
zone, the program can then be enabled or disabled for the specified zone either from the Grooming -
> Mapping screen (see “Managing Output Transport Streams” on page 113) or through the Show 
Program List screen.

The Show Program List screen (Figure 46) displays all output programs across all transport streams on 
all ports (GigE and ASI) that are currently enabled for the selected zone. You can use this screen to 
enable or disable Messaging Service operation for one or all programs in a zone.

Use any of the following methods to access the Zone Program List:

Menu Path

 Configuration tab -> Messaging System tab -> Messaging Zones screen -> right-
click in the zone’s row for popup menu --> select Show Program List (Figure 46).
OR
Configuration tab -> Messaging System tab -> Logo Overlay Zones screen -> right-
click in the zone’s row for popup menu -> select Show Program List.
OR
From the Modify Messaging Zone screen -> click the Show Program List button. 
OR
From the Modify Logo Overlay Zone screen - > click the Show Program List button.
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Figure 46. Show Program List

To view the specific programs and whether or not they are enabled for Messaging Services, click the + 
icon alongside a listed transport stream. 

Enabling or Disabling Specific Programs for Messaging

At the Zone Program List screen, use either the popup menu or screen buttons to enable or disable a 
specific program for messaging. 

• uTo use the popup menu, highlight, then right-click on a 
program and select Enable or Disable.

• To use screen buttons, click the Enable or Disable button at the 
bottom of the Zone Program List screen. 

Enabling or Disabling All Configured Programs for Messaging 

At the Zone Program List screen, click the Enable All or Disable All button at the bottom of the 
screen.
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Viewing Messaging Status

At the Zone Program List screen, look for the following icons to view which programs under a specific 
transport stream are either configured only, or configured and enabled for messaging (Figure 47): 

• An icon with a dark brown line under the green arrow is configured but not enabled for messaging.
• An icon with a pink line under the green arrow is configured and enabled for messaging.

Figure 47. Messaging Zone Icons

Messaging configured: enabled program

Messaging configured: disabled program

Refreshing a Program List 

Click the Refresh button from the bottom bar of the Zone Program List to update the view.

Quick-View Program Status via Scroll-over 

At the Zone Program List screen, point your cursor on a 
program name and hover. A popup view of the current 
status of the program will be displayed. 

Creating Messaging Zone Transport Streams and Output Programs

To create a transport stream or output program to use a Messaging Zone, see “Managing Output 
Transport Streams” on page 113 and “Creating Programs” on page 130.
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SNMP Trap Agent Configuration
You can use SNMP to monitor and control network devices as well as manage configurations and 
collect statistics. Use either an in-band or an out-of-band IP interface to manage the system with SNMP. 
At the BNP, you can configure from one to eight trap addresses; each of which will issue event 
notifications to the network management status. You can change this SNMP information at any time. 

To Configure SNMP for System Management with SNMP
1. Assign an IP address to an in-band Ethernet port.
2. Set the destination IP address to which the traps are forwarded by the system agent.

Use the SNMP Trap screen (Figure 48) to set up to eight IP addresses for SNMP traps. 

Menu Path  Configuration tab -> SNMP Trap screen.

Figure 48. SNMP configuration window.
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CHAPTER 5

System Redundancy 

Use guidelines in this chapter to set up a pair of BNP systems for redundant operations. To find out 
how to clear a redundancy, see “Removing Chassis Redundancy” on page 198.

Applicable Platforms: The information in this chapter can be used with any BNP device. 

In This Chapter:
• “Overview,” next.
• “Basic BNP Redundancy Configuration” on page 96.
• “Forcing Redundancy” on page 98.
• “Synchronizing Redundant BNP Systems” on page 98
• “Configuring GigE Ports for Heartbeat Detection” on page 98.

Overview
A redundant BNP configuration consists of two BNP systems; one BNP operates as the active system, 
and the other BNP serves as the standby system. During normal operations, each listens for the 
heartbeat of the other to ensure that the partner system is alive and operational. Upon detection of no 
heartbeat, the standby system takes over operations until the previously active system is ready to 
resume operations. 

Heartbeats are detected primarily over the IP network as a result of your configuration that establishes 
connectivity through the active and standby management ports (as described in “Basic BNP 
Redundancy Configuration” on page 96).

If the network connection to the 10/100 control port on the active chassis fails, both chassis will have 
the same output. Because this can be confusing to the network, and to ensure continuous healthy 
operations, Imagine Communications recommends that you also set up a direct connection between 
the active and standby GigE 8 ports, as described in “Configuring GigE Ports for Heartbeat Detection” 
on page 98.

Before You Begin
Prior to setting parameters for 1:1 BNP system redundancy, please review the caveats provided in the 
following topics:

• “Conditions and Restrictions,” next. 
• “1:1 Redundancy Best Practices and Considerations” on page 94. 
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Conditions and Restrictions
1. Software Version: �

Ensure that the BNPs to be configured for 1:1 redundancy are running the identical BNP software 
version.

2. IP Addresses: �
Because you will be setting the Virtual IP address for the GigE ports, the 10/100BaseT management 
port, or the 10/100BaseT DVB-CA port (on a BNP 3xr), you must first have valid physical 
IP addresses for these ports. 

3. Virtual IP address: �
Both active and standby chassis must have the same virtual IP address: one VIP for the 10/100 
management port and one VIP for the DVB-CA port (ETH 2 on the BNP 3xr).�
An ad or video server should only send ads or video streams to the virtual IP addresses.

4. Virtual gateway (optional): �
Both active and standby chassis must have the identical virtual gateway address for the 10/100 
management port. The same rule applies if configuring the virtual gateway for ETH 2. 

5. GigE ports:�
Currently, the BNP does not support the Gigabit Ethernet input port level redundancy. The 1:1 
chassis level redundancy will cover Gigabit Ethernet input port failure events (such as 
disconnection of the Gigabit Ethernet cable, or loss of the Gigabit Ethernet link).�
When a Gigabit Ethernet port delivers only one program and the program is missing for over 
2 seconds, the 1:1 chassis failover is used, instead of standby program failover.

Note: For hot-standby 1:1 chassis redundancy configured with virtual IP failover, unicast inputs cannot 
be received by both the active BNP and the standby BNP simultaneously. This means that unicast 
stream failover will not be immediate and the standby unit will need to initiate new unicast 
sessions, which will not allow an immediate failover condition for those streams. As an 
alternative, two BNP units without virtual IP coordination could be configured with identical 
streams routed to both units running in parallel with the standby unit output muted.

1:1 Redundancy Best Practices and Considerations
The following information must be considered when working with 1:1 chassis-level redundancy:

• The configuration of the standby chassis is not available from the BNP Element Manager while the 
unit is a standby unit.

• Because the virtual subnet mask is not configurable, the virtual IP address must be on the same 
subnet as the physical chassis IP addresses.

• Any changes to the virtual IP address requires a reboot of the active chassis.

Redundancy Management
Use the Global tab screen (Figure 49) to view and configure parameters applicable to the BNP system 
redundancy. 

Menu Path Access via BNP Element Manager Configuration tab -> Global tab screen.

This chapter focuses primarily on use of the Redundancy portion (lower half) of this screen. The 
parameters are described in Table 56.
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After you complete the “Basic BNP Redundancy Configuration” on page 96, you can also use this 
screen to switch the roles of the current active and standby BNPs, by clicking the Redundancy Switch 
button (see also “Forcing Redundancy” on page 98).

Figure 49. Global tab screen

Table 56. Chassis Redundancy Parameters

Field Description/Values
Chassis Active Status Read-only field that displays the current role of this chassis, as either Primary 

or Standby.

Redundancy Switch (button) Toggle the Primary and Standby BNPs in a redundant configuration.

 IP Address for 10/100 Enter the IP address of the 10/100 port at the partner system:
• In the BNP Element Manager GUI for the Active chassis, enter the IP 

address of the Standby chassis.
• In the BNP Element Manager GUI for the Standby chassis, enter the IP 

address of the Active chassis.

IP Address for GigE 8 
(Optional)

Enter the IP address of the GigE 8 port, if used, to pass redundancy 
information.
This port is essential to the configuration described in “Configuring GigE Ports 
for Heartbeat Detection” on page 98.
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Basic BNP Redundancy Configuration

Eth0    10/100
BNP - Standby

GigE 1
GigE 2
GigE 3
GigE 4
GigE 5
GigE 6
GigE 7
GigE 8

Eth0    10/100
BNP - Active

GigE 1
GigE 2
GigE 3
GigE 4
GigE 5
GigE 6
GigE 7
GigE 8

Virtual IP
Mgmt IP of Active Mgmt IP of Standby

Web Browser
The configuration steps in this section establish 
an active and a standby BNP, and ensure that 
the two systems can listen to each other via 
their respective management ports.

Use steps in this section to first configure the 
standby BNP, then configure the active BNP, as 
described in the following topics:

• “Step 1 (of 2)—Configure the Standby BNP 
Chassis,” next.

• “Step 2 (of 2)—Configure the Active BNP 
Chassis” on page 97.

Step 1 (of 2)—Configure the Standby BNP Chassis 
Complete steps 1 through 8 of this standby chassis configuration, before attempting to configure the 
active chassis for the redundant pairing. 

1. Log in to the Element Manager of the standby chassis as described in “Log in and Access the BNP 
Element Manager” on page 25.

2. If you have not already done so, go to the Configuration -> Ethernet Control Port tab screen, 
and change the IP Configuration, IP Address, Subnet Mask, and Gateway fields for Ethernet Port 1 
and Ethernet Port 2 of this standby chassis to the appropriate parameters for your network. �
See “Ethernet Control Port Configuration” on page 43 for more information. 
Modification to any of these parameters requires a system reboot. The system will prompt for the 
reboot after you click Apply Configuration. 
You will need to re-launch the BNP Element Manager and log in again to this standby following this 
reboot. 

3. From the BNP Element Manager of the standby chassis, go to the Configuration -> Global tab 
screen and enter data into the following fields:

- Redundant Chassis Configuration:�
IP Address for 10/100: Type the IP address of the active BNP Ethernet control port.

- Virtual IP Address Configuration:
• IP Address for 10/100: Type the IP address of the 10/100 port to be shared by both the 

active and standby chassis.
• IP Address for ETH2: Type the IP address of the Ethernet 2 port that is to be share by both 

the active and standby chassis, for the DVB-CA management port (BNP 3xr only). 
• Gateway for 10/100: Type the IP address of the gateway to be used by both active and 

standby chassis. 
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• Gateway for ETH2: Type the IP address to be shared by both the active and standby 
chassis.

4. At the Global tab screen, click Apply Configuration.
5. Wait two minutes for the configuration to be saved. During this time, a change will occur to the 

BNP GUI status bar: Look for the addition of an indicator showing Active and Standby BNP IP 
addresses.

6. From the BNP Element Manager main menu, go to Maintenance (Alt m)--> License Manager to 
display the License Manager screen.

• At the License Manager screen, confirm there are no entries in any of the License Key fields. �
See “Managing Licenses” on page 190 for more information. 

• If you see entries in any of these fields, please contact Imagine Communications Customer 
Support for assistance on how to remove the license keys.

7. From BNP Element Manager main menu, go to Maintenance (Alt m)-> Shutdown to shut down 
this BNP and exit the GUI. 

8. Physically remove power from the standby chassis.

Step 2 (of 2)—Configure the Active BNP Chassis 
Complete all steps in this section only after completing the steps provided in “Step 1 (of 2)—Configure 
the Standby BNP Chassis” on page 96.

1. Log in to Element Manager of the active chassis, as described in “Log in and Access the BNP 
Element Manager” on page 25.

2. From the BNP Element Manager of the active chassis, go to the Configuration -> Global tab and 
enter data into the following fields:

- Redundant Chassis Configuration:�
IP Address for 10/100: Type the IP address of the standby BNP Ethernet control port.

- Virtual IP Address Configuration:
• IP Address for 10/100: Type the IP address of the 10/100 port to be shared by both the 

active and standby chassis.
• IP Address for ETH2: Type the IP address of the Ethernet 2 port that is to be shared by 

both the active and standby chassis, for the DVB-CA management port (BNP 3xr only)
• Gateway for 10/100: Type the IP address of the gateway to be used by both active and 

standby chassis. 
• Gateway for ETH2: Type the IP address to be shared by both the active and standby 

chassis.
:

3. At the Global tab screen, click Apply Configuration.
4. From the BNP Element Manager main menu, go to Maintenance (Alt m)--> License Manager to 

display the License Manager screen. 
Check the License Manager to ensure that this active chassis has a license key.

5. Physically remove power from this active chassis.
6. Apply power to this active chassis and wait for it to fully boot up.
7. Apply power to the standby chassis.
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Forcing Redundancy
Caution: Care is needed when selecting this action: forcing a redundancy change will temporarily (and 

briefly) interrupt services during the failover process.

To force the current redundancy configuration to change (the secondary will become the active, or vice 
versa), click the Redundancy Switch button from the Configuration -> Global tab.

Synchronizing Redundant BNP Systems
Use steps in this section to force an NTP server sync in a 1:1 redundancy configuration. 

Perform the following tasks at both the active and the standby BNPs.

1. Log in to the standby chassis, using the physical IP address of the standby BNP.
2. At the BNP Element Manager, go to Configuration tab -> Global tab screen, and click the Force 

Sync button. The system now queries for confirmation. 
3. At the Force Sync confirmation dialog, click Yes. The system now queries for administrative 

password.
4. At the Password Verification dialog type the Administrator password, then click OK.The system 

now queries for confirmation to reboot this BNP. 
5. At the The Reboot confirmation window, click Yes.
6. Allow the standby BNP to reboot and return to its available backup status.
7. Log in to the active BNP, using its Virtual IP address.
8. From BNP Element Manager, go to Configuration tab -> Global tab screen, and click the 

Redundancy Switch button. The standby chassis now becomes the active chassis.
9. Log in to the new standby BNP (formerly, the active chassis) via its physical IP address.
10. At the Force Sync confirmation dialog, click Yes. The system now queries for administrative 

password.
11. At the Password Verification dialog type the Administrator password, then click OK.

The system now queries for confirmation to reboot this BNP. 
12. At the The Reboot confirmation window, click Yes.
13. Allow the new standby BNP to reboot and return to its available backup status.

Configuring GigE Ports for Heartbeat Detection
In this configuration, each BNP is configured at the global level to disable auto-negotiation, and at the 
port level to recognize the partner management IP and GigE 8 port IP address. Additionally, the virtual 
IP address setting for GigE 8 ports must be blank (Figure 50). 
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Figure 50. BNP Redundancy via Direct Connection

Eth0    10/100
BNP - Standby

GigE 1
GigE 2
GigE 3
GigE 4
GigE 5
GigE 6
GigE 7
GigE 8Port 

IP

Eth0    10/100
BNP - Active

GigE 1
GigE 2
GigE 3
GigE 4
GigE 5
GigE 6
GigE 7
GigE 8 Port 

IP

Crossover
Cable

Virtual IP
Mgmt IP of Active Mgmt IP of Standby

Web Browser

Configuration
• Autonegotiation = Off.
• IP Address for 10/100 = Mgmt IP address 

of active BNP. 
• Virtual IP Address = none (blank).
• IP Address for GigE port = �

Port IP of GigE 8 of the active BNP. 

Configuration
• Autonegotiation = Off.
• IP Address for 10/100 = Mgmt IP address 

of standby BNP. 
• Virtual IP Address = none (blank).
• IP Address for GigE port = �

Port IP of GigE 8 of the standby BNP. 

This configuration will ensure that the active and standby BNPs may continue to listen for heartbeats if 
their management ports can no longer detect heartbeats over a faulty IP connection. 

Use the following information and steps to set up a heartbeat configuration using cable-to-cable 
(cross-over) connection between the GigE8 ports of the active BNP and the standby BNP. 

• “Prerequisites,” next.
• “Configuring the Active BNP” on page 100.
• “Configuring the Standby BNP” on page 101.

Prerequisites

The following assumptions apply to this configuration:

• The active and standby BNPs are configured with IP addresses at their management ports.
• The active and standby BNPs are running on the same IP subnet. 
• A cross-over cable physically connects the active BNP and the standby BNP at their GigE ports. 
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Configuring the Active BNP
1. Log in to the BNP Element Manager of the active BNP. 
2. From the BNP Element Manager of the active chassis, go to Configuration --> GigE Ports tab 

screen, and disable (uncheck) Auto Negotiation for GigE 8 (Figure 51). 

Figure 51. Active BNP—Disable Auto Negotiation

Uncheck (disable) auto-negotiation for GigE 8

3. Go to the Configuration -> Global tab screen (Figure 52), and enter the following information:

- IP Address for 10/100: Type the IP address of the standby BNP management port.
- IP Address for GigE 8: Type the IP address of the standby BNP GigE 8 port. 
- Virtual IP Address Configuration for GigE 8: Make sure this field is blank. 
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Figure 52. Active BNP—Set Chassis Redundancy

ENTER INFORMATION ABOUT THE STANDBY BNP

BLANK

Configuring the Standby BNP
1. Log in to the BNP Element Manager of the standby BNP. 
2. From the BNP Element Manager of the standby chassis, go to Configuration -> GigE Ports tab 

screen, and disable (uncheck) Auto Negotiation for GigE 8 (Figure 53).

Figure 53. Standby BNP—Disable Auto Negotiation

Uncheck (disable) auto-negotiation for GigE 8

3. Go to the Configuration -> Global tab screen (Figure 54), and enter the following information:

- IP Address for 10/100: Type the IP address of the active BNP management port.
- IP Address for GigE 8: Type the IP address of the active BNP GigE 8 port.
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- Virtual IP Address Configuration for GigE 8: Make sure this field is blank. 

Figure 54. Standby BNP—Set Chassis Redundancy

ENTER INFORMATION ABOUT THE ACTIVE BNP

BLANK
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CHAPTER 6

Grooming and PSIP

This chapter describes how to perform grooming and Program and System Information Protocol (PSIP) 
tasks on the Selenio™ BNP, using the BNP Element Manager. Topics focus on tasks performed with the 
Grooming function to map transport streams and programs, and to monitor bitrates. 

Applicable Platforms: The information in this chapter can be used with any BNP device. 

In This Chapter:
• “Before You Begin,” next.
• “Grooming - Mapping” on page 104.
• “Monitoring Bitrates” on page 182.

Before You Begin
Before you begin performing grooming tasks, complete the general configuration described in 
Chapter 4, "System Configuration."
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Grooming - Mapping
Grooming refers to the process of grouping specific input programs and services from multiple sources 
into different packages, such as customized channel lineups for subscribers. Using guidelines provided 
in this chapter, you can select-and-drag transport streams or programs from the input column into 
specific output GigE/ASI interfaces, transport streams or programs. 

Use the Mapping tab screen (Figure 55) to manage your grooming operations (Table 57) for the BNP 
GigE ports. 

Table 57. Grooming and Mapping Functions

Function For more information
• Create input and output streams. “Creating Input Transport Streams” on page 109.

• Create output program “Creating Programs Manually” on page 131.

• Perform drag and drop grooming on individual 
programs or full transport streams.

“Drag and Drop Grooming” on page 140.

• Set program schedule. “Scheduling Grooming - One time event” on page 151.

Menu Path BNP Element Manager Grooming tab -> Mapping tab screen.

Figure 55. Grooming-Mapping View - Collapsed View

GigE and ASI 
Groupings

INPUTS PANEL OUTPUTS PANEL

• The Inputs panel of the Mapping tab screen displays all existing transport streams, program 
names, and elementary streams for input on BNP ports. 

• The Outputs panel of the Mapping tab screen displays output content after you apply input data 
into entities at the output panel. You can do this by using either of the following two methods:
- Use the popup menu from an entity at the Outputs panel to create an transport stream or 

program.
- Drag and drop input transport streams or programs into specific entities at the Outputs panel.

The GigE ports that you configured (as described in “GigE Port Configuration” on page 44) are shown 
in the Inputs (left) column, and color coded in accordance with current status:
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• Active ports are displayed as green icons
• Inactive ports are display as gray icons. 

From any GigE port displayed in this screen, you can create transport streams. From the Inputs panel, 
the transport streams can be selected and dragged into output ports at the Outputs panel. Each input 
transport stream has associated PSIP information where appropriate. Other types of transport streams 
may show similar information. 

Figure 56.

Mapping
INPUTS

GigE <#>

Modify Port Name
Show Port Usage

TS‐
Modify Transport Stream
Refresh Transport Stream Tables
Delete Transport Stream

Modify Program Name
Delete Program
Rollback Original Program Name

Program <#>

Add Elementary Stream
Display Groomed Targets
Bitrate Monitor

Ghost Program
Modify Ghost Program
Delete Ghost Program
Rollback Original Program Name
Add Elementary Stream
Display Groomed Targets
Bitrate Monitor

Delete All Transport Streams
Create Transport Stream

Bitrate Monitor
Create Ghost Program

Show History of CUEIs Received

Show History of CUEIs Received
ASI <#>

Modify Port Name
Show Port Usage

TS
Modify Transport Stream
Refresh Transport Stream Tables
Recreate Input Transport Stream
Create Ghost Program
Bitrate Monitor

Ghost Program
Modify Ghost Program
Delete Ghost Program
Rollback Original Program Name
Add Elementary Stream
Display Groomed Targets
Bitrate Monitor
Show History of CUEIs Received

STT
TVCT
MGT

RRT

PAT

PMT
Video
Audio

CUE

Data

Mapping
OUTPUTS

GigE <#>

Modify Port Name
Show Port Usage

Delete All Transport Streams
Create Transport Stream

TS
Modify Transport Stream
Delete Transport Stream
Create Program
Delete All Programs
Display Grooming
Bitrate Monitor

PAT

Program <#>

PMT

Delete

ASI <#>

Modify Port Name
Show Port Usage

TS
Modify Transport Stream
Delete Transport Stream
Create Program
Delete All Programs
Display Grooming

Program <#>

Create Transport Stream (FAT ASI)
Create Transport Stream

Bitrate Monitor

Modify  Program
Delete Program
Manage Elementary Streams
Manage Descriptor Rules
Display Grooming
View Grooming Source
Show History of DPI Activity

Modify  Program
Delete Program
Manage Elementary Streams
Manage Descriptor Rules
Display Grooming
View Grooming Source
Show History of DPI Activity

Video

Audio

View Grooming Source

Video

Audio

View Grooming Source

Delete

View Grooming Source
Delete

View Grooming Source

Delete

Inputs and Outputs
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Expanding and Collapsing Mapping Views

Programs are displayed under the transport stream in which they arrive (or to which they are output), 
and the elementary streams are displayed beneath their program ID. Each transport stream has an 
associated set of programs and PSIP tables. Each program includes video, audio, and PSIP tables which 
result in display of numerous icons. See Table 58, “Program Status Icons,” on page 106 and Table 59, 
“Elementary Stream Icons,” on page 107 for details about the icons. 

With the Mapping tab screen in view, you can elect to expand or collapse the entire view or individual 
views. Expanding and collapsing affect only the display, This function does not change the underlying 
grooming.

• To expand the view of an individual entity, click on the + symbol and the content will be revealed.�
To collapse the view, click the- symbol and the contents will be hidden. 

• For screen-wide expand/collapse, use the main menu View -> Expand Mapping (Alt v, Alt e) 
option, or the View -> Collapse Mapping (Alt v, Alt c) option. 

Figure 57. View --> Expand Mapping to View All Contents

Programs and Elementary Streams

In an expanded view, you can see any program(s) currently associated with a BNP port. All programs on 
both the Inputs and Outputs panels are displayed alongside status icons (Table 58), which reveal the 
program source. 

Table 58. Program Status Icons

Symbol Name
Network Program

Messaging Services Configured, Program Disabled

Messaging Services Configured and Program Enabled

Digital Program Insertion (DPI)
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The Mapping tab screen displays all Elementary Streams (ESs), on both the Inputs and Outputs 
panels, alongside icons (Table 58) that indicate ES type and stream type. Elementary Streams are listed 
beneath an associated program when the view is expanded. 

Messaging Services Configured with DPI

Encrypted Program

Inactive

Table 59. Elementary Stream Icons

Symbol ES Type Stream Type Description
Video MPEG2  2 (0x2)�

H.264   27 (0x1b)�
SCTE  128 (0x80)

Represents the presence of a video elementary stream 
on an input or output program.

Audio MPEG1�
MPEG2�
AC-3 (0x06)�
AC-3 (0x81)�
AAC (0x0f)�
HE-AAC (0x11)
E-AC-3

Represents the presence of an audio elementary stream 
on an input or output programs. 
Available audio options are:
None�
Arabic�
English�
French�
German�
Hindi�
Italian�
Japanese�
Mandarin Chinese�
Portuguese�
Russian�
Spanish

Data 5�
6 Teletext�
6 Sub Title�
7 – 191�
192�
193-255

Represents the presence of a data elementary stream 
with all stream types except: 
5 EBIF�
5 EISS�
192 EBIF�
192 EISS
A blue data stream icon can be displayed on either an 
input or an output program.

Data 5 EBIF�
5 EISS�
192 EBIF�
192 EISS

Represents the presence of an EBIF or EISS data 
elementary stream.
A blue data stream icon can be displayed on either an 
input or an output program.

Table 58. Program Status Icons

Symbol Name
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Viewing Program-Level Input Source

Menu Path From the BNP Element Manager, go to the Grooming tab -> Mapping tab screen 

At the Mapping tab screen, use the following procedure to view the input source of a selected output 
program.

1. Right-click on a program in the Outputs panel (Figure 58), and select View Grooming Source 
from the popup menu. 

2. Look at the row now highlighted in the Inputs panel. The highlighted row is grooming source for 
the selected program. 

Figure 58. Viewing program-level input source

Data 5�
6 Teletext�
6 Sub Title�
7 – 191�
192�
193-255

Represents the presence of an ES-level groomed data 
stream with all data stream types except: 
5 EBIF�
5 EISS�
192 EBIF�
192 EISS
A green data stream icon can only be displayed on an 
output program.

Data 5 EBIF�
5 EISS�
192 EBIF�
192 EISS

Represents the presence of an ES-level groomed EBIF 
or EISS data stream. 
A green data stream icon can only be displayed on an 
output program.

Table 59. Elementary Stream Icons

Symbol ES Type Stream Type Description
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Viewing ES-Level Input Source

At the Mapping tab screen, use the following procedure to view the input source of a selected 
Elementary Stream (ES). 

1. Expand the output program to display the ES you wish to view on the Outputs panel.
2. Right-click on the ES in the Outputs panel (Figure 59), and select View Grooming Source from 

the popup menu. 
3. Look at the row now highlighted in the Inputs panel, which is the grooming source for the 

selected program. 

Figure 59. Viewing ES-level input source

Highlighted source

Creating Input Transport Streams

The information required to create a transport stream (TS) depends on whether you are creating a 
transport stream on an input port or an output port, and on the type of TS created. Each TS creation 
dialog is described here.

Basic Input Transport Stream Creation
Use the Create GigE Input Transport Stream dialog (Table 60 and Table 60) to set parameters for an 
input transport stream. 

Menu Path BNP Element Manager Grooming tab -> Mapping tab screen - > Inputs panel -> right-click on an 
input port for popup menu -> select Create Transport Stream.



SelenioTM BNP  User Guide, Release 3.7.1 110

Grooming and PSIP - Grooming - Mapping

Figure 60. Create GigE Input TS
Selecting �
No SSM 
Redundancy

Selecting �
SSM 
Redundancy

1. At the Create GigE Input Transport Stream dialog, enter information about the transport stream.
2. Click OK to apply the configuration and to dismiss the dialog. The new TS will now be displayed in 

the Inputs panel for the specified port.

Table 60. Create GigE Input Transport Stream Parameters

Input Transport Stream Description
GigE Port This is the read-only port ID, and is based on the selected GigE port (GigE 1, 

GigE 2, etc.)

TS Name Alphanumeric string to name the transport stream. This name will be displayed 
on the mapping page. 

Multicast If this is a multicast stream, check this box to enable multicast.

SSM Redundancy Check to enable Source Specific Multicast (SSM) mode. If checked, you can 
configure up to four source IP addresses.
SSM Redundancy can only be checked if Multicast is also checked.

IP Address The unicast or multicast IP address on which the stream is received. 

UDP Port Enter the UDP port to use for transmitting data.

Source IP Address [1-4] The IP address of the source from which the stream is originating.
The Source IP Address can only be configured if Multicast is checked.
If SSM Redundancy is unchecked, Source IP Address 1 is available and 
optional and should only be included for IGMPv3/SSM transport streams.
If SSM Redundancy is checked, Source IP Address 2 to 4 are available. At least 
two source IP addresses must be configured. All source IP addresses must be 
unique.

Multiple TS Click this button if you are creating multiple transport streams. You can create 
incrementing IP addresses, incrementing UDP ports, or incrementing IP 
Addresses and UDP ports simultaneously. See also “Multiple IP and UDP 
Creation” on page 111/ 
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Multiple IP and UDP Creation
Use the Select Multiple IP and UDP dialog (Figure 61 and Table 61) to set parameters for multiple 
transport streams. 

Menu Path
BNP Element Manager Grooming tab -> Mapping tab screen -> Inputs panel -> right-click on an 
input port for popup menu -> select Create Transport Stream -> Create GigE Input Transport 
Stream dialog, click Multiple TS. 

Figure 61. Selecting Multiple UDP/IP Ports

1. At the Select Multiple IP and UDP dialog, use guidelines from Table 61 for this configuration.
2. Click OK to apply the settings to the GigE input TS, and to return to the Create GigE Input 

Transport Stream dialog. 
3. Click OK at the Create GigE Input Transport Stream dialog to save the settings and to place the 

new TS at the Inputs panel of the Mapping screen (see example in Figure 62). 

Table 61. Selecting Multiple IP and UDP

Field Description
Start IP Address A read-only field indicating the starting IP address.

End IP Address A read-only field indicating the ending IP address.

Start UDP A read-only field indicating the starting UDP port number.

End UDP A read-only field indicating the ending UDP port number.

Increment IP Address When checked, the starting IP address will be incremented by one for each 
multiple chosen.

Increment UDP When chosen, the UDP port number will be incremented by one for each 
multiple chosen.

Increment both IP Address 
and UDP

When checked both the IP address and UDP port number will be 
incremented by one for each multiple chosen.

Multiple Number The number of multiple creations, either or both, IPs or UDPs.

Excluded UDP Ports UDP ports that you want excluded from any automatic numbering.

Figure 62. Input Transport Streams created
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Note: Each TSID is a unique number used to identify a transport stream. It is a partition of two 16-bit 
hex numbers. The lower 16 bits is the MPEG transport stream ID. The upper 16 bits (0x) is used 
strictly internally.

Note: There are no configuration parameters required for creating a transport stream on an input ASI 
port. Each input ASI port is automatically configured with one transport stream.

Managing Input Transport Streams
After an input transport stream has been created, various options are available for managing the 
stream, as described in the following topics:

• “GigE Port Transport Stream Options,” next.
• “ASI Port Transport Stream Options” on page 112.

GigE Port Transport Stream Options
Use the popup menu from an input GigE port to view and select operations that can be performed on 
the selected port. 

Menu Path From the Inputs panel of the Grooming -> Mapping screen, right-click on a transport stream 
under a GigE port and select an option (Figure 63, described in Table 62) from the popup menu. 

Figure 63. Input Transport Stream pop-up menu - GigE

ASI Port Transport Stream Options
Use the popup menu from an input ASI port to view and select operations that can be performed on 
the selected port. 

Menu Path From the Inputs panel of the Grooming -> Mapping screen, right-click on a transport stream 
under an ASI port and select an option (Figure 64, described in Table 62) from the popup menu. 

Figure 64. Input Transport Stream pop-up menu - ASI



Table 62. Input Transport Stream pop-up menu options

Menu Description
Modify Transport Stream Allows you to modify only the name of the transport stream. If 

you wish to modify any other parameter, you must delete the 
transport stream and create it again.
If you enabled SSM Redundancy for the transport stream, a 
green dot will indicate the active multicast source IP address.

Refresh Transport Stream Tables When this option is selected, the internal Program Association 
Table (PAT) for this transport stream is invalidated, and the 
next incoming PAT will be used for the associated PSIP and 
DVB tables for selected transport stream.

Delete Transport Stream (GigE only) Deletes the transport stream at the GigE port, and all grooming 
for the associated output programs.

Recreate Input Transport Stream (ASI only) Deletes the transport stream at the selected ASI port and all 
grooming for the associated output programs, and recreates 
the transport stream with no associated grooming.

Create Ghost Program Used for created programs with unreferenced PIDs. See 
“Adding an Unreferenced PID as an Elementary Stream” on 
page 167 for details.

Bitrate Monitor Allows you to monitor bitrates for the selected transport 
stream.
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Managing Output Transport Streams
This section provides information about how to access configuration screens and provide parameters 
for output streams.

Creating MPEG-2 Output Transport Streams
Use the Create Output Transport Stream screen to set parameters for MPEG-2 transport streams, as 
described in the following topics:

• “Creating an MPEG-2 Output Stream on an ASI Port,” next.
• “Creating an MPEG-2 Output Stream on a GigE Port” on page 115.

Creating an MPEG-2 Output Stream on an ASI Port 
Navigate to the Create Output Transport Stream screen for ASI ports (Figure 65, and Table 63), and 
specify MPEG-2 as the TS Type. 

Menu Path
From the Outputs panel of the Grooming -> Mapping tab screen, right-click on an ASI port and 
select Create Transport Stream from the popup menu. 
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Figure 65. Create Output Transport Stream (ASI)—MPEG-2 or SCTE

1. At the Create Output Transport Stream dialog TS Type field, select, MPEG-2.
2. Use guidelines from Table 63 to provide MPEG-2 information in the remaining fields. 
3. Click OK to save your settings and to place the new transport stream in the Outputs panel of the 

Grooming->Mapping tab screen beneath the selected ASI port. 

Table 63. Create Output Transport Stream Dialog Parameters (ASI)—MPEG-2 or SCTE  

Field Description
Port Read-only, shows either ASI or GigE depending on the port selected.

SPTS Check if the output is a single program transport stream (SPTS).

Non-DPI Check this box if the transport stream is to use a Grooming-only (Non-DPI) 
license.

TS Name The (optional) name you want to assign to this output transport stream.

Bitrate (Mbps) The bitrate at which the stream is transported.

Unique TS ID Allows you to assign a unique numeric ID to this transport stream. 
• When this option is checked, the TS ID value placed in this field will be 

reserved as unique for the entire chassis.
• When this option is unchecked, a TS ID value may still be entered, 

however the value may be the same as another TS ID as long as that TS 
ID’s value has not been reserved as a Unique TS ID. 

• Note that each TSID is a unique number used to identify a transport 
stream. It is a partition of two 16-bit hex numbers. The lower 16 bits (user-
specified in decimal and converted to hex) is the MPEG transport stream 
ID. The upper 16 bits (0x) is strictly used internally.

• Default value is “1” if no value is specified.
• Broadcasters must configure this value with a unique ID to meet FCC 

standards.

Reserved Bandwidth Enter any bandwidth value to be reserved from the total bitrate of transport 
stream.

Network PID Decimal value to define the program ID on which network information is 
received.
Note that display of this entry, in applicable screens, is dependent on the 
current setting—as either hexadecimal or decimal—for Configuration--
>Global PID Display.
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Creating an MPEG-2 Output Stream on a GigE Port 
Navigate to the Create Output Transport Stream screen for GigE ports (Figure 66, and Table 64), and 
specify MPEG-2 as the TS Type. 

Menu Path From the Outputs panel of the Grooming -> Mapping tab screen, right-click on a GigE port and 
select Create Transport Stream from the popup menu. 

Figure 66. Create Output Transport Stream (GigE)—MPEG-2 (default multicast view) 

1. At the Create Output Transport dialog TS Type field, select, MPEG-2.
2. Use guidelines from Table 64 to provide MPEG-2 information in the remaining fields. 

TS Type The type of stream. The type of stream you choose determines what other 
information is required. Choices are:
MPEG-2, ATSC, SCTE, or DVB

Enable Messaging System Check this box to allow configuration of Messaging System zones for specific 
programs in this transport stream. See “Messaging System Configuration” on 
page 60 for information on configuring Messaging Zones.

MPEG-2 Aggressive Rate 
Control

Check this box for output transport streams that required more aggressive 
rate control due to severe oscillations from the input bitrate. 

Long Delay to support H.264 
DPI

Check this box for an output TS when it contains an H.264 program on which 
ADs can be placed. Checking this box will allow smooth DPI splicing on 
H.264 programs. 

H.264 Alarm Bitrate Level 
(Mbps)

This setting can assist in maintaining video quality for MPEG-2 video content 
in the presence of other content, such as H.264, which bypasses the BNP’s 
transrater. This is done by generating an alarm when H.264 program 
bandwidth exceeds the percent of the TS bandwidth specified in this setting.
This option is only available if SPTS is unchecked.

Table 63. Create Output Transport Stream Dialog Parameters (ASI)—MPEG-2 or SCTE  (Continued)

Field Description
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3. Click OK to save your settings and to place the new transport stream in the Outputs panel of the 
Grooming-->Mapping tab screen, beneath the selected GigE port. 

Table 64. Create Output Transport Stream Dialog Parameters (GigE)—MPEG-2 or SCTE

Field Description
Port This is read-only and is used for identification purposes.

SPTS Check if the output is a single program transport stream (SPTS).

Non-DPI Check this box if the transport stream is to use a Grooming-only (Non-DPI) 
license.

TS Name The (optional) name you want to assign to this output transport stream.

Multicast Check if the output is for multicast operation.

Bitrate (Mbps) The bitrate at which the stream is transported.

Multicast/Unicast IP The IP address to which the output stream is routed. 
• If Multicast is checked, this must be a valid multicast IP address.
• If Multicast is unchecked, this must be a valid unicast IP address. See also 

Figure 67. 

Reserved Bandwidth (Mbps) Enter any bandwidth value to be reserved from the total bitrate of transport 
stream. 

UDP Port Enter the UDP port to use for transmitting data.

Unique TS ID Allows you to assign a unique numeric ID to this transport stream. 
• When this option is checked, the TS ID value placed in this field will be 

reserved as unique for the entire chassis.
• When this option is unchecked, a TS ID value may still be entered, 

however the value may be the same as another TS ID as long as that TS 
ID’s value has not been reserved as a Unique TS ID. 

• Note that each TSID is a unique number used to identify a transport 
stream. It is a partition of two 16-bit hex numbers. The lower 16 bits (user-
specified in decimal and converted to hex) is the MPEG transport stream 
ID. The upper 16 bits (0x) is strictly used internally.

• Default value is “1” if no value is specified.
• Broadcasters must configure this value with a unique ID to meet FCC 

standards.

Subnet Mask For unicast (Multicast unchecked), enter the subnet mask IP for the unicast 
IP address entered in the Destination IP field.

Network PID Decimal value to define the program ID of transport stream packets which 
contain the network information table. 
Note that display of this entry, in applicable screens, is dependent on the 
current setting—as either hexadecimal or decimal—for Configuration--
>Global PID Display.

ARP If Multicast is checked, this field is hidden. 
If Multicast is unchecked, this box will appear. Un-checking this box will allow 
you to disable the use of Address Resolution Protocol (ARP) and to manually 
specify a MAC address. See also Figure 67.

TS Type The type of stream. The type of stream you choose determines what other 
information is required. Choices are:
MPEG-2, ATSC, SCTE, or DVB.
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Unicast Parameters for GigE Transport Streams
To present the Unicast version of the Create Output Transport Stream dialog, disable (un-check) 
Multicast. The entry fields for Subnet Mask, ARP, and MAC Address are then revealed (Figure 67). 
Other entry fields in this screen are described in Table 64.

MAC Address If Multicast or ARP are checked, this field is read-only. 
For Unicast or if ARP is disabled (un-checked) this field can be modified to 
include a hardcoded MAC address to be used to transport this stream. See 
also Figure 67.

MPEG-2 Aggressive Rate 
Control

Check this box for output transport streams that require more aggressive rate 
control due to severe oscillations from the input bitrate. 

Long Delay to support H.264 
DPI

Check this box for an output TS when it contains an H.264 program on which 
ADs can be placed. Checking this box will allow smooth DPI splicing on 
H.264 programs. 

Diffserv Code Point Set value, in the range 0 - 63, to define the differentiated service code point 
(DSCP) for the output TS. 
The DSCP is a 6 bit field in the IP header that classifies network traffic and 
provides QoS. The BNP allows you to configure a DSCP value for IP packets 
generated for any type of GigE output transport stream. See also “Using 
DSCP” on page 118.
Default = 0

Enable Messaging System Check this box to allow configuration of Messaging System zones for specific 
programs in this transport stream. See “Messaging System Configuration” on 
page 60 for information on configuring Messaging Zones.

Stripped Null Packet Check this box to generate SPTS outputs with no NULL packets to reduce 
the average required bandwidth.
This option is only available if SPTS is checked.
Note: When this mode is enabled, the output TS stream is no longer 
compliant to MPEG2 TS with respect to PCR jitter and accuracy.

H.264 Alarm Bitrate Level 
(Mbps)

This setting can assist in maintaining video quality for MPEG-2 video content 
in the presence of other content, such as H.264, which bypasses the BNP’s 
transrater. This is done by generating an alarm when H.264 program 
bandwidth exceeds the percent of the TS bandwidth specified in this setting.
This option is only available if SPTS is unchecked.

Multiple TS Click if multiple transport streams are used. See “Multiple IP and UDP 
Creation” on page 111 for details.

Table 64. Create Output Transport Stream Dialog Parameters (GigE)—MPEG-2 or SCTE

Field Description



SelenioTM BNP  User Guide, Release 3.7.1 118

Grooming and PSIP - Grooming - Mapping

Figure 67. Create Output Transport Stream (Gig E) MPEG-2 or SCTE (unicast view)

Using DSCP 

For all supported output transport streams on GigE ports, you can configure traffic classifications—
using the Differentiated Service Code Point (DSCP) option—to provide various quality of service levels 
on transport streams configured for a GigE port. This configuration applies only to output transport 
streams on GigE ports: any DSCP on input streams is not carried forward into output streams. 

You can modify a DSCP value at any time following creating of the output transport stream and your 
setting will remain intact following BNP reboots and Release 3.4+ upgrades. A DSCP value configured 
on the active BNP is carried over to the standby BNP and used as output if the standby become active. 

Menu Path Use the Create Output Transport Stream dialog with a selected GigE port, at the Diffserv Code 
Point field, to set a DSCP value (Table 64).

Note: A system downgrade to a release prior 3.4 will remove all DSCP settings. 



SelenioTM BNP  User Guide, Release 3.7.1 119

Grooming and PSIP - Grooming - Mapping

Creating ATSC Output Transport Streams

For ATSC transport types, you must include the information about PSIP tables. The PID values of major 
and minor channels are automatically numbered across the multiplex, reducing the chance of conflict.

Use the Create Output Transport Stream screen to set parameters for ATSC transport streams, as 
described in the following topics:

• “Creating an ATSC Output Stream on an ASI Port,” next.
• “Creating an ATSC Output Stream on a GigE Port” on page 120.

Creating an ATSC Output Stream on an ASI Port
Go to the ATSC version of the Create Output Transport Stream dialog (Figure 68 and Table 65):

Menu Path
From the Outputs panel of the Grooming tab -> Mapping tab screen, right-click on an ASI port 
and select Create Transport Stream from the popup menu. At the Create Output Transport 
Stream dialog TS Type field, select ATSC.

The dialog now provides entry fields for PSIP tables that can be applied to the selected ASI port. 

Figure 68. Create Output Transport Stream (ASI)—ATSC 

Select ATSC to 
reveal the PSIP 
table entry 
fields. 

1. At the Create Output Transport Stream dialog, enter information to define the ATSC transport 
stream:

- Use guidelines from Table 63 to provide ASI port information at the upper portion.
- Use guidelines from Table 65 to provide PSIP information. 

2. Click OK to save the settings, and to put the new TS at the Outputs panel of the Mapping screen, 
beneath the selected ASI port. 
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Creating an ATSC Output Stream on a GigE Port
Go to the ATSC version of the Create Output Transport Stream dialog (Figure 69 and Table 65):

Menu Path
From the Outputs panel of the Grooming tab -> Mapping tab screen, right-click on a GigE port 
and select Create Transport Stream from the popup menu. At the Create Output Transport 
Stream dialog TS Type field, select ATSC.

The dialog now provides entry fields for PSIP tables that can be applied to the selected GigE port. 

Figure 69. Create Output Transport Stream (GigE)—ATSC 

Select ATSC to 
reveal the PSIP 
table entry 
fields. 

1. At the Create Output Transport Stream dialog, enter information to define the ATSC transport 
stream:

- Use guidelines from Table 64 to provide GigE port information at the upper portion.
- Use guidelines from Table 65 to provide PSIP information. 

2. Click OK to save the settings, and to put the new TS at the Outputs panel of the Mapping screen, 
beneath the selected GigE port.



Table 65. Create Output Transport Stream—ATSC PSIP Table Information Configuration Parameters 

PSIP Table Informationa Description
EIT PID (0-3) The Event Information Table (EIT) packet identifier (PID) values can be set 

manually (as a decimal value), overriding the PID in the MGT.
Note that display of this entry, in applicable screens, is dependent on the 
current setting—as either hexadecimal or decimal—for Configuration�
-->Global PID Display.

EIT PID Interval (ms) This value can be set manually, overriding the PID in the MGT. Value in 
milliseconds.

MGT Interval (ms) The Master Guide Table (MGT) is highest order in the ATSC transport stream 
table hierarchy; it also provides program-identification (PID) locations so that 
receivers can locate other tables; the MGT can also inform the receiver of 
changes or table updates.

Modulation Mode Choose one of the following modes from the pull-down menu: 
Analog, SCTE 64 QAM, SCTE 256 QAM, ATSC 8 VSB, and ATSC 16 VSB.

Generate TVCT Check this box to generate TVCT tables instead of CVCT tables. A 
Terrestrial Virtual Channel Table (TVCT) is a mandatory PSIP table for 
terrestrial broadcast that lists all the virtual channels available in an ATSC 
transport stream. This feature is required for broadcasted channels.
• When Modulation Mode is set to ATSC 8 VSB or ATSC 16 VSB, you must 

enable this option. 

CVCT/TVCT Interval (ms) Specifies the interval in milliseconds at which CVCT/TVCT tables are 
generated. If the Generate TVCT option has been enabled, this field sets the 
interval for TVCT; if the Generate TVCT option has not been enabled, this 
field sets the interval for CVCT.
The Cable Virtual Channel Table (CVCT) provides information about the 
channels, such as channel name, navigation identifier, and stream 
components.

STT Source The System Time Table (STT) defines the GPS time and the daylight-savings 
time indicator to the consumer’s decoder, synchronizing the concept of "now" 
between the decoder and the broadcaster. This configuration is not 
generated by the BNP and requires a proper source to be valid on the output 
transport.
Choose an appropriate value from the pull-down menu. There must be a 
valid STT source to be ATSC compliant.

EIT Source Specifies how an EIT table is generated by the BNP. 
When Groomed Input (default) is selected, an Event Information Table (EIT) 
is generated based on that which is received from the groomed input 
program of the ATSC TS. 
Choose an appropriate value from the pull-down menu.

RRT Source The Rating Region Table (RRT) source transmits the program rating 
information
Choose an appropriate value from the pull-down menu. There must be a 
valid RRT source to be ATSC compliant.

Convert SCTE Video to 
MPEG2 Video

Check this box to convert SCTE video (type 0x80) to MPEG2 video (type 
0x2).
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Creating SCTE Output Transport Streams 
Use the Create Output Transport Stream screen to set parameters for SCTE transport streams, as 
described in the following topics:

• “Creating an SCTE Output Transport Stream on an ASI Port,” next.
• “Creating an SCTE Output Transport Stream on a GigE Port” on page 123.

Creating an SCTE Output Transport Stream on an ASI Port
Go to the SCTE version of the Create Output Transport Stream dialog (Figure 70):

Menu Path
From the Outputs panel of the Grooming tab -> Mapping tab screen, right-click on an ASI port 
and select Create Transport Stream from the popup menu. At the Create Output Transport 
Stream dialog TS Type field, select SCTE.

Figure 70. Create Output Transport Stream (ASI)—SCTE

1. At the Create Output Transport Stream dialog, use guidelines from Table 63 to provide port 
information in the remaining fields. 

2. Click OK to save your settings and to place the new SCTE transport stream in the Outputs panel of 
the Grooming-->Mapping tab screen beneath the selected ASI port. 

a. PSIP (Program and System Information Protocol) is a collection of tables operating within the terrestrial broadcast 
Transport Stream (TS) of every digital (and sometimes analog) television. PSIP settings are configured as part of 
the transport stream.�
�
These tables contain system information and program data:�
   - System information allows navigation and access of the channels within the  DTV transport stream.�
   - Program data provides necessary information for efficient browsing and event selection. �
   - Some PSIP tables contain the information to locate digital streams. �
�
If you are not sure of the PSIP guidelines, there are many good references on the Internet, including the ATSC 
Recommended Practice: Program and System Information Protocol Implementation Guidelines for Broadcasters
at http://www.atsc.org/cms/standards/a_69-2009.pdf

http://www.atsc.org/cms/standards/a_69-2009.pdf
http://www.atsc.org/cms/standards/a_69-2009.pdf
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Creating an SCTE Output Transport Stream on a GigE Port
Go to the SCTE version of the Create Output Transport Stream dialog (Figure 71):

Menu Path
From the Outputs panel of the Grooming tab -> Mapping tab screen, right-click on a GigE port 
and select Create Transport Stream from the popup menu. At the Create Output Transport 
Stream dialog TS Type field, select SCTE.

Figure 71. Create Output Transport Stream (GigE)—SCTE

1. At the Create Output Transport Stream dialog, use guidelines from Table 64 to provide port 
information in the remaining fields. 

2. Click OK to save your settings and to place the new SCTE transport stream in the Outputs panel of 
the Grooming ->Mapping tab screen, beneath the selected GigE port.

Creating DVB Output Transport Streams
Use the Create Output Transport Stream screen to set parameters for Digital Video Broadcast (DVB) 
transport streams, as described in the following topics:

• “Creating a DVB Output Transport Stream on a GigE Port,” next.
• “Creating a DVB Output Transport Stream on an ASI Port” on page 124.

Creating a DVB Output Transport Stream on a GigE Port
Go to the DVB version of the Create Output Transport Stream dialog (Figure 72):

Menu Path
From the Outputs panel of the Grooming tab -> Mapping tab screen, right-click on a 
GigE port and select Create Transport Stream from the popup menu. At the Create 
Output Transport Stream dialog TS Type field, select DVB.



SelenioTM BNP  User Guide, Release 3.7.1 124

Grooming and PSIP - Grooming - Mapping

Figure 72. Create Output Transport Stream (GigE)—DVB

Select DVB to 
reveal the DVB 
configuration 
fields. 

1. At the Create Output Transport Stream dialog, enter information to define the DVB transport 
stream:

- Use guidelines from Table 64 to provide GigE port information at the upper portion.
- Use guidelines from Table 66 to provide the DVB information. 

2. Click OK to save the settings, and to put the new TS at the Outputs panel of the Mapping screen, 
beneath the selected GigE port. 

Creating a DVB Output Transport Stream on an ASI Port
Go to the DVB version of the Create Output Transport Stream dialog (Figure 73):

Menu Path
From the Outputs panel of the Grooming tab -> Mapping tab screen, right-click on an ASI port 
and select Create Transport Stream from the popup menu. At the Create Output Transport 
Stream dialog TS Type field, select DVB.
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Figure 73. Creating Output TS (DVB) - ASI port

Select DVB to reveal 
the DVB 
configuration fields. 

1. At the Create Output Transport Stream dialog, enter information to define the DVB transport 
stream on the ASI port:

- Use guidelines from Table 63 to provide ASI port information at the upper portion.
- Use guidelines from Table 66 to provide the DVB information. 

2. Click OK to save the settings, and to put the new TS at the Outputs panel of the Mapping screen, 
beneath the selected ASI port. 

Table 66. DVB Output Transport Stream Configuration Parameters 

Field Description
Network ID Input the Network ID of the current transport stream.

Modulation Mode Use the pull-down menu to select the modulation mode used for the TS. 
Choice between SCTE 64 QAM and SCTE 256 QAM.

Original Network ID Input the Network ID from which this stream has originated.

NIT Source Use the pull-down menu to select the source for the network information 
table.

TDT/TOT Source Use the pull-down menu to select the source for the time and date table or 
the time offset table.

SDT Source Source of the service description table for this transport stream. If you select 
N/A then SDT is not generated for this output TS.

EIT Source Source of the Event Information Tabled (EIT) for the programs in this 
transport stream. If you select N/A then EIT will not be generated.
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Setting Up Network Information Tables (NITs) for DVB
You can generate a Network Information Table using one of three methods:

• Locally generated, using the NIT editor (as described in this section).
• NIT pass-through, with editing at the output transport stream.
• Complete pass-through of NIT from the input to the output transport stream.

Use the Setup Network Information Table (NIT) dialog to 
perform the following operations:

• “Adding a NIT,” next.
• “Editing a NIT” on page 127.
• “Deleting a NIT” on page 128.

Menu Path
From the main BNP Element Manager menu, select 
Maintenance (Alt m)--> Setup Network 
Information Table (NIT).

Adding a NIT

Use the Edit Network Information Table (NIT) screen (Figure 74) to add a NIT to the BNP. You can 
also use this screen to access the XML version of the NIT file or to import a NIT file from another BNP. 

Menu Path
From the main BNP Element Manager menu, select Maintenance (Alt m)--> Setup 
Network Information Table (NIT) --> Setup Network Information Table (NIT) 
dialog, click Add
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Figure 74. Add NIT

1. Edit the Network Information Table as described in Appendix A, “Editing the DVB NIT Table”.
2. Click OK to apply the NIT configuration.

Editing a NIT

Use the Edit Network Information Table (NIT) screen (Figure 75) to modify a NIT You can also use 
this screen to access the XML version of the NIT file or to import a NIT file from another BNP. 

Menu Path
From the main BNP Element Manager menu, select Maintenance (Alt m) -> Setup 
Network Information Table (NIT) -> Setup Network Information Table (NIT) dialog, 
click Edit

Figure 75. Edit NIT

1. Edit the Network Information Table as described in Appendix A, “Editing the DVB NIT Table”.
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2. Click OK to apply any changes.

Deleting a NIT
Use the Delete function to remove a NIT from the BNP. 

Menu Path

From the main BNP Element Manager 
menu, select Maintenance (Alt m)-> 
Setup Network Information Table (NIT) �
-> Setup Network Information Table 
(NIT) dialog, click Delete

Creating a FAT ASI Port Output Transport Stream
Use the Create Output Transport Stream (FAT ASI) dialog (Figure 76 and Table 67) to set parameters 
for up to four FAT ASI groups.

Menu Path Right-click on an ASI port and select Create Transport Stream (FAT ASI) from the 
popup menu.

Note: The following restriction applies when creating a FAT ASI transport streams:�
Two FAT ASI transport streams per card are allowed: �
one at one of the first three ports, and one at the last port. 
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Figure 76. Create Output Transport Stream (FAT ASI)

1. At the Create Output Transport Stream (FAT ASI) dialog, set parameters.
2. Click OK.

View results of this configuration at the Outputs panel (Figure 77) of the Mapping tab screen.

Table 67. Create Output Transport Stream (FAT ASI)  

Field Description
Port Read-only, Shows either ASI or GigE depending on the port selected.

Non-DPI Enable (check) or disable (un-check) a Grooming-only (Non-DPI) license for 
the TS. 

TS Name The (optional) name you want to assign to this output transport stream.

Bitrate (Mbps) The bitrate at which the stream is transported.

Unique TS ID Assign a unique numeric ID to this transport stream. 
• When this option is checked, the TS ID value placed in this field will be 

reserved as unique for the entire chassis.
• When this option is unchecked, a TS ID value may still be entered, 

however the value may be the same as another TS ID as long as that TS 
ID’s value has not been reserved as a Unique TS ID. 

• Note that each TSID is a unique number used to identify a transport 
stream. It is a partition of two 16-bit hex numbers. The lower 16 bits (user-
specified in decimal and converted to hex) is the MPEG transport stream 
ID. The upper 16 bits (0x) is strictly used internally.

• Default value is “1” if no value is specified.
• Broadcasters must configure this value with a unique ID to meet FCC 

standards.

Reserved B/W (Mbps) Enter any bandwidth value to be apportioned to the transport stream.

Network PID Decimal value to define the program ID on which the stream is received.
Note that display of this entry, in applicable screens, is dependent on the 
current setting—as either hexadecimal or decimal—for Configuration--
>Global PID Display.
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Figure 77. FAT ASI Ports Created

Creating Programs
Use information in this section to create output programs, as described in the following topics:

• “Creating Programs Manually,” next.
• “Program Messaging System Setting” on page 134.

Note: With the exception of ghost programs, input programs cannot be created; these must be 
automatically detected from a GigE or ASI port. For information about ghost program creation, 
see “Managing Elementary Streams” on page 156.

You can create output programs in one of two ways: 

TS Type The type of stream. The type of stream you choose determines what other 
information is required. Choices are:
MPEG-2, ATSC, SCTE, or DVB
• For information on additional fields for ATSC transport streams, see 

Table 65.
• For information on additional fields for DVB transport streams, see 

Table 66.

Enable Messaging System Check this box to allow configuration of Messaging System zones for specific 
programs in this transport stream. See “Messaging System Configuration” on 
page 60 for information on configuring Messaging Zones.

Number of Group The number of groups you want to assign to this port. Choose from 1 to 4. 
The default is 4.

Group Name (A-D) The name you want to assign to each group.

Group Bitrate (Mbps)
(A-D)

The bitrate, in megabits per second, that you want to assign to groups. The 
value entered will be applied to all Groups. The total bitrate for all groups 
cannot exceed the value in the Bitrate field in the top portion of the window. 

H.264 Alarm Bitrate Level 
(Mbps)

Assists in maintaining video quality for MPEG-2 video content in the 
presence of H.264 content, which bypasses the BNP’s transrater. This is 
done by generating an alarm when H.264 program bandwidth exceeds the 
percent of the TS bandwidth specified in this setting.
Choices are: 0%, 25%, 50%, 75%, 100%.

Reserved B/W (Mbps) The reserved bandwidth you want to assign for each group. The total 
bandwidth for all groups cannot exceed the value in the Reserved B/W field 
in the top portion of the window.

Table 67. Create Output Transport Stream (FAT ASI)  (Continued)

Field Description
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• Manual configuration, as described in “Creating Programs Manually,” next. 
• Drag and drop grooming, as described in “Drag and Drop Grooming” on page 140. 

For either method, the program mapping configuration is identical. You can also schedule programs by 
using either method.

Creating Programs Manually

Use the Create Output Program dialog to set parameters for an output program. Fields displayed in 
the ETV Configuration portion of this dialog are the result or PIDs priority setting as either Ad or 
Network. 

Menu Path From the Outputs panel of the Grooming -> Mapping tab, right-click on a transport 
stream and select Create Program from the popup menu (Figure 78 and Table 68).

Figure 78. Create Output Program 

ETV PIDs Priority set to Ad ETV PIDs Priority set to Network

1. At the Create Output Program dialog, set parameters for the program, then click OK. 
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2. View results of the program configuration at the Outputs panel of the Mapping page, directly 
beneath the selected TS. 
For information about the Messaging System Setting button, see “Program Messaging System 
Setting” on page 134.

Table 68. Create Output Program Configuration Parameters  

Field Description
Port Parameters

Port ID Read-only field. The GigE or ASI port on which the program resides.

IP Address Read-only field. The destination IP address of the transport stream.

UDP Port Read-only field. UDP port the program uses, based on UDP port of the transport 
stream.

TS Parameters

TS ID Read-only field. The ID number of the transport stream on which this program 
streams.

TS Type Read-only field. Indicates the type of transport stream for the program.

Program/Channel Info Parameters

Program Number MPEG number assigned to this program

Program Name Name assigned to this program. Output program names must be unique.

PMT PID Select this option to activate the PMT ID box, into which you can then enter the PMT 
ID, or the ID of the program map table (PMT). 
To set a PMT PID, enter a decimal value in this field. 
Note that display of this entry, in applicable screens, is dependent on the current 
setting—as either hexadecimal or decimal—for Configuration-->Global PID 
Display. 

Major Channel 
Number

Operator-defined channel number: for terrestrial broadcast, the major channel 
number is limited to the range 1 to 99 for ATSC digital television or audio services. For 
cable, major channel numbers may range from 1 to 999. 
This field can be edited if ATSC is enabled.

Minor Channel 
Number

Operator-defined minor channel number: any whole number in the range from 0 to 
999. 
This field can be edited if ATSC is enabled.

Enable DPIa Select this option to enable DPI for the program only, rather than the whole TS.
• This option is hidden unless a PROGRAM WITH DPI license key has been entered 

in the License Manager screen (see also “Managing Licenses” on page 190.

Allow SCTE 30- to-
SCTE 35 conversion

When checked, enables SCTE 30 to SCTE 35 conversion.

Allow Audio 
Mismatch During DPI

Check this box to allow ads to have a different audio format from the input program 
during DPI. By default, ads must have the same audio format as the input program.
Note: Audio mismatch is limited to MPEG-1 and MPEG-2 audio types.
Note: If you enable this feature while DPI is active on the output program, then the 
audio mismatch is allowed only from the next set of ads.
Note: PMT is not updated even if the BNP matches MPEG-1 audio to MPEG-2 audio.

ETV Configurationb Parameters
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ETV PIDs Priority Indicates the source of EBIF ES data for the duration of the ad time and provides the 
option to replace or not replace the pre-bound EBIF ESs during ad splicing. 
• When Ad is selected, the spliced ad will provide the EBIF and EISS elementary 

streams (ESs). If the EBIF and EISS ESs from the ad do not match the stream type 
and descriptors of the network EBIF and EISS ESs, then the network EBIF and 
EISS ESs will be dropped. If no EBIF and EISS data are pre-configured at the 
output program or no EBIF and EISS data are present at the output then the EBIF 
and EISS ESs form the ad are dropped.

• When Network is selected, the EBIF and EISS ESs from the ad server will be 
ignored, even if they are present.

Default is set to Ad.

Play Preference When the ETV PIDs Priority is set to Network, the following three options will appear 
in a drop down box: 
• Play through ad: any EBIF ES data that is part of the output program will continue 

to be played during the ad.
• Drop during ad: any EBIF ES data that is part of the output program will be dropped 

during the ad.
• Play during ad only: provides the ability to select the input EBIF ES source that will 

be playing only during the ad time; if an EBIF ES source is not available, the EBIF 
ES that currently exists in the output program will be played.

Default setting is Play through ad. 

Late-Bind Source This option is only available when the ETV PIDs Priority is set to Network and the 
Play Preference is set to Play during ad only. 
• When the above two conditions have been met, an additional field with ellipses (. . 

.) will appear. Clicking on the ellipses will open the Late-Bind Source Dialog 
window, which will allow the option to choose a valid pair of EBIF/EISS ES from the 
BNP’s input.

Messaging System Parameters

Messaging System 
Setting

Click this button to open the Program Messaging System Setting window to configure 
and enable messaging zones for the program. See “Program Messaging System 
Setting,” below for details.

a. A GROOMING WITH DPI license key (which enables DPI for the TS) cannot co-exist with a PROGRAM WITH DPI 
license key.

b. For additional information in ETV configuration including details on various EBIF and EISS use cases, see Chapter 
10, "ETV Binary Interchange Format."

Table 68. Create Output Program Configuration Parameters  (Continued)

Field Description
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Program Messaging System Setting
Use the Program Messaging System Setting dialog to configure and enable one of each of the three 
types of Messaging Zones per program. (Figure 79 and Table 69). 

Menu Path
From the Outputs panel of the Grooming -> Mapping tab, right-click on a TS and 
select Create Program from the popup menu -> click the Messaging System Setting 
button. 

Figure 79. Program Messaging System Setting dialog

Note: To select a zone from each of the three types of zone choices in the Program Messaging System 
Setting window, the zones must first be created from the Configuration -> Messaging System 
menu as described in “Messaging System Configuration” on page 60 in Chapter 4.

You may select one of each zone type to configure and enable per program. Only previously created 
zones will appear in the drop-down menu. Table 69 describes the fields available in the Program 
Messaging System Setting window.

Table 69. Messaging System Setting window

Field Description
EAS Zone Select an EAS zone from the pull-down menu to associate with the 

program. See “EAS Messaging Zones” on page 63 in Chapter 4 
for additional information.
Click the Enable Zone button next to the selection to enable the 
EAS messaging zone for the specified program.

Operator Messaging Zone Select an Operator or Advanced Messaging zone from the pull-
down menu to associate with the program. See “Operator and 
Advanced Messaging Zones” on page 68 in Chapter 4 for 
additional information.
Click the Enable Zone button next to the selection to enable the 
Operator or Advanced Messaging zone for the specified program.

Logo Overlay Zone Select a Logo Overlay zone from the pull-down menu to associate 
with the program. See “Logo Overlay Zones” on page 79 in 
Chapter 4 for additional information.
Click the Enable Zone button next to the selection to enable the 
Logo Overlay zone for the specified program.
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Modifying and Deleting Streams or Programs

If a transport stream or a program configuration needs to be modified, use the main Grooming -> 
Mapping window to access the change options:

Modifying Input Transport Streams
Use the Modify GigE Input Transport Stream dialog to change the name of an input transport 
stream. Other parameters cannot be modified. 

Menu Path
From the inputs side of the Grooming -> Mapping tab screen, right-click on a TS 
associated with a GigE port or an ASI port, and select Modify Transport Stream from 
the popup menu.

Figure 80. Modify Input TS — GigE Port and ASI Port Options

Modify GigE TS

Modify ASI TS

1. At the TS Name field, type an alphanumeric string to provide a new name for the TS. 
2. Click OK to save changes and dismiss the dialog. 
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Modifying Output Transport Streams - GigE
Use the Modify Output Transport Stream dialog (Figure 81) to change parameters for output GigE 
transport streams. 

Menu Path From the outputs panel of the Grooming -> Mapping tab screen, right-click on a GigE 
transport stream and select Modify Transport Stream from the popup menu.

Figure 81. Modify Output TS (MPEG-2 shown) - GigE port

1. At the Modify Output Transport Stream dialog, enter parameters to editable fields.
Note that certain parameters are common to all transport stream types (Table 64 on page 116): 
additional parameters can be modified for ATSC and DVB transport streams (Table 70). 
Table 70. Modifiable Parameters for GigE Output Transport Stream

For All TS Types
Additional Modifications

For ATSC TS For DVB TS
TS Name Generate TVCT Network ID

Multicast STT Source Original Network ID

Destination IP EIT Source NIT Source

UDP Port RRT Source TDT/TOT Source

Subnet Mask SDT Source

ARP EIT Source

ARP Address

Enable Message System

2. Click OK to save the changes and dismiss the dialog. 
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Modifying Output Transport Streams - ASI
Use the Modify Output Transport Stream dialog to dialog (Figure 82) to change parameters for 
output ASI transport streams. 

Menu Path From the outputs panel of the Grooming -> Mapping tab screen, right-click on an ASI 
transport stream and select Modify Transport Stream from the popup menu.

Figure 82. Modify Output TS - ASI port.

1. At the Modify Output Transport Stream dialog, enter parameters to editable fields.
Note that certain parameters are common to all transport stream types (Table 63 on page 114): 
additional parameters can be modified for ATSC and DVB transport streams (Table 71). 

Table 71. Modifiable Parameters for ASI Output Transport Stream  

For All TS Types
Additional Modifications

For ATSC TS For DVB TS
TS Name Generate TVCT Network ID

Enable Message System STT Source Original Network ID

EIT Source NIT Source

RRT Source TDT/TOT Source

SDT Source

EIT Source

2. Click OK to save the changes and dismiss the dialog. 
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Modifying Input Programs
The Program Name is the only editable parameter for input programs. Use the Modify Input Program 
dialog (Figure 83) to change an existing input program name. 

Menu Path From the inputs panel of the Grooming -> Mapping tab screen, right-click on a 
program and select Modify Program Name from the popup menu. 

Figure 83. Program Pop-Up menu - Modify Program

1. At the Modify Input Program dialog, type an alphanumeric string in the Program Name field. 
2. Click OK to save changes. The new program name is now listed in the inputs panel of the 

Grooming --> Mapping tab screen.
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Modifying Output Programs
Use the Modify Output Program dialog (Figure 84) to change the Program Name and/or PIDs Priority 
for a specified output program. 

Menu Path From the outputs panel of the Grooming -> Mapping tab screen, right-click on a 
program and select Modify Program from the popup menu.

Figure 84. Modify Output program - GigE or ASI port

1. At the Modify Output Program dialog, enter parameters to editable fields (see also Table 68, 
“Create Output Program Configuration Parameters,” on page 132 for descriptions):

- Program Name.
- Allow Audio Mismatch During DPI.
- Any relevant ETV Configuration fields: PIDs Priority, Play Preference, Late-Bind Source.
- Any relevant Messaging System Setting fields: EAS Zone, Operator Messaging Zone, Logo 

Overlay Zone.

Note: Any other attributes that you wish to change on a program must be changed on the program’s 
Elementary Stream(s). 

2. Click OK to save your changes. 
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Deleting Output Streams and Programs
Use the Delete function to remove a stream or program from the BNP. 

1. From the Grooming -> Mapping tab screen, right-click on a TS and select one of the following 
options from the popup menu:

- Delete Transport Stream, to remove the individual output stream from the ASI or GigE 
interface.

- Delete All Programs, to remove all output programs from the ASI or GigE interface. 
2. At the confirmation dialog, click Yes.

Figure 85. Delete Output Transport Stream or Program

Drag and Drop Grooming
You can groom programs by using the drag and drop method to associate input transport streams, 
programs, or data elementary streams with selected output elements (Table 72). You can drag a 
transport stream to a port, or over an existing transport stream. You can drag a program to a transport 
stream, or over an existing program. You can also drag an elementary stream to a program or to an 
existing elementary stream..

Table 72. Drag and drop grooming

Drag and Drop 
Components Grooming Behavior
Transport Stream to 
Transport Stream

Deletes all current programs and replaces them with the dragged Transport Stream

Transport Stream to 
GigE Port

The entire Transport Stream is copied to the output port

Program to Transport 
Stream

The program is created in the Transport Stream; the Configure Program Mapping 
window appears, allowing you to modify the program mapping information
See also “Program to Transport Stream Grooming” on page 141.

Program to Program Deletes the existing program and replaces it with the dragged program
See also “Program to Program Grooming” on page 142.

Elementary Stream to 
Elementary Stream

For EBIF, EISS, and regular data streams only; deletes existing ES and replaces it 
with the dragged ES. Opens the Configure Elementary Stream Mapping window. 
Only supports replacing the ES, not modification.
See also “Input Elementary Stream to Output Elementary Stream Grooming” on 
page 150

Elementary Stream to 
Program

For EBIF, EISS, and regular data streams only; adds the dragged ES to the program. 
If the ES already exists in the program, the dragged ES will replace the existing ES.
See also “Elementary Stream Grooming” on page 148.

Caution:  If you replace one transport stream with another, the original will be completely deleted. 
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Program to Transport Stream Grooming
Use steps in this section to associate a specific input program with output transport stream. All PSIP 
tables and schedules that are part of the input program will be set to the specified output port.

1. At the Grooming -> Mapping tab screen, select and drag an input program and drop it onto a 
specific output transport stream to present the Configure Program Mapping Grooming tab 
screen (Figure 86).

Figure 86. Drag input program to output TS

Drag selected program 
from the input panel to a 
TS on the output panel.

2. At the Configure Program Mapping Grooming tab screen, enter information to define the 
mapping. See Table 73 for parameter descriptions. 
If this is a backup program, click the Program Redundancy tab and enter the input ports, 
transport streams, and programs. (See “Program Redundancy” on page 152 for details.)

3. Click OK to save and use the settings. 
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Program to Program Grooming
Use steps in this section to associate a specific input program with a selected output program. 

Note: If you are using the drag and drop method of program creation and you wish to configure or 
enable Messaging System Settings for this program, you must modify the program after drag and 
drop and then associate zones for the program as described in “Program Messaging System 
Setting” on page 134.

Note: As of BNP Release 3.7.1 the Element Manager allows you to groom an input Ghost program to an 
output TS

1. At the Grooming -> Mapping tab screen, select and drag an input program and drop it onto a 
specific output program (Figure 87) to present the Configure Program Mapping Grooming tab 
screen.

Figure 87. Drag input program to output program

Drag selected program from 
the input panel to a program 
on the output panel.

2. At the Configure Program Mapping Grooming tab screen, enter information to define the 
mapping. 
See the following tables for guidelines:
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- Table 74, “Configure Program Mapping—Grooming Parameters—ETV Configuration,” on 
page 144.

- Table 75, “Configure Program Mapping—Grooming Parameters—Destination,” on page 145
- Table 76, “Configure Program Mapping—Grooming Parameters—Grooming Schedule,” on 

page 146.
- Table 77, “Configure Program Mapping—Grooming Parameters—Quality of Service,” on 

page 146.
- Table 78, “Configure Program Mapping—Grooming Parameters—Component PIDs,” on 

page 146.
- Table 79, “Quality of Service Levels,” on page 147.
If this is a backup program, click the Program Redundancy tab and enter the input ports, 
transport streams, and programs. (See “Program Redundancy” on page 152 for details.)

3. Click OK to save and use the settings.

Table 73. Configure Program Mapping—Grooming Parameters—Source  

Field Description
Port Read-only. Specifies the input GigE or ASI port used for the input program. The GigE 

port to use, transport stream ID, program name and number for both the source and 
the destination of this program must be defined. For input streams, you can choose to 
Forward SCTE 35 Cue. For output streams, you can enable and specify PMT PID, and 
enable SCTE 30 to 35 Conversion.

TS ID Read-only. Specifies the input Transport Stream ID used for the input program.

Program Number Read-only. Specifies the program number for the input program.

Program Name Read-only. Specifies the program name (if one was given) for the input program.This 
section also displays pass-through status as either enabled (checked) or disabled (un-
checked) for long and short program names. 

Synchronize input 
and output program 
names

Check this box to copy the input program name into the output program name at 
creation time. 
An output program can have up to three names when it is part of an ATSC transport 
stream, to serve the following purposes:
• The unique name, which is used for DPI purposes, that enables the BNP to identify 

the program.
• The short name (max 7 characters), for use in ATSC tables. The short name is not 

required to be unique at the BNP or at the output TS level. 
• The long name (max 32 characters), for use in ATSC tables. The long name is not 

required to unique at the BNP or at the output TS level. 

Short Name If available, string consisting of 1 - 7 characters, which identifies the short program 
name.

Long Name If available, string consisting of 1 - 32 characters, which identifies the long program 
name.

Forward SCTE 35 
Cue

Check this box to forward SCTE 35 cue tones from the input program. 
You cannot select this option and SCTE 30 to 35 Conversion for the same output 
program.



Table 74. Configure Program Mapping—Grooming Parameters—ETV Configuration 

Field Description
ETV PIDs Priority Indicates the source of EBIF ES data for the duration of the ad time and provides the 

option to replace or not replace the pre-bound EBIF ESs during ad splicing. 
• When Ad is selected, the spliced ad will provide the EBIF and EISS elementary 

streams (ESs). If the EBIF and EISS ESs from the ad do not match the stream type 
and descriptors of the network EBIF and EISS ESs, then the network EBIF and 
EISS ESs will be dropped. If no EBIF and EISS data are pre-configured at the output 
program or no EBIF and EISS data are present at the output then the EBIF and 
EISS ESs form the ad are dropped.

• When Network is selected, the EBIF and EISS ESs from the ad server will be 
ignored, even if they are present.

Default = Ad.

Play Preference When the ETV PIDs Priority is set to Network, the following three options will appear in 
a drop down box: 
• Play through ad: any EBIF ES data that is part of the output program will continue to 

be played during the ad.
• Drop during ad: any EBIF ES data that is part of the output program will be dropped 

during the ad.
• Play during ad only: provides the ability to select the input EBIF ES source that will 

be playing only during the ad time; if an EBIF ES source is not available, the EBIF 
ES that currently exists in the output program will be played.

Default = Play through ad. 

Late-Bind Source This option is only available when the ETV PIDs Priority is set to Network and the Play 
Preference is set to Play during ad only. 
When the above two conditions have been met, an additional field with ellipses (. . .) 
will appear. Clicking on the ellipses will open the Late-Bind Source Dialog window, 
which will allow the option to choose a valid pair of EBIF/EISS ESs from the BNP’s 
input.
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Note: For more information about ETV Configuration, see also Chapter 10, "ETV Binary Interchange Format."

Table 75. Configure Program Mapping—Grooming Parameters—Destination  

Field Description
Port Displays the destination GigE or ASI port of the output port to which the program will 

be groomed.

TS ID Displays the destination Transport Stream ID of the output TS to which the program 
will be groomed.

Program Number View or modify the destination program number of the output program to which the 
program will be groomed.

Synchronize Input 
and Output Program 
Names

Enable (check) or disable (un-check) copying of the current input program name into 
the output program name when grooming. 

Program Name View or modify the destination program name of the output program name to which 
the program will be groomed.

Pass-through Short 
Name

View or modify the short name. 
• When enabled (checked) the name currently displayed in this field is passed 

through. 
• When disabled (un-checked), up to 7characters can be entered to define the short 

name to be passed through. 

Pass-through Long 
Name

View or modify the long name.
• When enabled (checked) the name currently displayed is passed through. 
• When disabled (un-checked), up to 32 characters can be entered to define the long 

name to be passed through. 

PMT PID Select this option to activate the PMT ID box, into which you can then enter the PMT 
ID, or the ID of the program map table (PMT). 
To set this PMT PID, enter a decimal value in the range 32 to 8175.
Note that display of this entry, in applicable screens, is dependent on the current 
setting—as either hexadecimal or decimal—for Configuration-->Global PID Display.

Enable DPI Select this option to enable DPI for the program only, rather than the whole TS.
• This option is hidden unless a PROGRAM WITH DPI license key has been entered 

in the License Manager screen. See also “Managing Licenses” on page 190.
• A GROOMING WITH DPI license key (which enables DPI for the TS) cannot co-

exist with a PROGRAM with DPI license key.

SCTE 30 to 35 
Conversion

When checked, converts SCTE 30 messages to SCTE 35 cues for transport to the 
destination.
You cannot select this option and Forward SCTE 35 Cue for the same output 
program.

Allow Audio 
Mismatch During 
DPI

Check this box to allow ads to have a different audio format from the input program 
during DPI. By default, ads must have the same audio format as the input program.
Note: Audio mismatch is limited to MPEG-1 and MPEG-2 audio types.
Note: If you enable this feature while DPI is active on the output program, then the 
audio mismatch is allowed only from the next set of ads.
Note: PMT is not updated even if the BNP matches MPEG-1 audio to MPEG-2 audio.
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Table 76. Configure Program Mapping—Grooming Parameters—Grooming Schedule 

Field Description
Now or Start Time To specify the time the program should start, or to continue until either manually 

stopped or to stop at a specified time, enable these features. If you choose to specify a 
start or stop time, enable the feature and type the time directly into the appropriate 
field. A check mark appears when the feature is active.
See “Scheduling Grooming - One time event” on page 151 for additional information.

Never or Stop Time To tell the program the time to start, or to continue until either manually stopped or to 
stop at a specified time, enable these features. If you choose to specify a start or stop 
time, enable the feature and type the time directly into the appropriate field. A check 
mark appears when the feature is active.
See “Scheduling Grooming - One time event” on page 151 for additional information.

  

Table 77. Configure Program Mapping—Grooming Parameters—Quality of Service 

Field Description
Service Level Set a value from the pull-down to define the bit rate adaptation technique to be applied 

to MPEG-2 encoded streams, as one of the following:
• Any integer from -8 to +8 
• 0 (off)
• Bypass Transrater �

(not for use when grooming a DPI-enabled program)
• Handle as Data �

(not for use when grooming a DPI-enabled program)
• No Rate shaping
See also Table 79, “Quality of Service Levels,” on page 147.

Max Video Bitrate Sets the limits for the maximum bitrate (in Mbps) for this program. Choosing a specific 
max rate will bypass automatic transrating based on priorities. 

         

Table 78. Configure Program Mapping—Grooming Parameters—Component PIDs  

Field Description
For this program input, this category allows stream grooming by deselecting specific 
input PIDs.

Input Type Specifies the stream type of the input ESs for this program.

PID Specifies the PID of the input ESs for this program.

Output Type If clicking in the blue space under this field, opens the Select Elementary Stream 
window, which will allow you to change the PID of the chosen ES.

PID If clicking in the blue space under this field, opens the Select Elementary Stream 
window, which will allow you to change the PID of the chosen ES.
The PID is displayed either as a hexadecimal value or a decimal value, as based on 
the current setting for “PID Display Format—Global Configuration”.

Stay Unreferenced If the input program is a Ghost Program, the Stay Unreferenced option will appear in 
this section. Check this box if the PIDs in this stream are to remain unreferenced in 
any PSI tables. See “Adding an Unreferenced PID as an Elementary Stream” on 
page 167 for more information.
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Configure Program Mapping—Quality of Service Levels
The Service Level field of the Configure Program Mapping tab screen allows assignment of transrating 
priorities and conditions for each program. Table 79 provides additional details about the supported 
service levels.

Table 79. Quality of Service Levels

QoS Service Level 
Configuration Video Processing

Can DPI be 
performed? Effect on Video Output Bandwidth

Transrating Service 
Level Values

Video elementary stream (ES) 
is processed through the 
transrater.
• -8: highest transrating, 

lowest quality.
• +8: lowest transrating, 

highest quality. 

YESa

a. DPI sessions carry same QOS settings as network.

Transrated output video ES requires 
less bandwidth than input video ES.

No Rate shaping Video ES processing is limited 
through the transrater with null 
packet removal.
• Video quantization level is 

unchanged

YESb

b. DPI sessions carry same QOS settings as network.

Output video ES bandwidth will vary 
depending on level of ES null packet 
removal.

Bypass Transrater Video ES is not processed 
through the transrater. 

• Video can be displayed.

YES Output video ES uses the same 
bandwidth as input video ES. 
• Can not use more than the 

bandwidth of output TS.

Handle As Data Video ES is not processed 
through the transrater.

• Video cannot be displayed.

NO Output data ES is treated as data 
and will therefore use the same 
bandwidth as input video ES. 
• Cannot use more than the 

bandwidth of output TS. 

Treat As Async Data If the input program is a data-only program or all video and audio streams in the 
Component PIDs section are unchecked, the Treat as Async Data option will appear in 
this section. Check this box to disable PCR timing information for this program. 

Placeholder ETV 
ESs

If the input program does not contain EBIF and EISS elementary streams, a drop 
down box for the Placeholder ETV ES field will be displayed and editable. This option 
allows pre-configuration of an EBIF and EISS ES pair with a stream type of 5 or 192. 
When selecting either EBIF/EISS 5 or EBIF/EISS 192 the system will automatically 
generate the following:
• 1 new ES with a Preconfigured for PMT setting of Yes for each EBIF and EISS 

stream.�
(See “Managing Elementary Streams” on page 156.)

• 2 new Descriptor Rules for each new EBIF and EISS ES. �
(See “Managing PMT and ES Descriptors” on page 177.)

Table 78. Configure Program Mapping—Grooming Parameters—Component PIDs  (Continued)

Field Description
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Elementary Stream Grooming
Use steps in this section to groom a specific input elementary stream to an output program. You can 
also replace an existing elementary data stream within an output program. 

Menu Path
At the Inputs panel of the Grooming -> Mapping tab screen, select and drag generic 
data or the EBIF/EISS elementary stream and drop it into program in the Outputs panel 
(Figure 88). The Configure Elementary Stream Mapping screen is now presented.

Note: For information about various data stream types and their icons, see Table 59 on page 107.

Figure 88. ES-to-Program Drag and Drop

Drag selected generic data 
from the input panel to a 
program on the output panel.

At the Configure Elementary Stream Mapping screen, all fields—except Output Type and PID—are 
read-only (Table 80). 

1. To set a value for either Output Type or PID, click in the 
field to present the ES PID dialog. 

2. At the New Reserved PID field, type the ID string and 
click OK.
The new ES PID will be displayed in the Configure 
Elementary Stream Mapping screen.

3. At the Configure Elementary Stream Mapping screen, 
click OK to dismiss the screen.
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Table 80 describes the fields available in the Configure Elementary Stream Mapping window.

Table 80. Configure Elementary Stream Mapping 

Category Field Description

Source

Port Displays the source GigE or ASI port of the elementary 
stream’s input program.

TS ID: Displays the source Transport Stream ID of the ES’s input 
TS.

Program Number Displays the source program number of the ES’s input 
program.

Program Name Displays the source program name of the ES’s input 
program.

Destination

Port Displays the destination GigE or ASI port of the output port 
to which the ES will be groomed.

TS ID: Displays the destination Transport Stream ID of the output 
TS to which the ES will be groomed.

Program Number Displays the destination program number of the output 
program to which the ES will be groomed.

Program Name Displays the destination program name of the output 
program name to which the ES will be groomed.

PMT PID Displays the Program Map Table PID assigned to the 
output program.
The displayed value—as either hexadecimal or decimal—
is based on the current setting from Configuration--
>Global PID Display.

SCTE 30 to 35 
Conversion

Displays whether or not SCTE 30 to 35 Conversion has 
been enabled for the output program to which the ES will 
be groomed. 

Component PIDs

Input Type & PID�
Output Type & PID

Displays the ES Input Type and PID, Output Type and PID. 
For Input Type, the options that will be seen are as follows:
• Data
• EBIF
• EISS
Click the blue space under Output Type or PID to enter a 
reserved PID for this ES.

Treat as Async Data When grooming a data, EBIF, or EISS ES to an output 
program, the Treat as Async Data option will always be 
enabled. 
When data is treated as Async Data, then the timing 
information in the data stream is not processed. 
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Input Elementary Stream to Output Elementary Stream Grooming
Use steps in this section to groom an elementary stream from an input program into an output 
elementary stream. This operation will replace the targeted output ES with the selected input ES. 

Menu Path
From the Grooming -> Mapping screen Inputs panel, select either a generic data or the 
EBIF / EISS elementary stream and drag to an output ES at the Outputs panel (Figure 89). 
The ES Grooming Replacement dialog is now presented.

Note: An elementary stream may only be groomed on top of an existing ES-level groomed elementary 
stream (not a program-level groomed stream), and the Stream Types of the input ES and the 
output ES must match.

Figure 89. ES-to-ES Drag and Drop.

Input Data ES to groom Drag input ES to output ES

At the ES Grooming Replacement dialog, click Yes to 
continue/replace the ES.�

Elementary Stream Grooming Icon Colors
The ES icons are displayed as green or blue (Table 81). 

Table 81. ES Icon Colors

ES Color at Outputs 
Panel Description

Green The ES has been groomed from an input program to an output program, or directly 
onto an output ES.

Blue An entire program (and therefore all of its ESs) has been groomed to an output TS, or 
replaces an existing output program.

See Table 59 on page 107 for additional information.
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Viewing Grooming Details
1. In the Outputs panel of the Grooming -> Mapping window, select the transport stream or 

program whose details and schedule you want to see.
2. Right-click and select Display Grooming.

The BNP Element Manager will display the currently defined mapping and scheduling window. If 
you chose to view grooming for the whole TS, all grooming for the programs in that TS will be 
displayed; if you chose to view grooming for a specific program, only the grooming for that 
program will appear.

Figure 90. Grooming detail display - TS

Indicates ES-level grooming

The presence of ES-level grooming is indicated by a black asterisk (*) next to the relevant ES in the 
Component PIDs section of the Current Program Mapping and Schedule window.

3. Click Refresh to refresh the view, or Cancel to close the window.

Note: In Figure 90, the times specified in the Grooming Schedule section (see Figure 1 for a sample) are 
from the NTP server. Your PC that is used for configuration may show a different time. This “PC 
time” should be disregarded; the start and stop times you enter will be referenced to the NTP 
server.

Scheduling Grooming - One time event

Note: It should be noted that proper use of BNP’s scheduled grooming feature depends on an NTP 
server as an accurate timing source. Additionally, when scheduling grooming, only a single event 
can be scheduled, rather than an ongoing occurrence. 
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To schedule grooming at a specific time for a one-time occurrence, perform steps 1 through 4 in the 
last section, “Creating Programs Manually” above in order to open the Configure Program Mapping 
window. Then proceed as follows:

1. From the Configure Program Mapping window, 
un-check Now or Start time and click on the 
pull-down menu to access the calendar/clock 
screen. 

2. If you want to start grooming immediately, click 
OK. If you want to start at a later time, set the 
time and date and then click OK.

3. To set the stop time, un-check Never or Stop 
Time. The grooming schedule of Figure 1 
appears. If you don’t want to stop grooming, click 
OK. To set a stop time, set the time and date for 
grooming to stop and click OK.

4. Click OK to apply the mapping to the program.

Program Redundancy

The BNP supports program level redundancy on all the output services. Program level standby is 
configurable using the BNP Element Manager, which allows you to designate any input service as a 
“standby program” with the exception of the same service. This redundancy can be configured on 
output streams associated with GigE port as well as ASI ports.

The health of the standby program will be checked before failover and the BNP will not perform the 
switch if the standby is degraded. In automatic recovery mode, the BNP returns back to the primary 
program from the standby program when the primary program recovers from the interruption.

A program in an input TS that has SSM redundancy configured cannot be used as a backup program 
for program redundancy.
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Modes of Program Redundancy Operation
The BNP supports two modes of Program Redundancy operation (Table 82):

• Automatic recovery from the backup program to the primary program, or 
• Manual selection, by user, when the recovery process should occur.

Table 82. Program Redundancy Modes of Operation

Category  Primary to Backup Backup to Primary
Automatic Failover to Backup 
Program / Automatic Recovery 
to Primary Program

Automatic failover operation is based 
on two conditions detected, either one 
will trigger a failover to the designated 
backup program:
• Video ES failure detection
or
• Missing PAT/PMT detection.

Automatic recovery operation is 
based on two conditions detected, 
both are required to trigger a 
recovery to the primary program: 
• Video ES recovery detection
and
• PAT/PMT detection.

Automatic Failover to Backup 
Program / Manual Recovery to 
Primary Program

Automatic failover operation is based 
on two conditions detected, either one 
will trigger a failover to the designated 
backup program: 
• Video ES failure detection,
or
• Missing PAT/PMT detection.

Manual recovery operation is 
based on the user selecting when 
a single program or all programs 
should be recovered to their 
respective primary programs.

Configuring Program Redundancy

Use the Configure Program Redundancy screen (examples: Figure 91, Figure 92) to define the 
program to be used as backup on ASI or GigE ports. 

Menu Path
Grooming tab -> Mapping tab screen: from the Inputs panel, drag and drop a program 
to an output transport stream or an output program at the Outputs panel-> click the 
Program Redundancy tab, then enable (check) Specify a Backup Program. 

1. At the Program Redundancy screen, select the program that is to be the backup for the output 
program. 
Your selected port, TS ID, program number, and program name (if applicable) is displayed at the 
right panel of the screen. 
- Figure 91 shows an example of program redundancy in which the backup is selected as GigE 2, 

Transport Stream ID 0x5c, and Program Number 1. 
- Figure 92 shows an example of program redundancy in which the selected backup is ASI D5, 

Transport Stream ID 0x1, and Program number 1.
2. At Selected Program Redundancy Mode click to select either Automatic Failover / Automatic 

Recovery or Automatic Failover / Manual Recovery. See Table 82 for details. 
3. Click OK to return to the Mapping tab screen. 
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Figure 91. Configure Program Mapping - Program Redundancy on GigE Port

Figure 92. Configure Program Mapping - Program Redundancy on ASI Port
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Manual Recovery Procedures
The BNP supports the ability to manually switch between the Primary and Backup programs. Use the 
steps provided in this section to perform a manual recovery:

1. From the Outputs panel of the Grooming -> Mapping window, right-click the desired program 
and select Display Grooming from the pop-up menu.
The Current Program Mapping and Schedule window opens (Figure 93).

Figure 93. Program Redundancy - Manual Recovery

2. Select the scheduled program and right-click.
3. From the pop-up menu, select Switch to Backup.

The Switch to Backup option is available when the selected program is already in the Manual Recovery 
to Primary Program operation mode. (The Automatic Recovery to Primary Program mode does not 
allow staying in the Backup Program.)

Figure 93 above illustrates the Manual Recovery selection for program redundancy operation on 
individual programs. This can be used for the Manual Recovery Primary Program procedure following 
an Automatic Failure to Backup Program, or for toggling between primary and backup programs for 
test purposes.

To recover all programs, from the main Element Manager window, select Maintenance (Alt m)--> 
Regroom. See “Regrooming” on page 198 for additional information. 



SelenioTM BNP  User Guide, Release 3.7.1 156

Grooming and PSIP - Grooming - Mapping

Managing Elementary Streams 
Use guidelines provided in the following topics for management of elementary streams:

• “Creating an Elementary Stream,” next. 
• “Reordering an Elementary Stream” on page 162. 
• “Remapping Elementary Streams” on page 163.

Creating an Elementary Stream
Use the Manage Elementary Streams screen (Figure 94) to add a new elementary stream to an output 
program.

Menu Path From the Outputs panel of the Grooming -> Mapping tab screen, right-click on a 
program and select Manage Elementary Streams from the pop-up menu.

Note: An ES Type, Stream Type, PID number, Dummy value, and Preconfigured for PMT value can 
only be modified when the word “New” appears next to it in the Stream Order column. Once 
you click OK to save changes, you will not be able to modify any of these parameters for this 
particular stream without deleting the stream and adding it again.

Figure 94. Manage Elementary Streams

1. At the Manage Elementary Streams screen, click Add ES to add a new elementary stream entry to 
the table on display. By default, the new stream is an AC-3 Audio stream (as demonstrated in 
Figure 95).
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Figure 95. Manage Elementary Streams - Add ES

Stream Order must display “New” 
in order to modify the stream.

Use these 
buttons to 
reorder ES 
rows in the 
table.

Modifying Elementary Stream Parameters
Use the Manage Elementary Streams screen (Figure 94) to modify parameters for an output 
elementary stream. See Table 83 on page 160 for details about the screen parameters. 

Menu Path
Grooming tab -> Mapping tab screen: from the Inputs panel, drag and drop a program 
to an output transport stream or an output program at the Outputs panel-> click the 
Program Redundancy tab, then enable (check) Specify a Backup Program. 

1. At the table, click in the column you want to modify:
To set ES Type, click in the ES Type column and select either Audio, Data, or Video (Figure 96).

Figure 96. Manage Elementary Streams - ES Type choices

To set Stream Type, click in the Stream Type column (Figure 97). Options provided from a Stream 
Type cell are dependent on your selection of TS Type: 
- For Video, you can select an option from the pull-down options (Figure 97). 
- For audio or data, the Audio Selection dialog (Table 98) or Data Selection dialog (Table 99) is 

presented. 



SelenioTM BNP  User Guide, Release 3.7.1 158

Grooming and PSIP - Grooming - Mapping

Figure 97. Manage Elementary Streams - Stream Type, drop down for Video ES

Figure 98. Manage Elementary Streams - Audio Selection

The Audio Selection dialog is presented 
by clicking in a Stream Type cell of the 
Manage Elementary Streams table, if ES 
Type is Audio .

Figure 99. Manage Elementary Streams - Data Selection

The Data Selection dialog is presented 
by clicking in a Stream Type cell of the 
Manage Elementary Streams table, if ES 
Type is Data.

Note: If Stream Type is EBIF, EISS or EBIF and EISS, two new descriptor rules will be automatically added 
for each new EBIF or EISS stream. See “Managing PMT and ES Descriptors” on page 177 for 
additional information.

To set PID, double-click the PID field (Figure 100), then type the new PID entry into the field.
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Figure 100. Manage Elementary Streams - PID

Edit PID field.
Convert hex to decimal

Note: When entering a PID you must enter its decimal conversion from its hex listing in the Outputs 
panel of the Grooming -> Mapping window. For example, if you are creating a Dummy PID 
based on an input data stream that has been groomed to a program on an output TS whose PID 
is 0xf05 (note, the “0x” portion of the PID is for internal reference only), the decimal conversion 
would be as follows:�
�
hex: F05 converts to decimal: 3845.

To set the dummy PID for a data ES, click in the Dummy column to select either Yes or No 
(Table 101).

Figure 101. Manage Elementary Streams - Dummy

To set Preconfigured for PMT, click in the column and select either Yes or No (Table 102).
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Figure 102. Manage Elementary Streams - Preconfigured for PMT

2. Click OK to save and use the new configuration. The new or modified ES will be displayed in the 
Outputs panel of the Grooming -> Mapping window.

Essential information about the table columns in the Manage Elementary Streams screen is provided 
in Table 83.

Table 83. Manage Elementary Streams Screen—ES Configuration Columns  

Column Description
Dummy Read-only if stream is groomed; only applicable for data stream. Clicking this 

field will bring up a drop down box with the following options:
• Yes: Select this if the elementary stream is a dummy stream and the 

associated data stream with the same PID is carried by another program 
in the same transport stream. 

• No: This is a read-only value which will appear if the PID is “non-dummy” 
and therefore treated as a regular stream.

Note: The Preconfigured for PMT and Dummy fields are mutually exclusive; 
therefore, when one is set to Yes, the other will be automatically set to No

ES Type Read-only if changes have been saved (i.e., OK has been clicked). If the 
changes to the stream have not yet been applied, clicking this field will open 
a drop down menu with the following options from which to choose:
Audio, Data, or Video.

Grooming Status Read-only. Displays whether or not the stream is currently groomed.

PID Read-only if changes have been saved (i.e., OK has been clicked). If the 
changes to the stream have not yet been applied, double-clicking this field 
allow you to modify the PID associated with the new elementary stream.
• You must enter this value as a decimal conversion of the hex format which 

appears in the Grooming -> Mapping window.

Preconfigured for PMT Read-only if stream is groomed; applies to all stream types, but most useful 
for EBIF / EISS streams.
• Provides the ability to preconfigure the ES by creating associated 

descriptor rules, regardless of whether or not the data for the 
corresponding ES is present in the MPEG stream. When the 
Preconfigured for PMT option is set to Yes, the BNP will not update the 
PMT, as the assumption is the data is already included in the PMT. 

Note: The Preconfigured for PMT and Dummy fields are mutually exclusive; 
therefore, when one is set to Yes, the other will be automatically set to No. 
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Reserved Read-only. If the stream is a reserved PID, Yes will appear; if the stream is 
not a reserved PID, the field will be empty.

Stream Order Read-only. Displays the stream order in the program mapping table (PMT).

Stream Type Read-only if changes have been saved (i.e., OK has been clicked). If the 
changes to the stream have not yet been applied, and depending on the 
selection from ES Type, clicking this field will open variable options:
• For Stream Type Audio, the Audio Selection dialog is presented. Use this 

dialog to define Audio Type and/or Language for the TS. 
- Audio Type: select one of the following options from the drop-down 

menu: 

MPEG-1 Audio          MPEG-2 Audio        AC-3 Audio (0x6)�
AC-3 Audio (0x81)    AAC Audio (0x0f)    HE-AAC Audio (0x11)�
E-AC-3 Audio

- Language Selection: select one of the following options from the 
drop-down menu:

Arabic         English          French      German      Hindi         Italian�
Japanese   Portuguese    Russian    Spanish     Mandarin Chinese

• For Stream Type Dataa, the Data Selection dialog is presented. Use this 
dialog to define Stream Type and/or Stream Sub Type for the TS:

- Stream Type: select a decimal values in the range 5 to 255b. 

- Stream Sub Type: select Data, EISS, EBIF, or EBIF and EISS

• For Stream Type Video, a drop down box displays to enable choice of 
MPEG2 Video, H.264 Video, or SCTE Video.

a. When Stream Type is EBIF, EISS or EBIF and EISS, two new descriptor rules will be automatically added for each
new EBIF or EISS stream. See “Managing PMT and ES Descriptors” on page 177 for additional information.

b. This number appears as hex in the Grooming -> Mapping window; you will need to perform hex to decimal con-
version when selecting this value

Table 83. Manage Elementary Streams Screen—ES Configuration Columns  (Continued)

Column Description
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Reordering an Elementary Stream
Use the Manage Elementary Streams screen to reorder streams in the PMT. (As might be required, for 
example, when you need to change the order a stream is placed in the PMT when sent to the end-
user’s STB.)

1. At the Manage Elementary Streams screen, highlight the row containing the ES you want to 
reorder (Figure 103).

Figure 103. Reordering an Elementary Stream

Stream to be reordered

2. Click the Up or Down button, as required, to put the stream in its proper place in the table.

Figure 104. ES Reordered

Stream reordered

3. Click OK to save and use the settings.
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Remapping Elementary Streams

You can create a reserved PID or select any specific PID from existing output PIDs—during grooming in 
the Configure Program Mapping screen—as an outgoing PID. You have the flexibility of selecting any 
PID value for an outgoing PID. 

• When you select from an existing PID, it should be of the same ES Type and language (for audio) as 
the corresponding Input ES. Without an exact match, you cannot select that existing output PID.

• You cannot create a Reserved PID for Video if there is an existing video PID in the output program 
on which you are grooming.

Working with PIDs
This section provides information about display and management of PIDs, in the following topics:

• “PID Display,” next. • “Elementary Stream Ghost PID Management” on 
page 170

• “Reserved PIDs” on page 163 • “Unreferenced PID Pass Through” on page 171

• “Dummy PIDs” on page 164 • “Unreferenced PID Mapping” on page 172

• “Adding an Unreferenced PID as an Elementary 
Stream” on page 167

• “Referenced PID Mapping” on page 174

PID Display
You can set PIDs to be displayed either as hexadecimal values or decimal values. The setting affects 
display at the Grooming-Mapping tab page and in screens that contain PID fields. 

Use the global PID option to control format of PIDs to be displayed at the BNP Element Manager:

Menu Path BNP Element Manager Configuration tab -> Global tab screen, PID Display Format -> 
click either Hex or Decimal. 

See also Figure 18, “Global tab screen,” on page 37, and Table 17, “PID Display Format—Global 
Configuration,” on page 41.

Reserved PIDs

Reserved PIDs allow you to create PIDs under output programs which will maintain PID values and ES 
Type and Subtype across reboots and regrooming even when the PID is not groomed. These types of 
output elementary streams are called Reserved PIDs.

The Manage Elementary Streams screen can be used to add the ES and to specify its PID and 
subtype, as well as the language for the audio ES. The subtype of the reserved video stream will be 
overwritten by the input Video Subtype but the PID value will be maintained. You can delete any 
reserved ES if it is not groomed from the main screen by right-clicking the ES, and choosing Delete.
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See “Unreferenced PID Mapping” on page 172 for steps on creating reserved PID mapping.

Dummy PIDs 
Maintenance and removal of dummy PIDs are described in the following topics:

• “Guidelines for Dummy PID Configuration,” next.
• “Deleting Dummy PIDs” on page 166.

Guidelines for Dummy PID Configuration
The following guidelines should be taken into account when configuring data streams that use dummy 
PIDs:

1. You cannot configure a Dummy PID data stream unless an actual data stream has been groomed 
to a program in the relevant transport stream.

2. You cannot delete a program with a data stream to which other dummy PID streams point.
3. If you are creating multiple dummy PIDs under one program, they must all point to the original 

data streams from a single program. You cannot create multiple dummy PIDs in one program that 
point to data streams from multiple programs.

4. You can only reference a dummy PID data stream to a data stream in a program that is within the 
same transport stream. 

5. A dummy data PID referenced in a output program will be used regardless of the input source, 
such as the originally groomed network program source, during program redundancy or program 
substitution service, or during a DPI ad insertion.

6. You cannot configure the value in an ES as “Yes” for the Dummy field and “Yes” for the 
Preconfigure in PMT field at the same time.

7. Groom the actual data stream for which you wish to create a dummy PID, from an input program to 
a specific output program. 
This section contains an example that creates a dummy data PID that is associated to the real data 
stream (Figure 105): �
Data [PID: 0x21 Data 0xc2] in Program 6975 BBC HD

Figure 105. Dummy PID: Real data stream groomed

Dummy PID will be associated to this Data 
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8. At the Outputs panel of the Grooming --> Mapping tab screen, right-click on an ES and select 
Manage Elementary Streams from the pop-up menu, to present the Manage Elementary Streams 
screen (Figure 106).
In this example, we will use Program 6904 BBC 1 C1.

Figure 106. Manage ES - New ES for Dummy PID

9. At the Manage Elementary Streams screen, click the Add ES button. A new audio ES is now 
displayed as the last entry to the table of streams.

10. Click in the ES Type column, and select Data. The Data Selection dialog is now presented. 

Note: See the section, “Creating an Elementary Stream” on page 156 for complete details on 
manipulating the fields in the Manage Elementary Streams window.

11. At the Data Selection dialog, select the decimal number that matches the actual data stream’s hex 
ID (this is NOT the PID). In the following example, the number 194 is selected because it matches 
the hex number c2 from the data stream:�
     Data [PID: 0x21 Data 0xc2] in Program 6975 BBC HD.

12. At the Manage Elementary Streams screen, click in the PID column and enter the decimal value 
that corresponds to the hex value from the actual data stream. In the following example, the 
number 33 is entered because it corresponds to the hex value of 21 in the data stream:�
     Data [PID: 0x21 Data 0xc2] in Program 6975 BBC HD.

13. At the Dummy column, select Yes from the drop down box to indicate that this is a dummy PID.
The Manage Elementary Streams window should now contain entries as shown in (Figure 107).



SelenioTM BNP  User Guide, Release 3.7.1 166

Grooming and PSIP - Working with PIDs

Figure 107. Manage Elementary Streams - Dummy PID fields completed

14. Click OK to save changes and add this stream to the Outputs panel of the Grooming -> Mapping 
window.
The data stream (grayed out to indicate dummy PID reference) with associated dummy PID will be 
displayed under the appropriate program (Figure 108).

Figure 108. Dummy Data PID in Grooming -> Mapping window

Dummy Data ES greyed 
out, matching with real 

15. Repeat step 8-step 14 for each additional program (within the same transport stream) under which 
to create your dummy PID reference.

Deleting Dummy PIDs
Use the delete function to remove a dummy PID.

Menu Path From the Grooming -> Mapping window, right-click on a dummy PID data stream and 
select Delete from the popup menu. 
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Adding an Unreferenced PID as an Elementary Stream

You can add an unreferenced PID to an input transport stream. This allows you to manage 
unreferenced PID inputs for various applications in the BNP output. Unreferenced PID streams are 
those MPEG-2 elementary streams encapsulated in the MPEG-2 SPTS or MPTS, whose PIDs are not 
referenced in any PSI (PAT and PMT) tables. These unreferenced PID streams may be purposely inserted 
for some special control and applications; they could also result from the stream originator's error. 

Unreferenced PIDs can come from the program inputs from GigE interfaces or from ASI inputs. In some 
applications, these unreferenced PIDs need to be routed to the appropriate output GigE ports or ASI 
ports as pass-through, or with-or-without the PIDs being remapped. In other cases, these unreferenced 
PIDs need to be dropped, either because such unreferenced PIDs are not required or the streams are 
corrupted. 

Use the Create Ghost Program function to add an unreferenced PID as an ES. 

Menu Path From the Inputs panel of the Grooming -> Mapping tab screen, right-click on a 
transport stream and select Create Ghost Program from the popup-menu (Figure 109).

Figure 109. Creating an Input Ghost Program

1. Enter the Ghost Program Name.
2. Click OK. A new program stream is now displayed in 

the Inputs column for the TS.
3. Right click the new Ghost Program you have created, 

and choose Add Elementary Stream (Figure 110) to 
present the Add Elementary Stream dialog (for single 
or multiple ES).

Figure 110. Adding an Elementary Stream
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4. From the pull-down menus, select the Stream Category, Stream Type, and PID. 
If you check Multiple ES, you can simultaneously define sequential unreferenced PIDs by entering 
the number of Elementary Streams (Number of ES) and the Start PID.

5. At the Add Elementary Stream dialog, click OK to 
present the new PID in the Inputs column for the 
Ghost Program 

Table 84. Add Elementary Stream

Field Description/Values
TS Read-only field that identifies the transport stream associated with this 

configuration. 

Program Read-only field that identifies the program associated with this configuration.

Multiple ES (checkbox) Enable (check) or disable (un-check) multiple elementary streams for this TS. 

Stream Category Choose either Audio, Data, or Video to define the stream category for this ES. 

Stream Type As dependent on your selection for Stream Category, select an option from 
this range to define the selected stream category. See also the following 
topics in this section:
• “ES Audio Stream Types”.
• “ES Data Stream Types”.
• “ES Video Stream Types”

Number of ES For Multiple TS, value to set number of elementary streams allowable for this 
TS, in the range 1 - 32. 

Start PID For Multiple TS, value to set beginning PID.

End PID For Multiple TS, value to set end PID. 

PID (0..8190) For single TS, value to set PID, in the range 0 - 8190.
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ES Audio Stream Types
Use the Add Elementary Stream dialog from an Input Ghost Program to define audio (Figure 111) for 
a TS. 

Figure 111. ES Audio Options
Options are:

• MPEG-1 Audio
• MPEG-2 Audio
• AC-3 Audio (0x6)
• AC-3 Audio (0.81)
• AAC Audio (0x0f)
• HE-AAC Audio (0x11)
• E-AC-3 Audio (0x87

ES Data Stream Types
Use the Add Elementary Stream dialog from an Input Ghost Program to define data (Figure 112) for a 
TS. 

Figure 112. ES Data Options

Values are: 5 to 255

ES Video Stream Types
Use the Add Elementary Stream dialog from an Input Ghost Program to define video (Figure 113) for 
a TS. 

Figure 113. ES Video Options

Options are:

• MPEG-1 Video
• MPEG-2 Video
• H.264 Video
• SCTE Video
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Elementary Stream Ghost PID Management
Ghost programs and PIDs are extra input and output streams not referenced in a Program Association 
Table (PAT). The BNP allows you to manage elementary stream (ES) Ghost PIDs in three ways:

• Unreferenced PID Pass Through. The PID output is unreferenced in the Program Mapping Table 
(PMT) nor is there any mapping to any other program or transport stream table. Typical 
applications are Data PID transport and grooming.

• Unreferenced PID Mapping. This has no reference in the PMT, but is mapped as a table entry in 
the PAT at the transport stream level. This is used in various electronic program guide (EPG) 
applications.

• Referenced PID Mapping. The PID output is referenced as a PMT entry. A typical application 
might be to associate EPG data with one or more programs. 

Unreferenced PIDs streams are those MPEG-2 streams encapsulated in the MPEG-2 SPTS or MPTS but 
their PIDs are not referenced in any PSI (PAT and PMT) tables. These unreferenced PID streams may be 
purposely inserted for some special control and applications; they could also result from the stream 
originator's error. 

Unreferenced PIDs can come from the program inputs from GigE interfaces or from ASI inputs. In some 
applications, these unreferenced PIDs need to be routed to the appropriate output GigE ports or ASI 
ports as pass-through without or with PIDs remapping. In other cases, these unreferenced PIDs need to 
be dropped, either because such unreferenced PIDs are not needed or the streams are corrupted.

The BNP allows you to add and drop the unreferenced PIDs in its inputs from both GigE and ASI ports.

The BNP can groom the unreferenced PIDs from the inputs to the appropriate output transport stream 
(SPTS or MPTS) with or without PID remapping using the GUI configuration for the unreferenced PIDs.

Unreferenced PIDs associated with program inputs are usually known in advance, so they can be 
configured through the GUI for pass-through or drop. The GUI enables the user-configurable 
remapping as an output PID for the input unreferenced PID; the output PID can also be referenced in 
the output TS when necessary through GUI configuration. 

For input ASI ports, the TS is automatically created for the input ASI port. User-configured 
unreferenced PID streams are routed based on grooming rules.

The BNP guarantees there is no conflict between the unreferenced PIDs and the referenced PIDs in its 
output MPTS or SPTS. If there are unreferenced PIDs causing conflict in the output MPTS or SPTS, then 
the groomed unreferenced PID causing the conflict is dropped. This could happen when an 
unreferenced PID is not allowed to be remapped for output.
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Unreferenced PID Pass Through

Use the steps in this section to create a ghost program with a data ES, and map the unreferenced PID 
from a program input such as that shown in Figure 114.

Figure 114. Ghost Program With Unreferenced PID.

1. Drag and drop the ghost program from the Inputs panel of the Grooming -> Mapping window 
to the desired output transport stream to present the Configure Mapping Window.
Note the PID number of the component PID (in this case, 115). You will need this when you want to 
create a referenced PID mapping.

2. Be sure that the Stay Unreferenced box is checked, and click OK.
The ghost program and its data transport stream with PID of 0x73 (hex conversion from decimal) 
appears on both the input and output (Figure 115) panels, which indicates that the stream has 
been passed through.

Figure 115. Ghost Program Passed Through
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Unreferenced PID Mapping

Note: You cannot change an unreferenced output program to a referenced output program (and vice-
versa) during a regroom. You must first delete the output program (and grooming) to change this 
setting.

1. At the Grooming Mapping tab page, right-click on an output port and select Create Output 
Transport Stream from the popup menu to present the Create Output Stream dialog 
(Figure 116). 

Figure 116. Unreferenced PID Mapping

2. Enter the Destination IP address and the UDP Port number, choose DVB as the TS Type and click 
OK.

3. Drag the ghost program from the input panel and drop it on the DVB transport stream you just 
created. The Configure Program Mapping window (Figure 117) is now presented.
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Figure 117. Configure Program Mapping Window

4. At the Configure Program Mapping screen, be sure that the Stay Unreferenced box is checked.
5. Click the empty field to the right of the Component PIDs. The Select Elementary Stream window 

of Figure 118 appears.

Figure 118. Select Elementary Stream Window

6. Enter the new reserved PID number and click OK. 
7. Click OK in the Configure Program Mapping window. The unreferenced PID is mapped.
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Referenced PID Mapping

Input Ghost ES PIDs can be groomed by the BNP and referenced as ES PIDs in one or more program in 
the output TS. Figure 119 shows the starting window with the unreferenced data PID ES created under 
a Ghost Program on the input.

Figure 119. Starting Window for Referenced PID Mapping

Unreferenced data 
PID in Ghost 

Output program to which 
the Ghost PID will be 

1. Drag and drop the input ghost program (in this case: Ghost-Program-1) to the output transport 
stream. Be sure the Stay Unreferenced box is checked (Figure 120).

Note: The ghost program must be groomed to the output TS first (step 1) before creating a dummy PID 
as described in step 4.

Figure 120. Mapping the Transport Stream
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2. Click OK.
The ghost program and its unreferenced PID appear in the Outputs panel of the Mapping 
window.

3. Highlight the output program (from Figure 119) you wish to reference the data PID to, right click 
and choose Manage Elementary Streams.

Figure 121. Manage Elementary Streams

4. Click Add ES and fill in the new row (Figure 122) as described in “Dummy PIDs” on page 164. You 
will need to know the PID reference, which, in this case, is 115. Be sure to select Yes in the Dummy 
column.

Figure 122. New ES filled In
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5. Click OK.
The new ES will appear under the program. The mapping window shows the same PID in both 
programs, with the (dummy) PID in Program 1 grayed out.

Figure 123. Dummy data PID in Program grayed out

Clicking on the program of the grayed out data PID and selecting Manage Elementary Streams 
will show the Dummy PID status of Yes and a Reserved PID status of Yes as well:

Figure 124. Manage ES - Dummy and Reserved status
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Managing PMT and ES Descriptors
The Element Manager provides the ability to create program descriptor rules that the BNP will apply 
when it sends out a Program Management Table (PMT) for a specified output program. The rules allow 
for the appending or removal of output stream descriptors on the PMT level and will remain persistent 
upon program regrooming. 

Use the Manage Descriptor Rules screen (Figure 125) to view, add, edit, and delete program 
descriptor rules. 

Menu Path From the Outputs panel of the Grooming -> Mapping tab screen, right-click on a 
program and select Manage Descriptor Rules from the pop-up menu.

Figure 125. Manage Descriptor Rules window

The Manage Descriptor Rules screen displays details about currently configured rules. Details about 
operations you can perform from this screen are described in the following topics:

• “Adding Program Descriptor Rules,” next. 
• “Editing Program Descriptor Rules” on page 180.
• “Deleting Program Descriptor Rules” on page 181.

Adding Program Descriptor Rules
Use the Add Descriptor Rule dialog (Figure 126) to set parameters for a new descriptor rule. A new 
descriptor rule is not applied at the BNP until all steps in this procedure are completed. 

Menu Path Manage Descriptor Rule screen: click Add Rule --> Add Descriptor Rule dialog.
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Figure 126. Add Descriptor Rule window

0x

1. At the Add Descriptor Rule dialog, set parameters for the rule. Guidelines are provided in Table 85 
on page 179.

2. Click OK to create the rule. It will now be displayed as “New” in the Manage Descriptor Rules 
screen (Figure 130). 

Note: The rule is not yet applied to the BNP.

Figure 127. Add Descriptor Rule - New status

3. At the Manage Descriptor Rules screen, click OK to apply the new rule change to the BNP. Status 
“New” is now removed from the screen (Figure 128).
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Figure 128. Manage Descriptor Rules - Rules Added

4. Click Cancel to close the window. 

Table 85 describes the fields available in the Add Descriptor Rule menu.

Table 85. Manage Descriptor Rules fields  

Field Description
TS This field is read-only. Displays the Transport Stream ID and type for which 

the rule will apply.

Program This field is read-only. Displays the name of the program for which the rule 
will apply.

Name For reference use only when appending (or adding) an output program 
descriptor. Do not enter data in this field when removing a descriptor.

Action Specify which action is to occur for this rule. Choices are:
• Append Descriptor: adds the specified descriptor to the PMT of the output 

stream. The descriptor is appended to the end of the program descriptor 
loop if the PID is 0, or the ES descriptor loop if the configured PID matches 
the elementary stream PID.

• Remove Descriptor: removes the specified descriptor from the PMT of the 
output stream. If the BNP doesn’t find a match descriptor in the PMT, no 
action is taken.

PID Specifies the PID of the stream. Valid range is from 0 to 8190. If the 
descriptor is a program descriptor, enter a value of 0. Otherwise, enter the 
elementary stream (ES) PID value; the descriptor rule is applied to this ES.
• Clicking the green DEC button in this field will toggle the field from decimal 

to hex view. 
• Clicking the green HEX button in this field will toggle the field from hex to 

decimal view.
• See Figure 129 for an example of the DEC to HEX toggle view.
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Figure 129 shows an example of the DEC to HEX toggle view in the Add Descriptor Rule window.

Figure 129. Add Descriptor Rule - DEC to HEX toggle

Editing Program Descriptor Rules

Use the Add Descriptor dialog, from the Edit Rule option, to modify details for a specified descriptor 
rule. 

Menu Path Manage Descriptor Rules screen, highlight one of the displayed rules, and click the Edit 
Rule button --> Add Descriptor dialog.

1. Use guidelines listed in Table 85 on page 179 to enter parameters for a descriptor rule. 
If the rule you wish to edit has already been applied to the BNP, you will only be able to edit the 
Descriptor Data field.

2. Click OK to save changes.
The status field at the far left of the Manage Descriptor Rules window will show a status of 
“Changed.”

TAG Specifies the TAG of the stream. First 8 bits of the descriptor packet as 
viewed from an MPEG analyzer. 
Valid range is from 0 to 255 (decimal) or 0 to FF (hex), up to 8 bits.
• Clicking the green DEC button in this field will toggle the field from decimal 

to hex view. 
• Clicking the green HEX button in this field will toggle the field from hex to 

decimal view.
• See Figure 129 for an example of the DEC to HEX toggle view.

Descriptor Data (Hex Data): Enter the hex value program descriptor to be appended or removed to or 
from the PMT of the output stream.
• This value must be an even numbered hex value.
• This value must be an exact match for the program descriptor as known or 

discovered through an MPEG analyzer. The BNP will not discover or 
display the descriptors from the actual TS.

• When the rule applies to an input stream, the Descriptor Data field is 
passed through based on information from the input program. 

Table 85. Manage Descriptor Rules fields  (Continued)

Field Description
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Figure 130. Edit Descriptor Rule - Changed status

3. Click OK in the Manage Descriptor Rules window apply the new rule change to the BNP, 
removing the “New” status from the far left of the menu. 

4. Click Cancel to close the window. 

Deleting Program Descriptor Rules
Use the Delete Rule function to remove a specified descriptor rule. This operation removes rule 
information from the Descriptor Rules screens, and from the BNP. 

Menu Path Manage Descriptor Rules screen, highlight one of the displayed rules, and click the 
Delete Rule button.

1. At the Delete Rule confirmation dialog (Figure 131), click Yes.
2. Note that the rule is now removed from the Manage Descriptor Rules screen. 

Figure 131. Manage Descriptor Rules - Delete Rule
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Monitoring Bitrates
The BNP can simultaneously monitor up to 14 programs. If the total selected number of programs 
exceeds 15, the programs in the earlier monitoring list are shifted out, and newly selected programs are 
added to the bottom of the list. The bit rate monitor window only keeps up to 14 programs. Each 
program is shown as a percentage of the total. 

Access and view real-time monitoring graphs, as described in the following topics:

• “Using the Input Bitrate Monitor,” next.
• “Using the Input-Output Bitrate Monitor” on page 184.

Using the Input Bitrate Monitor
By default, the Input Bitrate Monitor screen is not monitoring anything until you select a program or 
stream to monitor. You can opt to view input bitrate only (default) or combine this with a view of video 
input bitrate and CC errors. 

Menu Path Grooming tab -> Input Bitrate Monitor tab.

1. At the Input Bitrate Monitor screen, click the Select Input button (Figure 132).
2. At the Select Input Programs to Monitor screen, click one or more transport streams, then click 

OK to dismiss the selection screen. 
3. To include a view of Input Video Program CC Error Counts per second, click the Video Input 

Bitrate and CC Errors option.

Figure 132. Selecting Input Programs to be Monitored

The following changes now occur in the Input Bitrate Monitor screen (Figure 133):

- The left panel lists the names of your selected transport streams, at the Input Program List.
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- The right panel presents a dynamic bar chart showing the bitrates associated with each of the 
selected streams. If you selected the Video Input Bitrate and CC Errors option, monitoring 
results are displayed above the input bitrate bar chart (Figure 133).

Figure 133. Viewing Monitoring Detail for Input Programs 

Total input rate as 
compared to the 
assumed output 

Click to remove monitoring of a
highlighted row from the Program List.

Percentage of total output bit rate for each program.
Default = 38.7. You an enter a different value here.

Stop monitoring: 
freeze the view.

Video Input 
Bitrate and CC 
Errors

Figure 134. Example—Input bitrate exceeds output
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Using the Input-Output Bitrate Monitor
By default, the Input-Output Bitrate Monitor screen is not monitoring anything until you select a 
GigE port and transport stream to monitor. 

Menu Path Grooming -> Input-Output Bitrate Monitor tab.

1. At the Port pull-down menu, select a GigE port.
2. At the Transport Stream pull-down menu, select a transport stream.
3. Enable (check) or disable (un-check) the any or all of the following options to monitor:

- Input Bitrate
- Output Bitrate
- CC Errors

Figure 135. Input-Output Bit Rate Monitor tab screen
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CHAPTER 7

Maintenance

This chapter describes how to use the BNP Element Manager to perform maintenance tasks. 

Applicable Platforms: The information in this chapter can be used with any BNP device. 

In This Chapter:
• “Software Upgrade,” next.
• “Clearing the Web Start Cache” on page 190.
• “Managing Licenses” on page 190.
• “Changing the SNMP Community String” on page 193.
• “Configuring the Time Offset Table (TOT)” on page 194.
• “Rebooting the System” on page 196.
• “System Shutdown” on page 197.
• “Removing Chassis Redundancy” on page 198.
• “Regrooming” on page 198.
• “Force Re-allocation of TS” on page 199.

Software Upgrade
To upgrade to the latest BNP software, download the software from an FTP server and use the BNP 
Element Manager upgrade feature to perform the upgrade. You will receive the specific information 
about the upgrade software when you purchase an upgrade, or when you are notified that an upgrade 
is available. 

In most cases, you can simply upgrade from your currently running release to the most recent, 
regardless of the sequence of releases in between (see “Upgrade Sequence” on page 186). However, 
systems running BNP software previous to 3.5.0 must first upgrade to 3.5.0 prior to attempting an 
upgrade to the currently available release. 

Note: Always refer to the Release Notes for supported upgrade paths. 

Use this section to find out how to upgrade a standalone BNP, or the active and standby BNPs in a 
redundant configuration, as described in the following topics:

• “Upgrade Sequence,” next.
• “Upgrading Software in a Single Chassis Environment” on page 186. 
• “Upgrading Software in a Redundant Chassis Environment” on page 188. 

Note: Please contact Imagine Communications Customer Support for assistance in performing a 
software downgrade process.
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Upgrade Sequence
The BNP can be upgraded from any of the following releases to the current release:

• BNP 3.5.5 (build 64325)
• BNP 3.5.4 (build 57976)
• BNP 3.5.3 (build 55783)
• BNP 3.5.2 (build 53116)
• BNP 3.5.1 (build 52097)
• BNP 3.5.0 (build 50397)

Note: If the BNP is running a release prior to any of the above, you must first update the system to 
Release 3.5.0 before attempting to upgrade to the current release. 

Upgrading Software in a Single Chassis Environment
Use the Upgrade Software dialog (Figure 136 and Table 87) to define the source and destination for 
software intended for use by a standalone (non-redundant) BNP. This dialog also allows you to enable 
or disable auto-reboot of the system upon completion of the upgrade. A typical upgrade procedure for 
use with a standalone system is provided in Table 86.

Menu Path BNP Element Manager main menu: Maintenance -> Software Upgrade
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Figure 136. Upgrade Software dialog

Provide information in all fields.

Table 86. Standalone Chassis Software Upgrade Steps 

Step Description
1. Upgrade the BNP 

chassis.
At the Upgrade Software screen:
a. Type the FTP Host, User Name, Password, and Directory and File 

Name: Un-check the Reboot chassis after successful software 
upgrade option.

b. Click Upgrade and wait until you see the 100% completion message in 
the Upgrade Log. 

2. Shut down the chassis. Log into the BNP via its Physical IP address and use the 
Maintenance ->  menu to perform a .

3. Remove power from 
the chassis. 

After shutting down the system through the Element Manager, wait 
one minute (or until the Fault LED has stopped blinking) and unplug 
the power cord from the chassis.

4. Power cycle the BNP. Apply power to the BNP and wait until the chassis is accessible 
through the GUI and output streams are verified.

Table 87. Upgrade Software - Configuration Fields  

Field Description
FTP Host Enter the IP address of the FTP server on which the upgrade software 

package resides.
User Name Enter the user name needed to access the FTP server.
Password Enter the password for the user name provided above.
Path Enter the source location of the upgrade software. Specify the 

directory and file name using the format shown on the Upgrade 
Software dialog. 
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Upgrading Software in a Redundant Chassis Environment
In a redundant BNP environment, both the active and standby chassis will need to be upgraded. The 
Upgrade Software dialog (Figure 137) for redundant BNPs presents options that allow you to define 
how to apply your software upgrade parameters—to both active and standby, or only to active or 
standby. This dialog also allows you to enable or disable auto-reboot of the system upon completion of 
the upgrade. Use the procedure in Table 88 to perform a redundant BNP software upgrade. 

Menu Path BNP Element Manager menu: Maintenance -> Software Upgrade

Upgrade Log Viewing area in which to watch messages during the upgrade. The 
upgrade is complete when you see status as 100% installed.

Reboot chassis after 
successful software 
upgrade

To reboot the chassis automatically, enable this feature; otherwise, 
you will have to reboot the chassis manually.

Table 87. Upgrade Software - Configuration Fields (Continued) 

Field Description
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Figure 137. Software Upgrade - Redundant chassis 

Table 88. Redundant Chassis Software Upgrade Steps 

Step Description
1. Upgrade the active BNP 

chassis
At the Upgrade Software screen:
a. Type the FTP Host, User Name, Password, and Directory and File 

Name. 

b. Select the Both Active and Standby radio button.
c. Un-check the Reboot chassis after successful software upgrade 

option.
d. Click Upgrade and wait until you see the 100% completion message in 

the Upgrade Log. 

2. Shut down the Standby 
chassis, then shut down 
the Active chassis. 

a. Log into the Standby’s Element Manager via its Physical IP address 
and use the Maintenance ->  menu to perform a .

b. Log into the Active’s Element Manager via its Virtual IP address and 
use the Maintenance ->  menu to shutdown the system.

3. Remove power from 
the Standby chassis. 

After shutting down the Standby through the Element Manager, wait 
one minute (or until the Fault LED has stopped blinking) and unplug 
the power cord from the standby chassis.

4. Power cycle the Active 
chassis, then power up 
the Standby chassis. 

a. Power cycle the active chassis.

b. Wait until the active chassis is accessible through the GUI and output 
streams are verified.

c. Replace power to the standby chassis and proceed with boot up.
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Clearing the Web Start Cache
Any time that you downgrade software, you must clear the cache from the Java Web Start. Older 
versions of the BNP Element Manager use Web Start when the BNP Element Manager is started. This is 
only needed when you change to a software version previous to the current one.

To clear the Java Web Start cache (on a Windows system)
1. From the Windows Start Menu, select Settings -> Control 

Panel -> Java to launch the Java Control Panel. 

2. From the Temporary Internet Files section, click the 
Settings button.

3. At the Temporary Files Settings screen now on display, click 
Delete Files and OK. 

4. Click Advanced tab, and check to ensure that the 
Application and Applets and Trace and Log Files boxes 
are checked.

5. Click OK to clear the cache and close the Java Control 
application.

Managing Licenses
The determination of what type of license is used for a particular transport stream and its bandwidth is 
made when you configure an output transport stream. A transport stream can only be assigned to a 
license type after the license has been installed. For more information on configuring various types of 
output transport streams, see the relevant sections in the Grooming and PSIP chapter of the BNP User 
Guide.

BNP licensing is based on the total bandwidth of output multiplexes where each Mux can be MPTS or 
SPTS. An associated license allows the creation of as many Mux or programs as will fit in the licensed 
bandwidth. For example, z40 Mbps Mux allows a MPTS with programs averaging at around 2.5 Mbps, 
or 10 CBR SPTS programs at 4 Mbps.

All license keys are tied to the serial number of the compact flash card, which allows flash portability 
and access to stored configurations.

Topics in this section: 

• “BNP License Types,” next.
• “Purchasing Licenses” on page 191.
• “Activating a License Key” on page 192.
• “Checking Hardware Capacity Status” on page 193.
• “Flash Portability” on page 193.
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BNP License Types
The license types available for use with the BNP are listed in Table 89. 

Table 89. BNP License Types

Type of License Description
Grooming with DPI Enables all product features, including grooming, statistical multiplexing, 

transrating, DPI (ad insertion), PSIP, all redundancy options, Gigabit 
Ethernet, and SCTE 30 to SCTE 35 conversion. 
This license is also referred to as the ‘standard’ grooming license. 

Applicable Platforms: BNP 2xr, BNP 2xr+, BNP 3xr
Grooming Enables all features without DPI. This license provides the option to add 

support for all features with a DPI license upgrade at a later time. 

Applicable Platforms: BNP 2xr, BNP 2xr+, BNP 3xr
Messaging System Enables use of integration with an external digital SCTE 18 EAS server, 

including option for Operator-defined message alerts. 
This license must be used in conjunction with the Grooming with DPI or 
Grooming (non-DPI) license. 

Applicable Platforms: BNP 2xr, BNP 2xr+, BNP 3xr
Advanced Overlay Provides ability for static logo insertion and import of external text or 

graphics for playout.
This license must be used in conjunction with the following licenses: 
• Either the Grooming with DPI or Grooming (non-DPI) license. 
• The Messaging System license. 

Applicable Platforms: BNP 2xr, BNP 2xr+, BNP 3xr
SPTS Allows a Single Program Transport Stream to be created on the output. 

The functionality of this license is identical to the standard grooming license 
with the exception that creation of an MPTS on the output is not allowed. 

Applicable Platforms: BNP 2xr, BNP 2xr+, BNP 3xr
Program with DPI Allows Digital Program Insertion on a per-program basis. 

This license is used in conjunction with the standard Grooming license and 
the SPTS license which enable grooming, statistical multiplexing, and 
transrating. 

Applicable Platforms: BNP 2xr, BNP 2xr+, BNP 3xr
DVB-CA Allows DVB Conditional Access on a per-TS MUX bandwidth basis. This 

license is available in 4Mbps increments and is tracked at the TS level. 

Applicable Platforms: BNP 2xr+, BNP 3xr

Purchasing Licenses

The BNP is shipped with a license key pre-loaded on the system.To purchase an upgrade license, 
submit your request and PO to your reseller or to Imagine Communications if you purchased the 
product directly. Your request will then be processed and a new license key will be sent to you.
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In your request, be sure to include the serial number of your compact flash card and the current 
number of licenses you have for that particular system. Imagine Communications will issue a new 
license key that will accommodate the total number of licenses for that system. For example, if you 
currently have a 4-Mux license (160 Mbps) for a single BNP and you are ordering two more licenses for 
this system, Imagine Communications will issue a new license key for 6 Muxes (240 Mbps). If 
purchasing licenses for multiple systems, you will need to indicate how many licenses per system with 
the serial number of the compact flash of each system clearly indicated. Imagine Communications will 
then issue separate license keys for each system.

Activating a License Key
After you receive the license key, use the License Manager screen (Figure 138) to activate a license. 

Menu Path BNP Element Manager main menu: Maintenance (Alt m)-> License Manager

1. At the License Manager screen, verify that the information currently on display is correct. 
2. In the New License Key field, enter the license key 

Note: There is only one field in which to input a license key; this field is applicable to all types of 
licenses. 

Figure 138. The License Manager (BNP 3xr Example)

3. Click Apply New License. The updated information is now displayed in the License Manager. 
Figure 138 shows the currently installed license key and Compact Flash ID (serial number).

Note: Adding a Messaging System or Advanced Overlay license key also requires a reboot to take effect.
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Checking Hardware Capacity Status

Use the Hardware Capacity for Current System section of the License Manager window to view 
hardware capacity information—which is defined as the maximum number of licenses and bandwidth 
that the system can currently support, as based on the hardware currently installed in the BNP. In the 
License Manager screen, capacity information is provided in the following rows: 

• Total Installed—the number of licenses residing in the compact flash and the resulting potential 
bandwidth available in each license category. This number of licenses shown in this display may 
exceed your current hardware capability.

• Available License—based on either the installed licensed bandwidth or hardware capacity 
bandwidth, whichever is less. In this display, Used Bandwidth + Available Bandwidth equals either 
the Total Installed licensed bandwidth or the Hardware Capacity, as depending on which is lower.

• Used License—indicates the bandwidth actually in operation.

Flash Portability

One of the advantages of the BNP's licensing structure is flash portability. In the unlikely case that your 
system suffers a catastrophic failure and you need to replace the hardware, remove the compact flash 
from the old BNP chassis and install it into the new hardware. The new system should now operate just 
like the old system as long as the hardware in the new system can support the same configuration. For 
example, if the failed system used two processor cards with two ASI cards, your new system would 
need to have the same hardware to support an identical configuration.

Changing the SNMP Community String
SNMP community strings control read and write access to BNP configuration. To read the BNP’s 
configuration, an SNMP Network Manager must provide a community string that matches the BNP’s 
Read Community String. To change the BNP’s configuration, the SNMP Network Manager must 
provide a string that matches the BNP’s Write Community String.

Menu Path From the Element Manager, select Maintenance (Alt m)--> Change SNMP Community String.

1. At the Modify SNMP Community String dialog, change 
either or both the Read and Write strings to the desired 
values, then click OK. 
When the BNP prompts for a reboot. Click OK to proceed.

2. After the system reboots, log in to the Element Manager.

Note: You will not be able to change the SNMP Community 
String at this point. You will need to log in as normal and 
allow the system to produce an error, thus prompting for 
new SNMP Community String entries.



SelenioTM BNP  User Guide, Release 3.7.1 194

Maintenance - Configuring the Time Offset Table (TOT)

3. After you click the Log in button, the BNP will timeout and 
display the BNP unreachable message. Click OK to dismiss 
this message. �
The BNP Log In screen is now displayed, with fields in which 
to enter the SNMP Community String Read and Write 
strings. �
Enter the new Read and/or Write community strings to match the entries you changed in step 1 
above.

4. Click the Log in button.
The BNP will log you in as normal.

Note: You will need to log in as described above for any workstation that is accessing the Element 
Manager for the first time after the SNMP Read / Write Community Strings have been 
changed.

Configuring the Time Offset Table (TOT)
The TOT conveys additional information about summer and winter time periods and gives the local 
time offset with respect to UTC for different countries or regions. If the TOT is locally generated, user 
interaction is required to define the country or region in which the receiver is operated. The BNP 
supports the required DVB tables, including TOT. 

Use the Set up Time Offset table (TOT) dialog for this configuration.

Menu Path From the Element Manager, select Maintenance (Alt m)--> Setup Time Offset table 
(TOT) (Alt t) (Figure 139 and Table 90).
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Figure 139. Accessing TOT Parameters

 

Table 90. TOT Parameters  

Field Description
Country Code The three-character country code.
Region ID Value, in the range 0 to 60, to set the region identifier. 

0 = one time zone in the country. 
Other time zones are numbered from 1 (most easterly) up to 60 
(most westerly).

DST Offset The DST offset: (range is -2:00, -1:30, -1:00, -0:30, 0, +0:30, +1:00, 
+1:30, +2:00). The value is 0: when DST is not applicable; otherwise 
the offset to be applied to current time when DST is in effect.
For example, in the US, the local time offset when DST is not in effect 
is -8, and when DST is in effect, it is –7. So, the DST offset is +1. 
polarity is 1 as time is behind UTC.

Start Time Fields to set day, month, hour, and minute, to define when DST takes 
effect in the current year.

End Time Fields to set day, month, hour, and minute, to define when DST ends 
in the current year.

Day Select option to set start or end day for TOT:
1st Sunday, 2nd Sunday, 3rd Sunday, or Last Sunday.

Month Select option, to set start or end month for TOT:
January to December.

Hour Select value, to set start or end hour for TOT:
Range: 1 to 23.

Minute Select value, to set start or end minute for TOT:
Range: 0 to 59.
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Rebooting the System
Any time you load a new software image, you must reboot the system. When a power cycle or reboot is 
performed, the BNP will retain previously saved configuration settings. Only the parameters of newly 
introduced features need to be set when the system is upgraded and rebooted. 

You can reboot the BNP either by using a power cycle or by using the reboot option from the BNP 
Element Manager. 

Rebooting the BNP

The BNP does not have a power switch. To power the unit down, disconnect the power cable from the 
connector as described in your BNP installation guide. 

A system reboot can be performed by Administrative or Operator user accounts. 

Use the Reboot option from the BNP Element Manager. The system will prompt for your Administrative 
or O

Menu Path BNP Element Manager main menu --> Maintenance (Alt m)--> Reboot (Alt b)

perator password, and for confirmation of the reboot. 

1. At the Password Verification dialog, enter your 
password and click OK. �

2. At the Reboot confirmation screen, click Yes to continue 
or No to dismiss the dialog and to cancel the reboot. 



SelenioTM BNP  User Guide, Release 3.7.1 197

Maintenance - System Shutdown

System Shutdown
Use the procedure in this section if you need to power off the system for servicing, such as when 
removing a Video Processing Module, ASI module, or GBP3 module. 

Note: It is not necessary to power-off or shut down the system when servicing hot-swappable modules. 

During a system shutdown, video services are stopped, and the BNP Administrative interface is 
disabled but you can use Telnet to connect to the BNP. A system shutdown stops all video services on 
the BNP. If chassis-level redundancy is configured and you are stopping all services on the active BNP, 
the standby BNP will become active.

Note: The only way to restart video services following a system shudown is to manually power cycle the 
chassis by removing and reinserting the power cord.

Note: Prior to performing the steps in this section, ensure there is a technician standing by at the 
physical location of the BNP.

A system shudown can be performed by Administrative or Operator user accounts. 

Use the system shutdown option from the BNP Element Manager. The system will prompt for your 
Administrative or Operator password, and for confirmation of the shutdown. 

Menu Path BNP Element Manager main menu -> Maintenance (Alt m)-> System Shutdown (Alt s)

1. At the  confirmation dialog, click Yes to 
continue, or No to abort. 

2. At the Password Verification prompt , 
type your Administrative or Operator 
password, and click OK.
All services at the BNP will now be 
stopped. Look for the solid green (or unlit) 
Fault LED on the BNP to verify that services 
are stopped. 

3. Disconnect power from the power source. 
Ensure that all LEDs are unlit. No sounds 
should be audible from the unit at this 
time. 
On a DC system, remove the power cables 
from the BNP power supply connectors (or both sets of cabling in the case of power supply 
redundancy). �
On an AC system, remove the power cord from BNP power supply connector (or both cords in the 
case of power supply redundancy). 
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Removing Chassis Redundancy
Use the Remove Chassis Redundancy function to tear down the redundant configuration between a 
pair of BNPs. 

Menu Path Element Manager main menu -->Maintenance (Alt m)--> Remove Chassis 
Redundancy (Alt r)

The BNP Element Manager will query for confirmation of 
the removal. 

At the Confirmation dialog, click Yes to proceed, or No 
to dismiss this dialog. 

Regrooming
Regrooming lets you reset all of the programs that are currently configured in Program Redundancy to 
their Active Programs. Once initiated, the command will check to see that the active program has been 
restored. If the active program has not been not restored, no change will occur to the current state of 
the program. 

The Regrooming feature resets all programs with a properly detected primary program available. 

Note: This feature cannot be used to regroom a selected stream.

To Reset all of Grooming to the Active Chassis
Use the Regroom function to apply a chassis regroom on the active BNP. 

Menu Path Element Manager main menu -->Maintenance (Alt m)--> Regroom (Alt g)
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At the Regroom dialog, click Apply regroom to proceed, or 
Cancel to dismiss this dialog.

Force Re-allocation of TS
Use the Force Rec-allocation of TS function to 
redistribute output transport streams to available 
PROC modules in the BNP. 

This action will require restart of the BNP, as 
indicated by the confirmation popup. 

Menu Path
Element Manager main menu -->Maintenance (Alt m)--> 
Force re-allocation of TS (Alt a)
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Digital Program Insertion (DPI)

This chapter describes digital program insertion and how it relates to the Selenio™ BNP. 

To implement DPI on the BNP, you need either a GROOMING WITH DPI license key or a PROGRAM 
WITH DPI license key. See “Managing Licenses” on page 190 for additional information. 

Applicable Platforms: The information in this chapter can be used with any BNP device. 

In This Chapter:
• “Digital Program Insertion,” next.
• “Connecting an Ad Server to the BNP” on page 201.
• “Setting SCTE 30 and SCTE 35 Message Handling” on page 202.
• “Setting Postblack Options for DPI” on page 204.
• “Viewing DPI Status” on page 205.

Digital Program Insertion
The BNP supports industry standard digital program insertion (DPI) applications, such as program 
substitution and ad insertion. 

The BNP is fully interoperable with industry compliant ad servers through the SCTE 30 interface. When 
a successful SCTE 30 initialization has been established with the BNP, the Element Manager indicates 
such with an arrow icon on the Input/Output window of the Grooming -> Mapping tab.

The BNP is fully compliant with the SCTE 30 and SCTE 35 standards. A common DPI / ad insertion 
application deployment using SCTE 30 and 35 (the latter carrying in-band availability cue messages) 
may be represented by the following regional ad zone insertion illustration:
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Figure 140. Regional Ad Zone Insertion Illustration
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The BNP receives ads along with SCTE 30 splice messages from an ad server. Receiving these messages 
triggers the BNP to splice the ad. The ad is then treated the same as other objects in the BNP 
configuration.

Note: Imagine Communications recommends that you use an NTP server with the BNP. An NTP server 
is required if you are performing Digital Program Insertion (DPI) and dynamic grooming. You 
must have the NTP server up and running prior to booting up your BNP.

Note: When configuring a DPI-enabled program, do not use Handle as Data Quality of Service levels 
when grooming a program. See Table 79 on page 147 for additional information. 

Connecting an Ad Server to the BNP
Figure 141 shows how the ad server is connected to the BNP. Other connections may be possible, but 
this figure shows the general connection.

Figure 141. Ad server - BNP connection
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Setting SCTE 30 and SCTE 35 Message Handling
The BNP is capable of receiving SCTE 30 messages from an ad server and converting those messages 
into SCTE 35 messages.

Figure 142. SCTE 30 to SCTE 35 Conversion
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The BNP is also capable of forwarding SCTE 35 messages from input streams to output streams during 
network time and ad time.

To set SCTE 30 and 35 message handling options:

1. Launch the Element Manager and log in as the administrator as described in “Log in and Access the 
BNP Element Manager” on page 25.

2. Select the Grooming -> Mapping window.
3. Groom an input program to an output transport stream as described in “Drag and Drop Grooming” 

on page 140.
The Configure Program Mapping window appears.

4. From the Configure Program Mapping window, check either the Forward SCTE 35 Cue or the 
SCTE 30 to 35 Conversion box. 
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Figure 143. Configure Program Mapping window

5. Click OK.

Note: You can either forward SCTE 35 cues from the input stream or convert SCTE 30 messages from an 
ad server, but not both.

Note: Once SCTE 30 to 35 Conversion is enabled, the BNP only performs conversion; no splicing is 
performed.

When you choose Forward SCTE 35 Cue or SCTE 30 to 35 Conversion on an output program, the 
BNP automatically allocates a PID for the cue (splice information) table, even if the input program 
contains no cue table. Figure 144 shows an example of an input program with no cue table groomed to 
an output program selected to forward SCTE 35 cues. Notice the allocation for the cue table in the 
output program.

Figure 144. Allocated PID for Cue Table

Input program with
no cue table

Cue table added
in groomed 
output program
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Setting Postblack Options for DPI
Postblack refers to insertion of black video and muted audio at the end of a spliced ad. Postblack might 
be necessary if the ad is shorter than the specified duration or if there are transmission errors. The BNP 
offers the following configuration options for postblack.

• Postblack in ad server requests — Determine whether to accept or ignore postblack settings in 
SCTE 30 Splice Request messages from ad servers. 

• Postblack for ad underflows — Determine whether to insert postblack after ads that are shorter 
than the time specified in the SCTE 30 Splice Request message. If enabled, postblack is inserted at 
the end of the ad for the remaining time.

Postblack handing is a global setting on the BNP. To view and configure postblack settings:

1. From the Element Manager, select Configuration -> Global.
The Global chassis configuration window appears.

Figure 145. Global chassis configuration
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2. Set your postblack options according to the following table:

Table 91. Postblack Enable Options

Category Field Description/Values
Postblack Enable 
Options

AD Server Request Check this to play postblack that an ad server 
specifies be played at the end of an ad. Left 
unchecked, the BNP will ignore any postblack 
requests from ad servers.

AD Underflows Check this to insert black frames before transitioning 
back to the network, when AD underflows. This will 
allow a smooth transition between the AD that under 
flowed and the network.

DPI Splicing Accurate splicing for non 
CUE DPI

Check this to allow BNP to delay or advance the 
splicing per current latency on the stream. This feature 
is for frame accurate splicing for DTMF based DPI.

3. Click Apply Configuration.

Viewing DPI Status
Use the System DPI Activity screen (Figure 146) to view the BNP chassis-level DPI activity. 

Menu Path BNP Element Manager main menu: Status -> System DPI Activity
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Figure 146. System DPI Activity Screen
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Table 92  System DPI Activity Options

Button Description
Refresh Click to update display of real-time statistics/

counters. 

Reset Click to set all displayed counters to zero and to reset 
the time. 

Cancel Click to dismiss this screen. 

Click on any output program listed at the bottom to find more information related to AD insertions at 
the output program level.
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DVB Conditional Access

This chapter describes the functionality and configuration parameters for the Selenio ™ BNP DVB 
Conditional Access (DVB-CA) feature. 

Applicable Platforms: The information in this chapter can be used only with BNP2xr+ or BNP 3xr. 

In This Chapter:
• “Overview,” next.
• “DVB-CA Required Components” on page 208.
• “DVB-CA Configuration” on page 208.
• “DVB-CA Best Practices and Considerations” on page 235.

Overview
The BNP supports the DVB-CA Common Scrambling Algorithm (CSA) and DVB SimulCrypt protocols 
(ETSI TS 103 197 V1.5.1) for Conditional Access System (CAS) which interfaces with DVB systems. This 
allows for encryption of MPEG-2 and H.264 programs in both SD and HD resolutions. The embedded 
SimulCrypt Engine is a low cost, high density, scalable encryption and management control 
implementation that is fully DVB-CA compliant. The BNP provides two 10/100 Ethernet management 
ports, allowing one of these port to be dedicated to the DVB-CA network. For an example topolgoy, 
see Figure 6, “BNP in a DVB-CA Network,” on page 17. 

The DVB-CA encryption feature includes the following functions:

• SimulCrypt Synchronizer (SCS).
• Control Word Generation (CWG).
• Common Scrambling Algorithm (CSA).
• ECM / EMM insertion.
• CA-related PSI / SI generation and insertion.

BNP’s proprietary SimulCrypt engine interfaces with the following devices:

• Entitlement Control Message Generator (ECMG).
• Entitlement Management Message Generator (EMMG).

• Optional external Event Information Scheduler (EIS)1.

1. The BNP may be configured to use an external EIS server or the internal EIS server provided by the BNP 
software. 
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DVB-CA Required Components
The following components are necessary for a fully functioning DVB-CA system for the BNP:

1. BNP running software version 3.0 or higher.
2. DVB Transport Streams (TSs) configured on the output of the BNP.
3. Conditional Access System (CAS) with the following components:

- Entitlement Control Message Generator (ECMG);
- Entitlement Management Message Generator (EMMG);
- Optional external Event Information Scheduler (EIS);
- Valid NTP server.

4. Determination of whether External EIS mode or Internal EIS mode will be used. 

DVB-CA Configuration
This section describes the steps required for configuration of a DVB-CA system. 

These steps require an Admin login level from the Element Manager. 

1. Verifying the DVB-CA License.
2. Setting Up an NTP Server.
3. Configuring Ethernet Control Port for DVB-CA.
4. Configuring GigE or ASI Port(s) for DVB-CA System.
5. Creating Input TS(s) for DVB-CA System.
6. Creating Output DVB TS(s) for DVB-CA System.
7. Grooming Input Program(s) to Output DVB TS.
8. Creating Input PSI/SI Table Grooming.
9. Grooming the Ghost Program to Output DVB TS.
10. Configuring DVB-CA Global Parameters.
11. Configuring DVB-CA: External and Internal EIS Mode.
12. Configuring DVB-CA for Internal EIS Mode.

Verifying the DVB-CA License
To view or configure DVB-CA parameters in the Element Manager, you must first have a valid DVB-CA 
license. See “Managing Licenses” on page 190 for details on obtaining or verifying a DVB-CA license. 
When a valid DVB-CA license is present, the DVB-CA option is displayed on the main Element Manager 
menu and in the DVB-CA tab (Figure 147). 
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Figure 147. Evidence of DVB-CA at the Element Manager 
�
DVB-CA menu additions to an 
Element Manager that has a 
valid DVB-CA license.
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Setting Up an NTP Server
To enable proper interaction of the DVB-CA feature with the CAS, a network time protocol (NTP) server 
must be set up in the Element Manager such that the IP Address of the NTP server is from the same 
source as that used by the CAS. 

Use the Global configuration tab page to set NTP parameters. 

Menu Path Access via BNP Element Manager Configuration 
tab -> Global tab screen.

1. At the Server 1: field, type the IP address of the NTP server, 
in dotted decimal format. 

2. Click the Apply Configuration button to save and use the 
settings displayed in this tab page.

Configuring Ethernet Control Port for DVB-CA
Of the two 10/100 Base T Ethernet management ports on the BNP, only Ethernet Port 2 is available for 
management access to the CAS. However, you must configure an IP address for both Ethernet Port 1 
and Ethernet Port 2 for proper DVB-CA functionality. 

The ports you will configure at the Element Manager are mapped to the physical ports of the BNP as 
shown in Figure 148. 

Figure 148. DVB-CA - Ethernet Control Port mapping

10/100-1 --> �
Ethernet Port 2

10/100-0 --> �
Ethernet Port 1

Use the Ethernet Control Port tab page to configure the BNP control ports.

Menu Path Access via BNP Element Manager Configuration tab -> Ethernet Control Port tab 
screen.

1. In the Ethernet Port 2 section, type the IP Address, Subnet Mask, Gateway, and DNS Server 
(optional) to which the CAS will connect.
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Note: If you have configured the BNP in a 1:1 redundancy environment, the Gateway IP Address for 
Ethernet Port 2 must be configured.

2. Click the Apply Configuration button to indicate confirmation of the settings displayed on the 
screen. 
Before using the settings, the BNP will prompt for a reboot. Additional information for performing 
BNP reboots is provided in “Rebooting the System” on page 196. 
Settings will take effect upon completion of the reboot. 

Configuring GigE or ASI Port(s) for DVB-CA System
Use guidelines in this section to set port addresses, mirroring, and/or negotiation, as described in the 
following topics:

• “GigE Port Input and Output Interface Configuration,” next.
• “ASI Port Input and Output Configuration” on page 212. 

GigE Port Input and Output Interface Configuration
Use the GigE Ports tab page to manage the GigE ports for the BNP. Note that GigE port can be used 
for simultaneous input and output.

Menu Path Access via BNP Element Manager Configuration tab -> GigE Ports tab page.

Figure 149. Configure GigE - DVB-CA

1. Type the IP Address, Subnet Mask, Gateway, and Auto-negotiation information for the input 
and output GigE port(s) that are to be used for encryption.

2. Click Apply Configuration to save changes.
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ASI Port Input and Output Configuration
Use the ASI Ports tab page to manage the ASI ports for the BNP. Note that an ASI port cannot be used 
for simultaneous input and output: only one direction per port may be selected. 

Menu Path Access via BNP Element Manager Configuration tab -> ASI Ports tab page.

Figure 150. Configure ASI - DVB-CA

1. At the selection field for any particular ASI, select either Input or Output. 
2. Click Apply Configuration to save changes.

Creating Input TS(s) for DVB-CA System
Use the Create GigE Transport Stream screen to create an input transport stream for which programs 
are to be encrypted. 

Menu Path

Access via BNP Element Manager Grooming -> 
Mapping window, right-click on an input GigE or 
ASI port and select Create Transport Stream from 
the popup menu. 

1. Enter the TS Name, IP Address, and UDP Port of the Input 
TS for the programs to be encrypted. 
Guidelines for entering parameters in this screen are 
provided in “Creating Input Transport Streams” on page 109.

2. Click OK to save and use the settings displayed in this 
screen. 
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Creating Output DVB TS(s) for DVB-CA System
Use the Create Output Transport Stream screen to create a new DVB output stream for a GigE or ASI 
port. 

Menu Path
From the Outputs panel of the Grooming tab -> Mapping tab screen, right-click on an 
ASI port or GigE port, and select Create Transport Stream from the popup menu. At the 
Create Output Transport Stream dialog TS Type field, select DVB.

Figure 151. Create Output TS - DVB-CA: GigE port and ASI port 

GigE Port ASI Port

1. Enter parameters for the output stream. 

- Refer to general guidelines provided in “Creating DVB Output Transport Streams” on page 123 
to create a new DVB Transport Stream for either a GigE or an ASI port. 

- For proper encryption operations, ensure that the parameters listed in Table 93 are configured.
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2. Click OK to save and use the settings displayed in this screen. 

Table 93. Output DVB TS parameters for DVB-CA configuration 

Output TS Parameter Description Required DVB-CA Value

Unique TS IDa

a. The DVB-CA standard requires a unique pair value of the TS ID and Network ID fields. 

Allows you to assign a unique numeric ID to this 
transport stream.
• When this option is checked, the TS ID value 

placed in this field will be reserved as unique 
for the entire chassis.

• When this option is unchecked, a TS ID value 
may still be entered, however the value may be 
the same as another TS ID, as long as that TS 
ID’s value has not been reserved as a Unique 
TS ID.

This field must be checked.
The value in this field must 
match that of the CAS.

TS Type The type of stream. The type of stream you 
choose determines what other information is 
required. Choices are:
MPEG-2, ATSC, SCTE, or DVB.

This field must be set to DVB.

Network ID The Network ID of the current transport stream. The value in this field must 
match that of the CAS.

Original Network ID The Network ID from which this stream has 
originated.

The value in this field must 
match that of the CAS.

Modulation Mode Use the pull-down menu to select the modulation 
mode used for the TS.
• The Modulation Mode information is carried in 

the Network Information Table (NIT) of the 
input from the CAS vendor. 

• Choice between SCTE 64 QAM and SCTE 256 
QAM.

The selection in this field must 
match that of the CAS, unless 
NIT is passed through.

SDT Source Source of the service description table for this 
transport stream. If you select N/A then SDT is 
not generated for this output TS.

This field must be set to N/A if 
SDT is originating from an 
external source.

EIT Source Source of the Event Information Tabled (EIT) for 
the programs in this transport stream. If you 
select N/A then EIT will not be generated.

This field must be set to N/A if 
EIT is originating from an 
external source.

Grooming Input Program(s) to Output DVB TS
Use the Configure Program Mapping screen to groom a selected input program for an output DVB 
transport stream 

Menu Path
From the Inputs panel of the Grooming tab -> Mapping tab screen, select an input 
program and drag it to the output DVB created in the Outputs panel -> Configure 
Program Mapping screen. 
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Figure 152. Configure Program Mapping - DVB-CA

1. In the Destination section, change the Program Number to the number assigned and provided by 
the CAS. 

2. If you are using an external EIS server, you may need to reserve the elementary stream PIDs per the 
CAS configuration to match those from the external EIS server. 
If you are using an internal EIS server, reserving a PID is optional and you may proceed to step 4 
below.
In the Component PIDs section, double click on the Output Type or PID fields for each 
elementary stream to assign a new reserved PID and to present the Select Elementary Stream 
screen. 
In the example above and below in Figure 152 and Figure 153, the Input SCTE Video PID of 16 
will be changed to 3011 and the AC-3 Audio PID of 17 will be changed to 3012.

Figure 153. Reserve ES PIDs - DVB-CA

Note: When entering elementary stream PID values in the BNP Element Manager, the values must be 
entered in decimal format. However—in the Grooming -> Mapping screen—these values will 
always appear in hexadecimal format. It will be necessary to perform hex-to-decimal (and vice 
versa) conversion during the DVB-CA configuration.
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3. Select the New Reserved PID radio button and enter the PID, as provided by the CAS vendor, for 
the elementary stream.

4. Click OK to save changes and return to the Configure Program Mapping window (Figure 154).

Figure 154. Configure Program Mapping - PIDs & Program changed - DVB-CA 

5. Repeat step 2 through step 4 for every elementary stream in the Configure Program Mapping 
window.

6. Click OK in the Configure Program Mapping window to complete the grooming process.
The program with the new reserved PIDs (in hexadecimal format: bc3=3011; bc4=3012) is now 
displayed in the Grooming -> Mapping window (similar to the example shown in Figure 155).

Figure 155. Reserved PIDs to Output (in hex) - DVB-CA
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Creating Input PSI/SI Table Grooming
Use the Create GigE Input Transport Stream screen to begin this configuration. 

Menu 
Path

Access via BNP Element Manager Grooming -> 
Mapping window, right-click on an input GigE or ASI 
port and select Create Transport Stream from the 
popup menu. 

1. At the Create GigE Input Transport Stream screen: 

- Enter the IP Address, and UDP Port. 
- Click OK to create the transport stream and to dismiss 

this screen. 
2. At Inputs in the Grooming -> Mapping page:

Right-click the TS that you just created, then select the 
Create Ghost Program option from the popup menu. �
�
The Create Ghost Program dialog is now presented. �

3. At the Create Ghost Program dialog:

- Type a name in the Ghost Program: field. 
- Click OK to dismiss the Create Ghost Program 

dialog. 
The new ghost program is now displayed in the Inputs 
section of the Grooming -> Mapping page. �

4. At Inputs in the Grooming -> Mapping page, right-click 
the new ghost program and select Add Elementary 
Stream from the popup menu.
The Add Elementary Stream dialog is now presented. 
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5. In the Add Elementary Stream dialog:

- Change the Stream Category to Data.
- Match the Stream Type and PID number provided by 

the CAS.
- Click OK to add the elementary stream to the Ghost 

program and to dismiss this dialog 
6. Repeat these steps for every elementary stream provided by 

the CAS vendor for which a PSI/SI table must be generated.�
�

Completion of the elementary stream configurations will 
result in Inputs display in Inputs display similar to the example 
shown at right . 

Grooming the Ghost Program to Output DVB TS
1. Groom the Ghost Program you just created above by dragging the program from the Inputs panel 

of the Grooming -> Mapping window to the output DVB TS from “Creating Output DVB TS(s) for 
DVB-CA System” on page 213. 

2. In the Configure Program Mapping window that opens, check the Stay Unreferenced box.

Figure 156. Configure Program Mapping - Ghost Program - DVB-CA

3. Click OK to complete the grooming process.
The Grooming -> Mapping window will look similar to Figure 157 below:
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Figure 157. Output grooming window with ghost program added - DVB-CA

Configuring DVB-CA Global Parameters 
Before configuring the DVB-CA global parameters, determine if you will be using an external EIS server 
or the BNP’s internal EIS server. External EIS mode requires different setup and menus that are 
determined in the DVB-CA Global Configuration menu. Changing from an external EIS to an internal 
EIS or vice versa will require a reboot of the BNP and will remove all previously configured DVB-CA 
encryption streams. 

To configure the DVB-CA global parameters:

1. From the main Element Manager window, select DVB-CA -> Global Configuration. 
The DVB-CA Global Configuration window of Figure 158 opens:

Figure 158. DVB-CA Global Configuration - Internal EIS mode default
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If an external EIS server is being used (i.e., the Enable button in this window checked), the DVB-CA 
Global Configuration window of Figure 159 will appear as follows:

Figure 159. DVB-CA Global Configuration - External EIS mode default

2. Fill out the fields of this window according to the descriptions listed in Table 94.
3. Click Apply to save any changes.
4. If the Enable button next to the External EIS Port Number field has been checked or unchecked, 

the system will prompt for a reboot. Click Yes to accept the reboot.
Table 94 describes the fields available in the DVB-CA Global Configuration window.

Table 94. DVB-CA Global Configuration fields  

Field Description
Internal EIS mode or 
External EIS mode

Scramble Level Specifies the default scramble level for the BNP 
chassis. The default is set to TS (transport 
stream). This field is read-only.

Common to both

Crypto Period Duration 
(100ms)

Specifies the default crypto period for the BNP 
chassis in 100 millisecond increments.
• The default is set to 200 (which is 20,000 

msecs, or 20 seconds).

Common to both

CW Mode Specifies the Control Word mode to be used for 
the BNP chassis. Choose one of the following 
options from the pull-down menu:
• Conformance 64-bits, Non-conformance 

64-bits, Fixed 0, or Fixed 1.
• Default is Conformance 64-bits.

Common to both

CAS Mode Specifies the CAS mode for the BNP chassis. 
Default is Broadcast mode; this field is read-only.

Common to both
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External EIS Port Number

Enable button

Specifies the TCP port number that the BNP will 
use to connect to the external Event Information 
System (EIS) server.
• This field is for an External EIS server to 

communicate with the BNP.
• Default value is 1; valid range is from 1 to 

65535.

External EIS mode 
only

Checking this button will do the following: 
• Switch the DVB-CA system from an internal 

CAS to an external CAS.
• Allow editing of the External EIS Port Number, 

EIS Test Timeout, and EIS Test Interval fields.
Un-checking this button will do the opposite of the 
above. 

Determines if system 
uses External EIS 
mode or Internal EIS 
mode

EIS Test Timeout Specifies the testing timeout (in seconds) for the 
external EIS server.
Default is 5 seconds.

External EIS mode 
only

EIS Test Interval Specifies the interval (in seconds) in which the 
EIS test timeout will occur. 
Default is 20 seconds.

External EIS mode 
only

ECM Test Timeout Specifies the testing timeout (in seconds) for the 
Entitlement Control Message Generator (ECMG).
Default is 5 seconds.

Common to both

ECM Test Interval Specifies the interval (in seconds) in which the 
ECMG test timeout will occur. 
Default is 20 seconds.

Common to both

EMM Test Timeout Specifies the testing timeout (in seconds) for the 
Entitlement Management Message Generator 
(EMMG).
Default is 5 seconds.

Common to both

EMM Test Interval Specifies the interval (in seconds) in which the 
EMMG test timeout will occur. 
Default is 20 seconds.

Common to both

EMMG TCP Control Port 
Number

Specifies the TCP control port number for the 
EMMG.
Default is 0; valid range is 1 to 65535.

Common to both

EMMG Data Port Number Specifies the UDP number for the EMMG.
Default is 0; valid range is 1 to 65535.

Common to both

Table 94. DVB-CA Global Configuration fields  (Continued)

Field Description
Internal EIS mode or 
External EIS mode
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Configuring DVB-CA: External and Internal EIS Mode
Use steps in this section to configure DVB-CA for external and internal EIS modes. For internal EIS 
mode, please include the additional steps provided in “Configuring DVB-CA for Internal EIS Mode” on 
page 230 to complete that configuration.

The tasks for this configuration are provided in the following topics:

• “Step 1, Create CA System” on page 223.
• “Step 2, Create ECMG” on page 223.
• “Step 3, Create EMMG” on page 225.
• “Step 4, Create EMM” on page 225.
• “Step 5, Join TS to EMM” on page 226.
• “Step 6, Verify Scrambling” on page 228.

EMM Multicast IP Specifies the multicast IP address on which 
Ethernet Port 2 will receive EMM packets. 
• Enter a valid multicast IP address in this field to 

enable Ethernet Port 2 for receiving EMM 
packets.

• Enter all 0’s (or leave field at the default of all 
0’s) to not send EMM traffic via Ethernet Port 2.

Common to both

Update Timer (secs) Specifies the amount of time (in seconds) before 
the BNP should begin to transmit video services 
in order to allow for encryption processing.
• Default is 0.
• The higher the number, the longer it will take 

the end user to receive a video signal. If the 
number is too low, programming will be 
transmitted in the clear until the encryption 
engine takes over. The recommendation is to 
choose a number that will be an acceptable 
level of delay for the end user while still 
providing the minimum amount of clear data 
transmission.

Common to both

Table 94. DVB-CA Global Configuration fields  (Continued)

Field Description
Internal EIS mode or 
External EIS mode
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Step 1 Create CA System
1. From the main Element Manager menu tabs, click the DVB-CA tab to view the CA System and SCG 

subtabs.
2. Click the CA System subtab. 

Note that if no CA System has been configured, the “+” expansion symbol is not displayed 
alongside the folder (as demonstrated in Figure 160). 

Figure 160. DVB-CA tab

The absence of an “+” here indicates that no CA Systems are currently configured.
The absence of an “+” here indicates that no CA Systems are currently configured.

3. Right-click the CA Systems folder and select Create CA 
System from the pop-up menu. 
The Create CA System dialog is now in view. �

4. Use the Create CA System dialog to set parameters for the 
CA System:

- In the CAS Name field, type a name for this CAS. This 
name should be unique across the chassis.

- In the CAS ID field, enter the ID number as provided by 
the CAS.

- Click Apply to save the displayed settings and to dismiss 
this dialog. �

5. At the CA System tab page, check to ensure that the new CAS 
is added to the CA Systems list.

Step 2 Create ECMG 
1. Expand the CA Systems list using either of two methods:

- Click the “+” icon next to the name of the CAS you just 
created�
or 

- Double-click on the name of the CAS.�
�

2. Under the CAS Name: list, right-click on the ECMG List folder 
and select Create ECMG from the pop-up menu:
The Create ECMG dialog is now in view. 
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3. Use the Create ECMG dialog to set parameters for the ECMG. 
Parameter descriptions are provided in Table 95 (below).�
�
�
�

4. Click Apply to save the displayed settings, exit this dialog, and 
create the ECMG.�
�
�
�

5. Check the CA System tab page to ensure that the new ECMG is 
now displayed in the list. 

�

Table 95. Create ECMG parameters

Field Description Info Provided by:
CAS Name Specifies the name of the CAS created in the CA Systems 

subtab. This field is read-only.
CAS

CAS ID Specifies the CAS ID number created in the CA Systems 
subtab. This field is read-only.

CAS

Sub CAS ID Enter the Sub CAS ID for this ECMG.
• Valid range is 0 to 65535; enter 0 if this field is to be ignored.
• This field is optional.

CAS

ECMG IP Address Enter the IP address of the ECMG CAS

ECMG Port Enter the UDP number of the ECMG CAS

Channel Start Offset Specifies the first channel for the ECMG.
• This field is optional.
• Valid range is any integer.
• Default is 0.

CAS

Channel Count Specifies the total number of channels this ECMG is currently 
maintaining.
• This field is optional.
• Valid range is any integer.
• Default is 10.

CAS

Second CAS ID Enter the second CAS ID (if provided with one) from the CAS.
Range is 0 to 65535; enter 0 if not using a second CAS ID.
• This field is optional.

CAS
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Step 3 Create EMMG
Up to four EMMGs may be created for a CAS. 

1. Under the CAS Name folder, right-click on the EMMG List 
folder and select Create EMMG from the pop-up menu:
�
The Create EMMG dialog is now in view.�
�

2. Use the Create EMMG dialog to define the client ID. At the 
Client ID: field, enter the Client ID number in decimal 
format.

Note: If this value is being provided by the CAS, you will most 
likely receive this number in hexadecimal format. If so, 
you will need to convert the format from hex to decimal in 
order for this value to properly populate the field. 

3. Click Apply to save the displayed settings, exit this dialog, 
and create the EMMG.�

4. Check the CA System tab page to ensure that the new 
EMMG is now displayed in the list.

Step 4 Create EMM
1. Under the CAS Name folder, right-click on the Client ID 

folder and select Create EMM from the pop-up menu.�

The Create EMM dialog is now in view.�

2. Use the Create EMM dialog to set parameters for this EMM. �
�
Table 96 provides parameter descriptions for this 
configuration. 

3. Click Apply to save the displayed settings, exit this dialog, 
and create the EMM.

4. At the CA System tab page, check to ensure that the new 
EMM is added under the Client ID folder. 
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:

Table 96. Create EMM parameters

Field Description Provided by:
Client ID Displays the value created in the Create EMMG dialog.

This value is read-only.
CAS

Data ID Specifies the unique identification of an EMM / private data 
stream of a Client ID.
Range is 0 to 65535

CAS

Private Data Enter additional data into the CA descriptor in the PMT. 
• For a service, add private data into the program level’s CA 

descriptor.
• For an ES, add private data into the ES level’s CA 

descriptor.
• Default is blank.
• Format must be hex.

CAS

Second CAS ID Enter the second CAS ID (if provided with one) from the CAS 
vendor.
Range is 0 to 65535; enter 0 if not using a second CAS ID.

CAS (optionally)

Max Bandwidth (kbps) Enter the maximum bandwidth that will be allocated by the 
MUX.

CAS

Step 5 Join TS to EMM
1. Under the EMMG List, expand the Client ID folder and right-click on an EMM to select Join/

Disjoin TS to EMM from the popup menu. 
The Join/Disjoin TS to EMM screen is now in view.
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2. From the right side of the window, expand the GigE or ASI port in which you created the original 
DVB TS (See “Creating Output DVB TS(s) for DVB-CA System” on page 213.)

3. Highlight the TS and click the left arrow button (<<) next to the port list. 

4. The TS is now added to the left side of the window with a PID value of 0 (Figure 161), which you will 
need to change.

Figure 161. Join/Disjoin TS - TS added to EMM - No PID

5. Edit the PID value:

- Click on the TS displayed in the left panel of the window to activate the PID: field at the 
bottom of the screen. 

- At the PID: field, type a PID value for this TS. The PID value may be any valid PID�
or�
Leave the PID value as 0 to automatically generate a default PID for the entry.

Figure 162. Join/Disjoin TS - PID entry

PID not yet modified

6. Tap the <Enter> key to set the specified value into the Pid column at the top of the window (as 
demonstrated in Figure 163.
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Figure 163. Join/Disjoin TS - PID modified

PID modified

7. Click Apply to complete the process of joining the TS to the EMM.
8. At the Grooming -> Mapping tab page, anew EMM program is now displayed under the TS to 

which the EMM was joined.

Figure 164. EMM Program joined to TS

EMM Program added 
to TS after TS is joined 

CAT added to TS after 
TS is joined to EMM

Step 6 Verify Scrambling
The best way to verify scrambling is to confirm encrypted streams through the use of an analyzer. 
However, the following methods from the Element Manager may also be useful:

• “Verification via the Channel View,” next.
• “Verification via the Service List” on page 229.

Verification via the Channel View

You can view the channel information being received on the BNP by selecting the following menu path 
from the DVB-CA tab:

     CA System -> CAS Name -> ECMG List -> Sub CAS ID -> Channel.



SelenioTM BNP  User Guide, Release 3.7.1 229

DVB Conditional Access - DVB-CA Configuration

If scrambling is occurring, the stream IDs for each program will display “connected” status (Figure 165).

Figure 165. Stream IDs connected

Verification via the Service List

Depending on the configuration of the DVB-CA system, you may be able to view the elementary 
stream(s) joined to the SCG in the Service List folder under the SCG tab. To use this method, select the 
following menu path (as shown in Figure 166) from the DVB-CA tab: 

     SCG -> SCG Group -> SCG -> Service List -> ES Type

Figure 166. SCG List - ESs Scrambled

This completes the DVB-CA configuration process in external EIS mode. See the next section, 
“Configuring DVB-CA for Internal EIS Mode” for the additional steps required for configuration of an 
internal CAS.
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Configuring DVB-CA for Internal EIS Mode
This section contains the configuration requirements necessary when setting up a DVB-CA system that 
uses the BNP’s internal EIS. Use these steps in addition to those described for “Configuring DVB-CA: 
External and Internal EIS Mode” on page 222

The tasks for this configuration are provided in the following topics:

• “Step 1, Create Access Criteria List” on page 230.
• “Step 2, Create SCG” on page 231.
• “Step 3, Create ECM” on page 233.
• “Step 4, Join Program and ES to the SCG” on page 234.
• “Step 5, Verify Scrambling” on page 234.

Step 1 Create Access Criteria List

An Access Criteria List is CA system-specific information needed by the ECMG to build an ECM, which is 
required only for internal EIS mode configuration.

1. From the CA System tab page, navigate to CAS Name -> Access Criteria List.
2. Right-click on the Access Criteria List folder and select 

Create Access Criteria from the pop-up menu.
The Create Access Criteria dialog is now in view and 
displays read-only CAS Name and CAS ID fields, which are 
based on the information already configured (see also 
Create CA System section on page 223), 

3. Use the Create Access Criteria dialog to configure the 
following parameters:

- AC Name field—type an alphanumeric string to define a 
name that is unique to the chassis.

- AC Data field—enter the hexadecimal number, as 
provided by the CAS.

The AC Data entry is a hex number provided by the CAS, 
formatted as follows:
      [vendor #] [Unique TS ID] [ECM PID]
For example:
      0b04 0003 0bc6

4. Click Apply to create the Access Criteria List.

Viewing the total count of Conditional Access systems
1. From the DVB-CA menu click on the CA Systems tab.
2. Expand the CA Systems folder to display a list of CA Systems.
3. Highlight the Access Criteria List folder to view the TOTAL ACs pop-up (Figure 167).



SelenioTM BNP  User Guide, Release 3.7.1 231

DVB Conditional Access - DVB-CA Configuration

Figure 167. Access Criteria List - Show Total ACs

Step 2 Create SCG
The conventions described in Table 97 are applicable for creation of an SCG, as based on whether the 
DVB-CA system uses an external or internal EIS server. 

Table 97. EIS Servers and SCG Creation

EIS Server Type SCG Creation
External An SCG is automatically created for every program to be encrypted. In this case, you 

can only display the SCG for external EIS mode. You cannot create the SCG for 
external EIS mode.

Internal An SCG must be manually created. An SCG must be created for every program 
to be encrypted.

Repeat the following steps for every program to be encrypted.

1. From the SCG tab page, right-click on the SCG Group 
folder and select Create SCG from the pop-up menu.
The Create SCG dialog is now in view. �

2. Use the Create SCG dialog to define parameters for 
the SCG to be included in the selected group. 
Use guidelines from Table 98 (below) with this dialog. �

3. Click Apply to save the settings displayed in this 
dialog, dismiss this dialog, and to create the SCG

4. At the SCG tab page, check to ensure that the new 
SCG is listed in the expanded SCG Group. 

.

Table 98. Create SCG dialog - Internal EIS mode parameters 

Field Description
SCG ID Specify a unique number that will identify an SCG within the system.

Range is 1 to 65534; default is blank.

Transport Stream Use the Select TS button to select the TS under which the desired 
programs are to be encrypted.
This TS must be a DVB TS. 
See “Creating Output DVB TS(s) for DVB-CA System” on page 213.
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Monitoring SCG
Use the Monitor SCG dialog to view a Basic or Extension display of CP counters. 

1. From the DVB-CA tab page, click on the SCG tab.
2. Right-click on a selected SCG and select Monitor SCG from the popup menu.

The Monitor SCG dialog is now in view. 
3. At the View Type: field, use the pull-down menu to choose the Basic or Extension view 

(Figure 168).

Figure 168. Monitor SCG dialog

• The Basic view displays data between the SCS and the MUX. 
• The Extension view additionally displays counters that are collected between the SCS and the 

ECMG. 

CP Duration (100ms) Specify the Crypto Period for this SCG. Specifies the default crypto period 
for the BNP chassis in 100 millisecond increments.
• Check the Use global config box to follow the default parameter as 

specified in the DVB-CA Global Configuration fields table.
• Un-check the Use global config box to specify a different Crypto Period 

for the SCG. 
• Default is set to Use global config.

Scramble Level Specifies the default scramble level used to configure the scrambler for 
this SCG.
• TS is currently the only option.
• This field is read-only.
• Use global config box is read-only and defaulted to checked.

Disable Checking this button will disable all scrambling on the SCG, changing all 
scrambled programs to clear.
• Default is unchecked.

Table 98. Create SCG dialog - Internal EIS mode parameters (Continued)

Field Description
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Step 3 Create ECM
The conventions described in Table 99 are applicable for creation of an ECM, as based on whether the 
DVB-CA system uses an external or internal EIS server. 

Table 99. EIS Servers and ECM Creation

EIS Server Type ECM Creation
External The ECM must be created manually.
Internal An ECM is automatically created for each SCG.

1. From the SCG tab, expand the SCG Group and navigate 
to the ECM Groups folder.�

2. Right-click on the ECM Groups folder and select Create 
ECM from the pop-up menu.
The Create ECM dialog is now in view.

3. Use the Create ECM dialog to set parameters for the 
ECM to be included in the specified group. 
Use guidelines from Table 100 (below) with this dialog. �

4. Click Apply to use the displayed settings, dismiss this 
dialog and to create the ECM.�

5. At the SCG tab page, check to ensure that the new ECM 
is listed in the expanded ECM folder.

.

Table 100. Create ECM dialog

Field Description
ECM ID Enter a unique PID (allocated by the MSO) to identify the ECM stream for a Super 

CAS ID. The combination of the Super CAS ID and the ECM ID uniquely identifies 
the ECM stream in the system as a whole.
• Default is blank
• Valid range is up to a 10-digit number and must be equal to or greater than 0.

CAS ID Select the CAS ID from the drop-down box. This value should have been provided 
by the CAS and configured in the CA System tab.

Sub CAS ID Select the Sub CAS ID from the drop-down box. This value should have been 
provided by the CAS and configured in the CA System tab.

Private Data Enter additional data into the CA descriptor in the PMT. 
• For a service, add private data into the program level’s CA descriptor.
• For an ES, add private data into the ES level’s CA descriptor.
• Default is blank.
• Format must be hex.

Access Criteria Select the name of the Access Criteria from the drop-down menu created from the 
Access Criteria List menu. 

PID Enter the PID to use for the ECM.
• Default is blank.
• Valid range is 52 to 8175.
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Step 4 Join Program and ES to the SCG
The conventions described in Table 101 are applicable for joining elementary streams or programs, as 
based on whether the DVB-CA system uses an external or internal EIS server. 

Table 101. EIS Servers and Joining

EIS Server Type Description
External Each elementary stream or program must be joined to the SCG.
Internal The elementary stream(s) or program are automatically joined to an SCG. 

1. From the SCG tab, expand the SCG Group and navigate 
to the Service Lists folder.

2. Right-click on the Service Lists folder and select Join 
Program and ES from the pop-up menu.
The Select service list and ES list Objects dialog is 
now in view. This screen displays the list of programs 
available for this TS. The associated streams are 
contained in the program folder. 
Programs that are not available are displayed as gray 
text. 

3. Use the Select service list and ES list Objects screen to 
select the program to be encrypted.
To select a stream to be encrypted, expand the program 
folder and select one of its streams. 

4. Click Apply to join the program or ES to the SCG.

Step 5 Verify Scrambling
To verify if programs are being scrambled, use steps provided in “Verify Scrambling” on page 228.
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DVB-CA Best Practices and Considerations
The following guidelines should be taken into consideration when setting up a DVB-CA system:

• In a BNP redundancy configuration only the primary BNP is connected to the EIS, ECMG, and 
EMMG servers.

• During switchover the old primary (now standby) disconnects to CA servers and the new primary 
reconnects to them.

• The Update Timer is used to avoid sending clear streams during boot up & switchover because the 
boot up time and CAS reconnection time vary from configuration to configuration.

• It is recommended that Ethernet Port 2 be connected downstream of an IP switch such that 
multicast traffic does not spill onto the CAS network and flood the EMM and ECM traffic.

• The BNP can optionally be configured to receive EMM traffic via a multicast socket on Ethernet 
Port 2. 

• Virtual IP configuration for Ethernet Port 2 must be configured when using 1:1 chassis redundancy; 
this virtual IP address must be used by CA servers (external EIS and ECMG configuration).
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CHAPTER 10

ETV Binary Interchange Format 

This chapter describes how the Selenio™ BNP can be configured to process Enhanced Television (ETV) 
Binary Interchange Format (EBIF) content for delivery of interactive data in the video processing 
network. 

Applicable Platforms: The information in this chapter can be used with any BNP device. 

In This Chapter:
• “Overview,” next.
• “Functionality” on page 237.
• “Prerequisite Reading” on page 236.
• “Use Case Configuration Examples” on page 237.

Overview
The CableLabs EBIF standard provides a solution for the delivery of interactive data to existing set-top 
boxes (STBs), including older models of STBs. EBIF condenses interactive applications in order to use 
the minimal STB resources available for interactive data delivery. Since ETV can make use of scant 
resources, the MSO has the ability to deliver interactive broadcasts and advertisements to the widest 
possible audience, including the STB user who still relies on legacy hardware. Because ETV applications 
are very compact and can be downloaded to the STB rapidly, the ETV format is particularly suitable for 
authoring interactive commercials.

Prerequisite Reading
To better understand the Use Cases described in this chapter, you should familiarize yourself with the 
concepts and steps described in Chapter 6, “Grooming and PSIP.” In particular, the following sections 
will be useful:

• “Viewing ES-Level Input Source” on page 109.
• “Programs and Elementary Streams” on page 106.
• “Creating Programs” on page 130.
• “Drag and Drop Grooming” on page 140.
• “Managing Elementary Streams” on page 156.
• “Managing PMT and ES Descriptors” on page 177.
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Functionality
ETV is interpreted by a User Agent: a software application that runs on the set-top box that is installed 
remotely by the MSO. 

When ETV is downloaded to the STB, it uses a pairing of data elementary streams, which consist of the 
following: 

• ETV Binary Interchange Format (EBIF) data ES — carries the application data.
• ETV Integrated Signaling Stream (EISS) data ES — carries timing signals that trigger events 

associated with the application.

ETV applications are typically “bound” (or Pre-bound) to particular pieces of content, and packaged in 
a program together with video and audio while being broadcast to the STB. This content can be a 30-
second ad or a network stream (a dedicated channel or program with EBIF content coded into it). 
Another possible source of ETV data is a local EBIF streamer: a server that provides pre-packaged EBIF 
content, allowing the BNP to enhance a video or audio program (network stream or ad) with additional 
ETV data. The process of adding EBIF enhancement to an existing network stream or ad is referred to as 
Late-binding.

Figure 169 shows the basic ETV data source flow.

Figure 169. ETV EBIF Data Source flow
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Use Case Configuration Examples
The BNP can groom, splice or filter ETV data streams, including, but not limited to, the Use Case 
examples listed below: 

1. Pre-Bound Ad Splice.
2. Pre-Bound EBIF Passthrough (no DPI).
3. Pre-Bound EBIF Drop.
4. Pre-Bound EBIF Passthrough and Keep During Ad Splice.
5. Pre-Bound Network EBIF; Late-Bind EBIF During Ad.
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Note: In all of the following Use Cases (except as specified as “Non-DPI”) it is assumed that the BNP is 
configured for DPI. See Chapter 8, “Digital Program Insertion (DPI)” for details on configuring 
DPI.

Pre-Bound Ad Splice

In pre-bound ad splicing, the input network (or program) stream does not contain ETV data; rather, an 
ad containing ETV data ESs is spliced in later. In this case, the BNP would be configured to play the ad’s 
ETV streams on the output during the ad splice.

Figure 170 shows an example of pre-bound ad splice.

Figure 170. Pre-bound Ad Splice flow
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Configuration Steps:
To configure pre-bound ad splice:

1. From the BNP Element Manager, click on the Grooming -> Mapping tab.
2. Create an output transport stream, if necessary. (See the section that begins with, “Managing 

Output Transport Streams” on page 113 for additional information.)
3. Use the Drag and Drop Grooming feature to groom a desired input program to the desired output 

transport stream (oTS), as seen in Figure 171, for example.

Note: In this use case, the input program does not contain any ETV elementary streams.
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Figure 171. Input program (without ETV data) groomed to oTS

The Configure Program Mapping window will open.
4. In the ETV Configuration section, the PIDs Priority setting should remain at the default of Ad. 
5. In the Component PIDs section under Placeholder ETV ESs, select the appropriate type of EBIF 

and EISS elementary stream placeholders from the drop down box. The type of ESs selected here 
should match those of the ETV ESs in the ad.

6. If necessary, change the PID values of the EISS and EBIF ESs by clicking the blue space under the 
Output Type or PID columns next to the appropriate input ES. 
Figure 172 shows the Configure Program Mapping window with the above options filled in.

Figure 172. Configure Program Mapping window - EBIF/EISS Placeholder

7. Click OK.
The Grooming -> Mapping window will now show the groomed program with two Data EBIF/EISS 
ESs grayed out.



SelenioTM BNP  User Guide, Release 3.7.1 240

ETV Binary Interchange Format - Use Case Configuration Examples

Figure 173. Program with placeholders groomed - ESs grayed out

Note: When creating Placeholder ETV ESs, two new descriptor rules with default values will be created 
for each ES used as a placeholder. The Descriptor Data information in these rules may be edited, 
if necessary. In this case, there will be 4 new descriptor rules (2 for EISS and 2 for EBIF) that are 
created in the Manage Descriptor Rules window. 

To view the descriptor rules created with the placeholder ESs:

1. From the Outputs panel of the Grooming -> Mapping window, right-click on the program you 
just groomed and select Manage Descriptor Rules from the pop-up menu.
The Manage Descriptor Rules window will open, showing two descriptor rules for each ES 
placeholder:

Figure 174. Manage Descriptor Rules - EISS & EBIF additions

2. Click Cancel to close the Manage Descriptor Rules window.

Pre-Bound EBIF Passthrough (no DPI)
In pre-bound EBIF passthrough on a non-DPI program, the network stream contains the pre-bound 
ETV data streams, and the BNP is configured to play the input ETV streams on the output.
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Figure 175 shows an example of pre-bound EBIF passthrough.

Figure 175. Broadcast EBIF enabled
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Configuration Steps:
To configure pre-bound EBIF passthrough:

1. From the BNP Element Manager, click on the Grooming -> Mapping tab.
2. Create an output transport stream, if necessary. (See the section that begins with, “Managing 

Output Transport Streams” on page 113 for additional information.)
3. Use the Drag and Drop Grooming feature to groom a desired input program to the desired output 

transport stream (oTS), as seen in Figure 176, for example.

Note: In this use case, the input program does contain two ETV elementary streams.

Figure 176. Input program (with ETV data) groomed to TS
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The Configure Program Mapping window will open.

Figure 177. Configure Program Mapping - EBIF/EISS defaults

4. In the ETV Configuration section, leave the PIDs Priority set to the default of Ad. 
5. In the Component PIDs section, leave the EISS and EBIF ESs checked. You may change the PID 

values or leave them at their defaults. 
6. Click OK.

The Grooming -> Mapping window will now show the groomed program with the data EBIF/EISS 
ESs passed through to the output.

Figure 178. Program with ETV ESs passed through 
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Pre-Bound EBIF Drop
In pre-bound EBIF drop, the network stream contains pre-bound ETV data streams and the BNP is 
configured to not play (to drop) the network ETV streams on the output.

Figure 179 shows an example of pre-bound EBIF where the ETV streams are dropped.

Figure 179. Broadcast EBIF disabled

Configuration Steps:
To configure pre-bound EBIF to be dropped:

1. From the BNP Element Manager, click on the Grooming -> Mapping tab.
2. Create an output transport stream, if necessary. (See the section that begins with, “Managing 

Output Transport Streams” on page 113 for additional information.)
3. Use the Drag and Drop Grooming feature to groom a desired input program to the desired output 

transport stream (oTS), as seen in Figure 176, “Input program (with ETV data) groomed to TS,” on 
page 241, for example.

Note: In this use case, the input program does contain two ETV elementary streams.

The Configure Program Mapping window will open.
4. In the ETV Configuration section, leave the PIDs Priority set to the default of Ad. 
5. In the Component PIDs section, un-check the EISS and EBIF ESs. 

The Configure Program Mapping window will look similar to Figure 180.
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Figure 180. Configure Program Mapping - EBIF/EISS unchecked 

6. Click OK.
The Grooming -> Mapping window will now show the groomed program with the data EBIF/EISS 
ESs dropped from the output.

Figure 181. Program with ETV ESs dropped

Pre-Bound EBIF Passthrough and Keep During Ad Splice
In this example, the network stream contains pre-bound ETV data streams and the ads are un-
enhanced. When the network stream is groomed to the output the BNP is configured to continue 
playing (keep) the network ETV streams during ad splices.

Figure 182 shows an example of broadcast EBIF groomed as Splice/Keep. 
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Figure 182. Broadcast EBIF groomed as Splice/Keep
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Configuration Steps:
To configure pre-bound EBIF to play through and be kept during an ad splice, proceed as follows:

1. From the BNP Element Manager, click on the Grooming -> Mapping tab.
2. Create an output transport stream, if necessary. (See the section that begins with, “Managing 

Output Transport Streams” on page 113 for additional information.)
3. Use the Drag and Drop Grooming feature to groom a desired input program to the desired output 

transport stream (oTS), as seen in Figure 176, “Input program (with ETV data) groomed to TS,” on 
page 241, for example.

Note: In this use case, the input program does contain two ETV elementary streams.

The Configure Program Mapping window will open.
4. In the ETV Configuration section, click on the PIDs Priority drop-down box and select Network.

When Network is selected in PIDs Priority, the Play Preference drop-down box will be displayed.
5. In the Play Preference drop-down box, leave the setting at the default of Play through ad.

The Configure Program Mapping window will look similar to Figure 183.
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Figure 183. Configure Program Mapping - Play through ad

6. Click OK.
The Grooming -> Mapping window will now show the groomed program with the data EBIF/EISS 
ESs passed through to the output.

Figure 184. Program with ETV ESs passed through (Splice/Keep)

To verify that the ETV ESs are configured for Play through ad, highlight the program and select 
Modify Program from the pop-up menu.

Pre-Bound Network EBIF; Late-Bind EBIF During Ad
In this example, the network stream contains pre-bound ETV data streams and a local streamer or 
another source (such as another input program) streams another pair of ETV ESs (late-bind source). The 
BNP is configured to play the network ETV streams when the network stream is played, then to switch 
to the late-bind source during the ad.

Figure 185 shows an example of pre-bound network EBIF and late-bind EBIF during an ad.
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Figure 185. Pre-bound Network EBIF, late-bind EBIF during ad
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Configuration Steps:
To configure a late-bound EBIF ad to play through a pre-bound program, proceed as follows:

1. From the BNP Element Manager, click on the Grooming -> Mapping tab.
2. Create an output transport stream, if necessary. (See the section that begins with, “Managing 

Output Transport Streams” on page 113 for additional information.)
3. Use the Drag and Drop Grooming feature to groom a desired input program to the desired output 

transport stream (oTS), as seen in Figure 186, for example.

Note: The input program should contain at least two ETV elementary streams and there should be an 
additional two ETV ESs available for the late-bound streams.
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Figure 186. Input program (with ETV data) groomed to TS; Late-bound

Additional 
ETV ESs to 
be used for 

The Configure Program Mapping window will open.
4. In the ETV Configuration section, click on the PIDs Priority drop-down box and select Network.

When Network is selected in PIDs Priority, the Play Preference drop-down box will be displayed.
5. In the Play Preference drop-down box and select the Play during ad only option.

The Configure Program Mapping window will look similar to Figure 187.

Note: The times displayed in the Alarms and Events table are quoted local to the time zone from the 
NPM server collocation which governs the Daylight Savings Time (DST) rules in effect and the 
specific time zone abbreviations. All system alarm (raised and cleared) times are displayed in the 
server time zone. The server time zone may be controlled from the client’s configuration screen. 

Figure 187. Configure Program Mapping - Play during ad only

Click the “...” to select 
a late-bind source

When the Play during ad only option is selected, the Late Bind Source field will be displayed.
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6. Click on the ellipses (. . .) on the right-hand side of the Late Bind Source field to open the Late-
Bind Source Dialog window.

Note: This window displays the Inputs panel of the Element Manager’s Grooming -> Mapping 
window.

Figure 188. Late-Bind Source Dialog window

7. In the Late-Bind Source Dialog window, drill down to the program level.
8. Select the desired program with ETV ESs that will be used to play during the ad; this is also called 

the late-bound ETV source.

Figure 189. Late-Bind Source selected

9. Click OK to return to the Configure Program Mapping window, which will look similar to 
Figure 190:
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Figure 190. Configure Program Mapping window - Late-bound selected

10. Click OK to complete the grooming process.
The Grooming -> Mapping window will now show the groomed program with the late-bound 
data EBIF/EISS ESs in the output.

Figure 191. Program with late-bound ETV ESs

To view which late-bound ETV source is configured for Play during ad only, highlight the program 
and select Modify Program from the pop-up menu.



SelenioTM BNP  User Guide, Release 3.7.1 251

ETV Binary Interchange Format - Use Case Configuration Examples

Figure 192. View Late-Bind Source in output program
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CHAPTER 11

Monitoring Alarms and Events

This chapter describes information about the system that you can monitor to ensure that the system is 
always healthy. The Alarms & Events tab provides system information and health status.

Applicable Platforms: The information in this chapter can be used with any BNP device. 

In This Chapter:
• “Selecting the Elements to View,”  next.
• “Viewing Alarms and Events” on page 252.
• “The Status Bar” on page 254.

Selecting the Elements to View
The upper portion of the Alarms & Events tab lets you define the information you want to see on the 
screen. You can select as many options as you choose. The information is cumulative. To sort alarms 
and events, click the table header. The BNP Element Manager re-sorts the information according to 
your selection.

Once you have selected the events to display, click Apply Filter to accept the changes and refresh the 
window.

Types of alarms and events that can be displayed include:

• All shows all alarms and events, regardless of severity
• Raised shows all alarms that have been raised, but not cleared
• Cleared shows all alarms that have been raised and cleared
• Critical shows only critical severity alarms; these are alarms that must be dealt with immediately
• Major shows major alarms; these are alarms that may not require immediate intervention but 

cannot be allowed to continue indefinitely
• Minor shows minor alarms that will not disrupt the system

Viewing Alarms and Events
After you have set the types of alarms to display, you can tab to Alarms & Events at any time to see the 
current state of the system. Figure 193 shows a typical alarms window.
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For each alarm, you see a description, status, severity, source, cleared time (if the alarm has been 
cleared), any comment, and the user who cleared the alarm.

Note: Only those alarms whose levels have been checked (Figure 193) will be displayed. The others will 
be hidden until checked.

Cleared events remain in the list for historical purposes.

Figure 193. Alarms & Events tab

Alarms and Events

The following alarms are available:

• Video underflow 
• PID missing
• Grooming failed

• Missing input-Missing PAT/PMT, this could be caused by: 
• A disconnected cable 
• A TS packet missing or lost 



SelenioTM BNP  User Guide, Release 3.7.1 254

Monitoring Alarms and Events - The Status Bar

• Input GigE not operational
• Cooling system failure
• Failure of ad insertion/splicing
• Postblack duration from ad server ignored or greater than four seconds

The four severity levels include info, minor, major, and critical.

The Status Bar
The status bar is visible regardless of the tab selected. This ensures that you can see if there are any 
critical alarms that need attention. The bottom portion of the window displays the IP address to which 
the BNP Element Manager is connected and the highest-priority current alert. The information is color-
coded. A green IP address section indicates that the connection is active.

For alarms, the color-coding is one of the following:

• Green indicates that the alert or event displayed is informational.
• Yellow indicates a situation that might need operator action.
• Pink indicates a major alarm requiring operator attention. 
• Red indicates a critical error has occurred and immediate operator intervention is needed.

Figure 194. The status bar
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Editing the DVB NIT Table

This appendix describes how to edit, make additions to, and delete items from the NIT table, one of the 
DVB tables. To understand the meaning and context of the various values in the table, consult one or 
both of the following documents:

• Digital broadcasting systems for television, sound and data services; Allocation of Service Information 
(SI) codes for Digital Video Broadcasting (DVB) systems, ETSI Technical Report, ETR 162, European 
Telecommunications Standards Institute, October 1995.

• Digital Video Broadcasting (DVB); Specification for Service Information (SI) in DVB systems, ETSI EN 
300 468 V1.5.1 (2003-05), European Telecommunications Standards Institute.

Applicable Platforms: The information in this chapter can be used with any BNP device. 

In This Appendix:
• “NIT Values Supported,” next.
• “Naming, Viewing, Deleting and Editing NIT Configuration Files” on page 257.
• “Suggestions for Editing the NIT Table” on page 268.

NIT Values Supported
Table 102 shows the NIT values Mandatory values are indicated with an asterisk (*).

Table 102. Values Supported 

NIT Section Value Name Default Range
nit_section network_id 100

Version_ Number 1

*current_next_indicator 1

Array of 
network_name:

*name my network 
name

Any name

Array of linkage: *Transport stream ID 1 Any value that fits in 16 bits

*original_network ID 129 Any value that fits in 16 bits

*service_id 16642 Any value that fits in 16 bits

*linkage_type 9 Any value that fits in 16 bits

Array of 
private_data_byte:

data private1 Array of bytes of hex integers (if type is 
8 or 9). Else it is char string
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Array of Freqency List *coding_type 2 0 (not defined), 1(Satellite), 2 (cable) 
and 3 (terrestrial)

*Center_frequency: 3300000 32 bit unsigned integers

*Private_data: private_data_1 32 bit unsigned integer (currently 
defined values are) 1 (SES), 2 
(BSKYB1), 3(BSKY2), 4(BSKY3) 
BE (BetaTechnik), 0x6000 (News 
DataCom), 0x6001(NDC1), 
0x6002(NDC2), 0x6003(NDC3) 
0x6004(NDC4), 0x6005(NDC5), 
0x6006(NDC6) 0x362275(Irdeto) 
0x4E544C(NTL) 0x532D41(SFA) 
0x44414E59(NEWS DATACOM), 
0x46524549(NEWS DATACOM) 
0x53415053 (SFA)

Array of Transport 
Stream

*transport stream id 769 Any value that fits in 16 bits

*original network id 1920 Any value that fits in 16 bits 

Array of service: id 16398 Any value that fits in 16 bits

type 1 1 to 0x10 and 0x80 to FE 1(digital 
television service)

*id 16403 Any value that fits in 16 bits

*type 1 1 to 0x10 and 0x80 to FE 1(digital 
television service)

Cable delivery 
system:

*frequency 6312500 Up to 8 digit (decimals) value in MHz

*FEC_Outer 2 4 bit integer 0,1, 2

*modulation 4 8 bit integer (00, 01, 02,03, 04 and 05)

symbol_rate 68750 7 digit (decimals) integer specifying 
symbols/second

*FEC_Inner 5 4 bit integer 0 (not defined),1 (1/2 conv 
code rate), 2(2/3), 3 (3/4), 4 (5/6), 5 (7/
8), 6 (8/9), F (no conv Coding

Satellite Delivery 
System

*frequency 1208400 up to 8 digits (decimal) value in GHz

orbital_position 970 up to 4 digit (decimal) value orbital 
position. A decimal occurs after the 
third character

west_east_flag 0 0 or 1 (0 indicates western, 1 indicates 
eastern)

polarization 1 0 (linear horizontal), 1 (linear vertical), 
2 (circular left) or 3 (circular right)

modulation 1 0 (not defined), 1 (QPSK), 2 (8 PSK) or 
3 (16 QAM)

symbol_rate 220000 7 digit value specifing mega symbol/
sec (decimal (imaginary) occurs after 
third digit)

FEC_Inner 3 4 bit integer 0 (not defined),1 (1/2 conv 
code rate),2 (2/3), 3 (3/4), 4 (5/6), 5 (7/
8), 6 (8/9), F(no conv Coding

Table 102. Values Supported (Continued)

NIT Section Value Name Default Range
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Naming, Viewing, Deleting and Editing NIT 
Configuration Files

Naming a Configuration File
An opening window with no files named is shown in Figure 195. The default configuration file is 
present.

Terrestrial Delivery 
System

centre_frequency 739000000 32 bit integer (expressed in multiple of 
10Hz)

bandwidth 0 0 (8 MHZ), 1 (7 MHZ) or 2 (6 MHZ) (3 
bit field)

constellation 2 0 (QPSK), 1 (16 QAM), 2 (64 QAM) (2 
bit field)

*hierarchy_information 0 0 (non hierarchical),1 (alpha = 1), 2 
(alpha = 2), 3 (alpha=4) (3 bit field)

code_rate-HP_stream 0 0 (1/2),1 (2/3), 2 (3/4), 3 (5/6), 4 (7/8) 
(3 bit field)

code_rate-LP_stream 0 0 (1/2), 1 (2/3), 2 (3/4), 3 (5/6), 4 (7/8) 
(3 bit field)

*guard_interval 3 0 (1/32), 1 (1/16), 2 (1/8) or 3 (1/4) (2 
bit field)

transmission_mode 1 0 (2k mode) or 1 (8k mode) (2 bit field)

*other_frequency_flag 1 0 (no other frequency in use) or 1 
(more than one frequency in use)

Array of Private Data data 1 32 bit unsigned integer (currently 
defined values are) 1 (SES), 2 
(BSKYB1), 3 (BSKY2), 4 (BSKY3) BE 
(BetaTechnik), 0x6000 (News 
DataCom), 0x6001 (NDC1), 0x6002 
(NDC2), 0x6003 (NDC3) 0x6004 
(NDC4), 0x6005 (NDC5), 0x6006 
(NDC6) 0x362275 (Irdeto) 0x4E544C 
(NTL) 0x532D41 (SFA) 0x44414E59 
(NEWS DATACOM), 0x46524549 
(NEWS DATACOM) 0x53415053 
(SFA)

Array of Frequency 
List

coding_type 2 0 (not defined),1 (Satellite),2 (cable) 
and 3 (terrestrial)

Center_Frequency 1300000

Table 102. Values Supported (Continued)

NIT Section Value Name Default Range
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Figure 195. Window With No Arrays

To name a configuration file:

1. Click Edit. The default configuration file appears (Figure 196).

Figure 196. Default Array

2. Now enter a name for the file in the Name space, in this case Array2.
3. Click Apply. 
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The configuration file is named as Array2. (Figure 197).

Figure 197. Array2 Added

Viewing a Configuration File
You can view an configuration file in XML format. 

1. In Figure 197, choose View NIT in XML Format. A window similar to Figure 198 appears.

Figure 198. NIT Configuration File Viewed in XML Format

2. Navigate to where the arrays are stored and click Open. The window of Figure 199 appears.
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Figure 199. Assigning a Name to a Configuration File

3. Assign the name you want to the Array. In this example, we chose Array2.

Deleting a Configuration File
1. To delete an array, highlight the array to be deleted in Figure 197.
2. Click Delete.
3. The delete confirmation box appears (Figure 200).

Figure 200. Delete Confirmation

4. Click Yes if you want to delete the configuration file

The Array is deleted.

Editing a Configuration File
1. Highlight the configuration file you want to edit (Figure 201).
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Figure 201. Setup Network Information Table screen

2. Click Edit. The window of Figure 202 appears.

Figure 202. Editing Window

Icon Menu

Figure 203 shows the icons appearing at the top of the window.
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Figure 203. Icon Menu

Insert Node Before

Insert Node After

Remove Node

Move Node Up

Move Node Down
Open Namespace Qualifier Window

Find Invalid Node

Search

XML Editor XML Viewer

Figure 204 shows the Namespace Qualifiers window, obtained when you click the Namespace Qualifier 
icon.
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Figure 204. Namespace Qualifier Window

Figure 205 shows the Search window, obtained when you click the Search icon.

Figure 205. Search Window

Expanding the NIT Edit Window

The vertical bars shown in the window of Figure 202, “Editing Window,” on page 261 are used to toggle 
between an expanded and reduced view. through show three layers of expansion. Clicking the large 
vertical bar compresses the display as shown in Figure 206.
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Figure 206. Large Vertical Bar Clicked Fully Compress

Figure 207 shows the first level of expansion from Figure 202, “Editing Window,” on page 261, obtained 
by clicking all of the small bars to the right of the large bar.

Figure 207. First Level of Expansion

Clicking all of the smaller bars in Figure 207 creates the second level of expansion shown in Figure 208.
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Figure 208. Second Level of Expansion

Clicking the smaller bars in Figure 208 creates the third level of expansion shown in Figure 209.

Figure 209. Third Level of Expansion
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Inserting a Node

To insert a node, select the node and click Insert Node Before (Figure 210).

Figure 210. Inserting a Node Before

Figure 211 shows the result.

Figure 211. Node Inserted Before

In the node that was added, we attempted to change the value of the transport stream to an alpha 
value, ‘a.” An error message resulted (Figure 212).
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Figure 212. Error Message from Wrong Type of Data Character

Using the proper data types we changed the values so they are different from the original (Figure 213).

Figure 213. Data Type Mismatch Corrected

Deleting a Node

You can delete a node. In the example, highlight the linkage to be deleted and click Remove Node. The 
node is deleted (Figure 214).
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Figure 214. Linkage Deleted

Suggestions for Editing the NIT Table
The following are some suggestions that may prove helpful in editing the NIT table:

• In editing fields, go to the next tab to apply.
• When adding new nodes or fields, it is easiest to right click on the node to be added, then choose 

Insert.
• Uncheck optional fields if they are not needed.
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This glossary defines the acronyms common in the video industry, and used in this guide. It is not all-
inclusive but serves as a reference.

Numeric

3DES Triple Data Encryption Standard. A mode of DES that encrypts data three times. Three 
64-bit keys are used, for an overall key length of 192 bits.

A

AES Advanced Encryption Standard. AES is a privacy transform for IPSec and Internet Key 
Exchange, and is replacing the Data Encryption Standard (DES). AES offers a larger key 
size and a variable key length.

Alpha Channel In reference to editing image files, an alpha channel stores selections as grayscale 
images. Adding alpha channels to an image allows the creation and storing of masks 
in order to manipulate or protect parts of an image.

ARP Address Resolution Protocol. ARP broadcasts a packet containing the IP address that 
the sender specifies to all hosts attached to an Ethernet connection. When the target 
recognizes that the IP address is its own, it returns a response. 

ASI Asynchronous Serial Interface. ASI extends the functionality from strictly a video/
audio-bounded device to a transport stream-based system that can store data in 
either a single program stream or a set of multiple program streams.

ATSC Advanced Television Systems Committee. ATSC is working to coordinate television 
standards among different communications media. ATSC is also developing digital 
television implementation strategies. 

C

CA Conditional Access. Conditional access is an encryption/decryption management 
method by which a broadcaster controls a subscriber's access to services. 

CAS Conditional Access Systems. These are systems that ensure broadcast service is 
accessible only to those entitled to access, usually by scrambling or encrypting the 
service.

CBR Constant Bit Rate. Constant bit rate encoding ensures that the rate at which a codec's 
output is consumed is constant. Because it is the maximum bitrate that matters, CBR is 
useful for streaming multimedia content on limited capacity channels. See also VBR.

CSA Common Scrambling Algorithm. 
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D

DCCT Direct Channel Change Table, part of 9 tables in the ATCS PSIP. The DCCT instructs the 
receiver to change channels based on viewer preferences, demographics or 
geographical location. This table works with a DCCSDT in the set top box. 

DCCSDT DCC Selected Code Change Table, part of 9 tables in the ATCS PSIP.
DES Data Encryption Standard. DES specifies a FIPS approved cryptographic algorithm as 

required by FIPS 140-1. Encrypting data converts it to an unintelligible form called 
cipher. The cryptographic security of the data depends on the security provided for the 
key used to encipher and decipher the data. Data can be recovered from cipher only by 
using exactly the same key used to encipher it.

DET Data Event Table, part of 9 tables in the ATCS PSIP. The DET announces the data portion 
of a video/audio/data event when the data event does not match the exact duration of 
an video/audio event.

DHCP Dynamic Host Configuration Protocol. DHCP servers let individual computers on an IP 
network extract their configurations. DHCP servers have no specific information about 
the individual computers until they request the information.

DOCSIS Data Over Cable Service Interface Specifications. Now known as CableLabs Certified 
Cable Modems. DOCSIS specifies modulation schemes and the protocol for 
exchanging bidirectional signals over cable. 

DPI Digital Program Insertion. The digital splicing of one MPEG program (typically a 
commercial) into another based on digital cues within the MPEG transport stream.

DVB Digital Video Broadcast. A European set of defined transmission standards for digital 
broadcasting systems.

DWDM Dense Wavelength Division Multiplexing. A fiber-optic transmission technique using 
light wavelengths to transmit data parallel-by-bit or serial-by-character.

E

EAS Emergency Alert System. An operational structure for national and local emergency 
alerts used by broadcast, cable, and wireless cable.

EBIF Enhanced Binary Interchange Format. EBIF standard provides a solution for the delivery 
of interactive data to existing set-top boxes (STBs), including older models of STBs. EBIF 
condenses interactive applications in order to use the minimal STB resources available 
for interactive data delivery

ECM Entitlement Control Messages.
ECMG ECM Generator.
EISS ETV Integrated Signaling Stream data ES — carries timing signals that trigger events 

associated with the user-agent application loaded onto the STB.
EIT Event Information Table, part of 9 tables in the ATCS PSIP. EITs are associated with a 

specific virtual channel in the VCT, contain event information, and point to the location 
of extended text in the ETT. Each EIT PID contains 3 hours worth of events per program.

EM Element Manager. The graphical user interface for the BNP.
EMM Entitlement Management Message. A packet containing the information necessary to 

decrypt the picture.
EMMG Entitlement Management Message Generator. The component of the conditional 

access headend that delivers entitlements to the multiplexers. 
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F

FCC Federal Communications Commission. The agency that regulates communications 
services, including cable television, at the Federal level.

FPGA Field Programmable Gate Array. An array of logic gates that can be hardware-
programmed to fulfill user-specified task.

FVOD Free-Video-On-Demand.

G

GigE Gigabit Ethernet. Ethernet which supports data transfer rates of 1 Gigabit (1,000 
megabits) per second.

GBP /GBP2 Gigabit Ethernet Processor module. 
GUI Graphical User Interface.

H

HD High Definition. High-resolution digital television combined with Dolby Digital 
surround sound (AC-3). 

HFC Hybrid Fiber/Coax. A distribution system combining fiber and coax cable. An HFC 
system is used to distribute CATV signals into a neighborhood. 

I

IGMP Internet Group Management Protocol. IP hosts use IGMP to register dynamic multicast 
group membership. Connected routers discover the group members using the same 
protocol.

IP Internet Protocol. The network layer for the TCP/IP Protocol Suite. It is a 
connectionless, best-effort packet switching protocol.

ITU International Telecommunication Union. An international organization through which 
governments and the private sector coordinate global telecommunications networks 
and devices.

J

JRE Java Runtime Environment. JRE is made up of the Java virtual machine, the Java 
platform core classes, and supporting files.

EOD Everything-On-Demand.
ES Elementary Stream, an individual audio, video, or data output stream that is 

transmitted in a program
ETT Extended Text Table, part of 9 tables in the ATCS PSIP. ETTs carry longer text messages 

than EITs for describing events and virtual channels. 
ETV Enhanced Television. 
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L

LED Light Emitting Diode. A semiconductor diode that emits light when current passes 
through it. LEDs are used as indicators.

M

MGT Master Guide Table, part of 9 tables in the ATCS PSIP. MGT provides program-
identification (PID) locations so a receiver can find the other tables, and informs the 
receiver of changes or table updates.

MIB Management Information Base. MIB defines the variables needed by the SNMP 
protocol to monitor and control elements in a network. 

MID Mid-plane.
MPEG Moving Pictures Experts Group. The standards group and the standard for 

compression and storage of motion video.
MPTS Multi-Program Transport Stream. A combined multiplex of video streams.
MUX Multiplexer. A device that both combines multiple data sources into a single data 

stream for transmission, and demultiplexes the single data stream into its composite 
forms.

N

NTP Network Time Protocol. A TCP protocol that assures accurate local time-keeping with 
reference to radio and atomic clocks, and can synchronize distributed clocks within 
milliseconds.

NTSC National Television System Committee. Committee that defined the current standard 
for analog color television in North America, as well as the name for the standard. The 
format is 525 lines in 4MHx of video bandwidth.

O

OOB Out-Of-Band.

P

PAT Program Association Table. A table ID that indicates the MPEG-2 SI packet type.
PCR Program Clock Reference.
PMT Program Map Table. A table ID that indicates the MPEG-2 SI packet type.
PNG Portable Network Graphics. PNG format is used for lossless compression and for 

display of images on the web. Unlike GIF, PNG supports 24-bit images and produces 
background transparency without jagged edges. PNG format supports RGB, Indexed 
Color, Grayscale, and Bitmap mode images without alpha channels. PNG preserves 
transparency in grayscale and RGB images.



SelenioTM BNP  User Guide, Release 3.7.1 273

Glossary - 

Q

QAM Quadrature Amplitude Modulation. This is the modulation technique used in systems 
carrying digital video.

QoS Quality of Service. Guarantees network bandwidth and availability for applications.

R

RF Radio Frequency. Television signals are modulated onto RF signals and are then 
demodulated by the television tuner.

RTP Real Time Protocol. RTP provides services such as payload type identification, 
sequence numbering, time-stamping, and delivery monitoring to real-time 
applications.

RU Rack Unit. A common increment of equipment space height. The height of 1 RU is 1.75 
inches. 

S

PSI Program Specific Information, as part of MPEG-2.
PSIP Program and System Information Protocol. PSIP is a collection of nine tables that allow 

the DTV transport stream to provide information about a station's services and 
programming. These nine tables include:

Master Guide Table (MGT)�
System Time Table (STT)�
Virtual Channel Table (VCT)�
Rating Region Table (RRT)�
Event Information Table (EIT)�
Extended Text Table (ETT)�
Data Event Table (DET)�
Directed Channel Change Table (DCCT)�
DCC Selected Code Change Table (DCCSDT)

SAP Secondary Audio Program. A way to provide a second audio channel within a TV 
broadcast channel. Commonly used for stereophonic sound or bilingual audio tracks.

SCTE Society of Cable Telecommunications Engineers. An organization that develops 
training for cable television installers and engineers and standards for the cable 
industry. 

SD Standard definition.
SFP Small Form Factor Pluggable. An optical interface that is used in network switches for 

Fibre Channel, Gigabit Ethernet and InfiniBand.
SNMP Simple Network Management Protocol. A protocol used to monitor and control 

network devices, and to manage configurations, statistics collection, performance, and 
security.

SPTS Single Program Transport Stream.
SSM Source Specific Multicast. A way to deliver multicast packets whereby only packets 

delivered to a receiver are those that have originated from a specific source IP address 
that has been requested by the receiver. 



SelenioTM BNP  User Guide, Release 3.7.1 274

Glossary - 

T

TFTP Trivial File Transfer Protocol. TFTP uses UDP and is often used by servers to boot 
diskless workstations, X-terminals, and routers.

TS Transport Stream, the result of multiplexed--or combined--audio, video, or other data 
content that is packaged and transmitted through the broadcast network.

TVCT A Terrestrial Virtual Channel Table is a mandatory PSIP table that lists all the virtual 
channels available in an ATSC transport stream, and optionally, virtual channels 
available in other ATSC transport streams.

U

UDP User Datagram Protocol. A connectionless protocol that runs on top of IP networks. 
UDP provides a direct way to send information over an IP network. It is used primarily 
for broadcasting messages over a network.

V

VBI Vertical Blanking Interval. A portion of a television signal that carries non-audio/video 
data, such as closed-caption text. 

VBR Variable Bit Rate. VBR streams vary in bandwidth over time.
VCT Virtual Channel Table, part of 9 tables in the ATCS PSIP. The VCT contains a list of all the 

channels that are or will be online, along with their channel name and number. This 
table contains the set of data that enables a receiver to tune and locate the service 
being broadcast. 

VOD Video-on-Demand. Video-on-demand systems allow users to watch video content 
over a network as part of an interactive television system, either by streaming or by 
download.

X

XFP 10 Gigabit Small Form Factor Pluggable (SFP). The XFP is a pluggable, hot-swappable 
optical interface for 10 Gigabit SONET/SDH, Fibre Channel, Gigabit Ethernet, and other 
applications. XFP modules are optical transceivers, typically 1310nm or 1550nm. 
Optical XFPs include digital diagnostics.

STP Strip Processor. The STP modules (NP and ASI) is one of the units that comprise the 
BNP.

STT System Table Time. Allows a broadcaster to present time indicators to the consumer, 
ensuring that the time is synchronized.

SVOD Subscription-Video-on-Demand. This is a Video-on-Demand service offered by 
subscription, providing viewers with access to select programs from the libraries of 
featured cable networks.
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A
AAA 49
AAA behaviors reference 51
AAA default IP 58
AAA default port 58
AAA default protocol 59
AC power

shutdown 197
access criteria 230, 233
Account level

administrator 54
operator 54
user 54

Account privileges 50
Ad Server 201
ad splicing 238
advanced messaging 16
advanced overlay license 191
Alarms 252

Viewing 252
alpha channel 79
alpha channels 16, 79
ASI 18
assumptions 11
audio streams 169
audio types 161
authentication, authorization and accounting (AAA) 49

B
Bitrates

Monitoring 182

C
CAS 207, 208, 223, 225, 230, 235
common scrambling algorithm 17, 207

CSA 207
conditional access system 207
crawl 16
CSA 17, 207
CVCT 121
CWG 17, 207

D
data streams 161, 169
DC power

shutdown 197
deleting 140

streams 140

Deleting Servers 60
descriptor rules 240
Digital Program Insertion (DPI) 200
document audience 11
document organization 11
DPI Based

Ad Splicing 15
DSCP

and upgrade or downgrade 118
parameter 117

DTV transport stream 122
DVB Transport Stream 123
DVB-CA 17, 207, 208, 210, 211, 215, 219, 220, 229, 230, 232, 

235
access criteria 230
CAS mode 220
create ECM

access criteria 233
CAS ID 233
PID 233
sub CAS ID 233

create ECMG
CAS ID 224
CAS name 224
channel count 224
channel start offset 224
ECMG IP address 224
port 224
second CAS ID 224
Sub CAS ID 224

create EMM
client ID 226
data ID 226
max bandwidth 226
second CAS ID 226

create SCG
CP duration 232
disable 232
scramble level 232
transport stream 231

createECM
private data 233

createECMG, CAS name 222
creating input TS 212
creating output TS 213
crypto period duration 220
CW mode 220
ECM ID 233
ECM test timeout 221
EIS test interval 221



SelenioTM BNP  User Guide 276

Release 3.7.1

EIS test timeout 221
EIT source 214
EMM multicast IP 222
EMM test interval 221
EMMG data port number 221
EMMG TCP control port number 221
external EIS port number 221
global parameters 219
license 208
modulation mode 214
network ID 214
private data 226
required components 208
SCG ID 231
scramble level 220
SDT source 214
TS type 214
unique TS ID 214
update timer 222

DVB-CA license 191

E
EAS 16

audio override 16
audio stream insertion 16
configuration 60

EBIF 236, 237, 239, 241, 242, 243, 244, 246, 270
late-bind 246
pre-bind 240, 243, 246
pre-bind, network 246
pre-bind, passthrough 240, 241
pre-bind, passthrough,keep 244
pre-bind. passthrough, keep 244

ECM 17, 207, 221, 233, 235
ECMG 17, 207, 208, 221, 223, 224, 235
Editing AAA Servers 58
EIS 17, 207, 208, 215, 220, 221, 222, 235
EISS 237, 239, 242, 243, 246
Element Manager 11, 36, 103, 185, 190, 208, 210, 219, 223, 

228, 238, 241, 243, 245, 247, 249
Element Monitor

reboot with 196
Element Stream 156
elementary stream 179
emergency alert system 16
EMM 17, 207, 221, 222, 225, 228, 235
EMMG 17, 207, 208, 221, 225, 226, 235
enhanced television (ETV) 236
enhanced television binary interchange format 

(EBIF) 236
entitlement control message generator 17, 207
entitlement management message generator 17, 207
ES 179
Ethernet control port 33, 43
ETV 236, 237, 246

configuration 242, 243, 245, 248
placeholder ES 240
pre-bind 246

ETV integrated signaling stream (EISS) 237
event information scheduler 17, 207
Events 252

Viewing 252

F
fast Ethernet 43
force re-allocation of TS 199
force redundancy 98
Force Sync 42, 43
FTP 187

G
GigE 18, 19, 20, 32, 44

IP address 45
Grooming 15, 140, 151
grooming 103

PSI/SI table 217
grooming license 191
grooming with DPI license 191

I
Input Source 108, 109
intended audience 11
IP Address 95
IPaddress

determining (with DHCP running) 44

J
Java 11, 24, 190
JRE 24

L
languages 161
late-bind 246

source 248, 249, 251
licenses 191
Local Configuration 53
logo overlay 60

positioning 81
zone configuration 80

long name 143

M
mapping 141, 142
master guide table 121
menus

VMG Element Manager 28
message system

operator alert messages 68
messaging system

configuration 60
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messaging system license 191
MGT 121
modifying

programs 135
streams 135

MSO 236
Multiple IP Creation 111
Multiple UDP Creation 111
multiplex 119
Multiplexing 15

N
Network Information Tables (NIT) 126
Network Information Tables, see NIT
NIT

O
overlay 16

P
PAL content 40
passthrough 240, 241, 244

keep 244
PID 119

display 163
display format configuration 41
dummy 164
ES ghost management 167
referenced mapping 170
reserved 163
unreferenced as ES 167
unreferenced mapping 170
unreferenced pass through 171

PNG 16, 79
port mirroring 44
Portable Network Graphics 16, 79
Postblack 204
Postblack Configuration 41, 205
power cycle 196
pre-bind 237, 238, 240, 241, 243, 244, 245, 246
program descriptors

managing 177
program with DPI license 191
programs 140

deleting 140
modifying 135

Protocol 53
PSIP 105, 121, 122

Q
Quality of Service (QoS) 15

R
RADIUS 49
Radius 53, 57
reboot 196
Redundancy 94

SSM 20
redundancy 21

Chassis-level 21
DVB-CA best practices 235
force change 98

regroom
program redundancy 198

regrooming 198
Remote Only 53
Remote user authentication 49
RGB 79
RRT 121

S
SCG 223, 229, 231, 232, 233, 234
scheduler 141
scrambling

verifying 234
scrambling, verifying 228
SCS 17, 207
SCTE 30 15, 200, 202
SCTE 35 15, 200, 202
SCTE Transport Stream 122
Server Configuration 57
service-level redundancy 20
services

stopping 197
set-top boxes (STBs) 236
Shared Secret 59
short name 143
SimulCrypt Engine 17, 207
Single Program Transport Stream (SPTS) 114
Source Specific Multicast Redundancy 20
SPTS license 191
SSM 20
Standby Chassis 98
Status Bar 254
status bar, VMG Element Manager 30
STB 236, 237
stop service 197
stream sub types 161
Streams

Deleting 140
Modifying 135

streams
deleting 140
modifying 135

STT 121
Switched Digital Video (SDV) 18
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T
tables 121
tabs

VMG Element Manager window 29
TACACS 53
TACACS+ 49, 57
Terrestrial Virtual Channel Table 121
time zone 38
transparency 79
transport stream

join/disjoin 227
Transrating 15
TVCT 121

U
Unreferenced PID 167
User Accounts 54, 55
user agent 237

V
video streams 161, 169
VMG Element Manager 23

features 23
menu 28
status bar 30
tabs 29
user interface 26
version 33

X
X Y coordinates 81
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